Solstice™ SyMON™ 1.3 User’s Guide
Contents

Preface ........................................................................................................... xvii

1. Solstice SyMON Overview ................................................................. 1
   Product Features ................................................................. 1
   Software Components ...................................................... 2
   Server Subsystem .......................................................... 4
      Kernel Reader ............................................................ 5
      Config Reader .......................................................... 5
      Log Scanner ............................................................. 6
      symond Daemon ......................................................... 6
   Event Manager ............................................................... 6
   Graphical User Interface .................................................. 8
      Launcher and Consoles ............................................. 8
      Information Messages ............................................... 10
      Error and Warning Messages ................................. 10
   Monitoring Hardware, System Performance, Alarms, and Events .................................. 11
Monitoring Hardware Status .......................... 11
  Physical View ........................................ 11
  Logical View ......................................... 11
  Online Diagnostics ................................. 11
Monitoring System Performance ...................... 12
  Kernel Data Catalog ................................. 12
  System Meters ....................................... 12
  Log Viewer ........................................... 13
  Process Viewer ...................................... 13
Monitoring Alarms and Events ........................ 13
  Event Generator ..................................... 14
  Event Viewer ........................................ 14
Interaction with SunReMon ............................. 14

2. Installing Solstice SyMON ............................ 17
   Installation Requirements .......................... 17
   Installing the Software ............................ 19
   Installing Solstice SyMON from the Updates CD .... 19
     Mounting the CD .................................. 19
   Installing Packages ................................ 21
   Updating Solstice SyMON from a Previous Release .... 21
     Identifying Previously Installed Packages with pkginfo ... 21
   Installing the man Pages ............................ 25
   Setting Up Your Environment ........................ 26
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuring Solstice SyMON</td>
<td>28</td>
</tr>
<tr>
<td>Starting Solstice SyMON</td>
<td>29</td>
</tr>
<tr>
<td>Exiting the GUI</td>
<td>30</td>
</tr>
<tr>
<td>Shutting Down Solstice SyMON</td>
<td>31</td>
</tr>
<tr>
<td>Removing Solstice SyMON</td>
<td>31</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>33</td>
</tr>
<tr>
<td>Installing and Setting Up SNMP Traps</td>
<td>33</td>
</tr>
<tr>
<td>3. Using the Solstice SyMON Consoles</td>
<td>35</td>
</tr>
<tr>
<td>Invoking the Solstice SyMON GUI</td>
<td>35</td>
</tr>
<tr>
<td>Launcher Window</td>
<td>36</td>
</tr>
<tr>
<td>Monitoring Hardware Status</td>
<td>37</td>
</tr>
<tr>
<td>Using the Physical View Console</td>
<td>37</td>
</tr>
<tr>
<td>Displaying a Detailed View of a Component</td>
<td>38</td>
</tr>
<tr>
<td>Limitations of the Physical View</td>
<td>39</td>
</tr>
<tr>
<td>Using the Show Information Window</td>
<td>40</td>
</tr>
<tr>
<td>Using the Copy Information Window</td>
<td>41</td>
</tr>
<tr>
<td>Using the Close Options</td>
<td>42</td>
</tr>
<tr>
<td>Locating Troublesome Components</td>
<td>42</td>
</tr>
<tr>
<td>Using the Logical View</td>
<td>42</td>
</tr>
<tr>
<td>Expanding and Collapsing the Hierarchical Diagram</td>
<td>45</td>
</tr>
<tr>
<td>Summary of Expanding and Collapsing the Hierarchical Diagram</td>
<td>45</td>
</tr>
<tr>
<td>Limitations of the Logical View</td>
<td>45</td>
</tr>
<tr>
<td>Using the Show Information Window</td>
<td>46</td>
</tr>
</tbody>
</table>
Using the Copy Information Window ............... 46
Using the Online Diagnostics Console ............... 47
Commands Menu .................................. 50
View Menu ..................................... 51
  Additional Information on SunVTS ................. 52
  Monitoring System Performance ................... 52
  Using the Kernel Data Catalog ..................... 52
    Kernel Data Catalog Instruments ................. 53
    Building System Meter Windows ................. 54
  Customizing a System Meter ...................... 55
  Displaying the System Meter Graphs ............... 60
    Saving and Redisplaying System Meter
    Configurations .............................. 61
  Using the Log Viewer ........................... 62
    View Menu in the Log File Viewer Window ........ 63
    Searching for Log File Entries ................ 63
    Search Criteria and Results ................... 66
  Using the Process Viewer ......................... 66
    Customizing the Process Viewer Display ........ 68
    Resizing Columns ............................ 69
  Monitoring Alarms and Events ...................... 69
    Using the Event Viewer ....................... 69
      Event Viewer Menus ......................... 71
      Acknowledging and Deleting Events .......... 71
## 4. Understanding and Writing Event Rules

- Overview of Event Rules ........................................... 75
- Terminology ......................................................... 76
- Types of Event Rules ............................................... 77
- Description of Rules Files ........................................ 78
- Special Characters ................................................. 80
- Reserved Words .................................................... 81
- Attributes ......................................................... 81
- MULTI Rules ...................................................... 83
- Rule Functions .................................................... 84
  - alarm ......................................................... 84
  - crnode ......................................................... 85
  - debug ......................................................... 85
  - dynlink ......................................................... 86
  - end_alarm ...................................................... 86
  - findlist ......................................................... 87
  - findstatus ..................................................... 89
  - findvalue ....................................................... 89
  - getfield ......................................................... 90
  - get_parameter .................................................. 91
  - gettime ......................................................... 92
<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>hotlist</td>
<td>92</td>
</tr>
<tr>
<td>load</td>
<td>93</td>
</tr>
<tr>
<td>mailto</td>
<td>94</td>
</tr>
<tr>
<td>putfield</td>
<td>94</td>
</tr>
<tr>
<td>put_parameter</td>
<td>95</td>
</tr>
<tr>
<td>snmp</td>
<td>96</td>
</tr>
<tr>
<td>syslog</td>
<td>97</td>
</tr>
<tr>
<td>Hierarchies</td>
<td>97</td>
</tr>
<tr>
<td>Writing Event Rules</td>
<td>98</td>
</tr>
<tr>
<td>Config Reader</td>
<td>99</td>
</tr>
<tr>
<td>Determining the Path for the Config Reader</td>
<td>100</td>
</tr>
<tr>
<td>Kernel Reader</td>
<td>102</td>
</tr>
<tr>
<td>Determining the Path for the Kernel Reader</td>
<td>103</td>
</tr>
<tr>
<td>Log Scanner</td>
<td>104</td>
</tr>
<tr>
<td>Event Generator and Log Scanner Tasks</td>
<td>104</td>
</tr>
<tr>
<td>Partial Listing of RULE 10000 and Description</td>
<td>105</td>
</tr>
<tr>
<td>Guidelines for Using LOG_RULES</td>
<td>106</td>
</tr>
<tr>
<td>Event Generator</td>
<td>106</td>
</tr>
<tr>
<td>Getting Functions</td>
<td>107</td>
</tr>
<tr>
<td>Locating Rule Files</td>
<td>107</td>
</tr>
<tr>
<td>Verifying and Activating Rules</td>
<td>108</td>
</tr>
<tr>
<td>Verifying New Event Rules</td>
<td>108</td>
</tr>
<tr>
<td>Activating New or Modified Event Rules</td>
<td>108</td>
</tr>
<tr>
<td>Debugging Tips</td>
<td>109</td>
</tr>
</tbody>
</table>
Troubleshooting .................................................. 110
Rule Examples .................................................. 110
    Simple Rules .............................................. 110
        Simple Rule Example 1: RULE 0 .................. 110
        Simple Rule Example 2: RULE 403 .............. 112
    Complex Rules .......................................... 113
        Complex Rule Example 1: RULE 102 .......... 113
        Complex Rule Example 2: RULE 1201 ......... 115
        Complex Rule Example 3: RULE 100 .......... 118
        Complex Rule Example 4: RULE 106 .......... 120

5. Command Line Options .................................... 123
    Options to Solstice SyMON ............................. 123
        colorMap ............................................. 124
        dragthreshold ....................................... 124
        flashDuration ...................................... 124
        flashInterval ....................................... 125
        heartbeatInterval .................................. 126
        help .................................................. 126
        installDir .......................................... 126
        interval ............................................ 127
        minWait ............................................. 127
        pruneTime .......................................... 128
        rpcNum .............................................. 128
        session .............................................. 129
target ............................................. 129
tempPruneTime ................................. 129
vtsui ......................................... 130

6. Troubleshooting ................................. 131
Troubleshooting Tips ......................... 131

A. Kernel Reader ................................. 137
Kernel Reader Data Hierarchy .............. 137

B. Config Reader ................................. 143
Terminology .................................. 144
Data Hierarchy ................................. 144
Ultra Enterprise 3000, 4000, 5000, and 6000 .... 145
SPARCserver 1000/1000E and SPARCcenter 2000/2000E . 155
Ultra Enterprise 2 and 150 Systems .......... 160

C. Installing SNMP Traps ...................... 169
Installing SNMP Traps ....................... 169

D. Default Solstice SyMON 1.3 Rules ........ 173
Glossary ....................................... 179
Index ........................................... 183
# Tables

Table 1-1  Solstice SyMON Features ........................................... 2  
Table 1-2  Solstice SyMON Consoles ........................................... 9  
Table 1-3  Menu Items ............................................................. 10  
Table 1-4  Performance Parameters ............................................ 13  
Table 2-1  Solstice SyMON Packages ........................................... 18  
Table 2-2  Solstice SyMON Packages ........................................... 31  
Table 3-1  The System Box on the Launcher Window ....................... 36  
Table 3-2  Meanings of Colors Used ........................................... 37  
Table 3-3  SunVTS Components Online Diagnostic Tool Screen .......... 49  
Table 3-4  Description of Commands in the Command Menu ............... 50  
Table 3-5  Graph Style Window Attributes ................................... 57  
Table 3-6  Log Entry Search Criteria ........................................... 63  
Table 3-7  Process Viewer Entry Descriptions ............................... 67  
Table 3-8  Description of Entries in the Event Viewer for Open Events . 70  
Table 3-9  Description of a Typical Line for Each Data Item ............. 73  
Table 4-1  LEVEL, PRIORITY, and SEVERITY Attribute Descriptions . 77
| Table 4-2 | Types of Event Rules | 78 |
| Table 4-3 | Description of Rules Files | 79 |
| Table 4-4 | Description of Platform-Specific Rule Files | 80 |
| Table 4-5 | Reserved Tcl Variable Names | 81 |
| Table 4-6 | Attribute Descriptions | 82 |
| Table 4-7 | Keywords for the crnode Command | 85 |
| Table 4-8 | getfield Field Type Descriptions | 90 |
| Table 4-9 | putfield Field Type Descriptions | 95 |
| Table 4-10 | Arguments to the verify_rules Command | 108 |
| Table 5-1 | Flash Duration Settings | 125 |
| Table 6-1 | Troubleshooting Tips | 131 |
Figures

Figure 1-1    Process Flow Overview .........................................  4
Figure 1-2    Server Subsystem Agents ......................................  5
Figure 1-3    Event Manager Subsystem .....................................  7
Figure 1-4    Launcher ..........................................................  8
Figure 2-1    Diagram of Desktop System B Monitoring Server A ........  28
Figure 3-1    Launcher Window ................................................. 36
Figure 3-2    Expanded Physical View of a CPU/Memory Board ..........  39
Figure 3-3    Show Information Window ..................................... 40
he peripheral_5v Node in the Logical View
of the peripheral_5v Node in the Logical View ...........  41
Figure 3-5    The Logical View ................................................ 44
Figure 3-6    SunVTS Online Diagnostic Tool ..............................  48
Figure 3-7    Commands Menu ...............................................  50
Figure 3-8    View Menu .......................................................  51
Figure 3-9    Kernel Data Catalog Console ...............................  53
Figure 3-10   Displaying Two System Meters in the Same Window ......  55
Figure 3-11   Graph Style Window Under the View Menu ..............  56
Figure 3-12  Log File Viewer Window ................................. 62
Figure 3-13  Log Viewer Change Criteria Worksheet Window .... 65
Figure 3-14  Log File Viewer Menu.................................... 66
Figure 3-15  The Process Viewer........................................ 67
Figure 3-16  Event Viewer .................................................. 70
Figure 4-1   KernelReader.cpu.*.busy Hierarchy Example ........ 87
Figure 4-2   ConfigReader Data Hierarchy Example ................ 101
Figure 4-3   Example of the Kernel Reader Data Hierarchy......... 103
Preface

Solstice™ SyMON™ is a system monitoring tool that collects various system information and displays it through a graphical user interface (GUI). This manual, which explains how to install and use Solstice SyMON, also describes how to modify the rules used to monitor the server. It also explains how to customize Solstice SyMON.

How This Book Is Organized

This manual is divided into six chapters and four appendixes:

Chapter 1, “Solstice SyMON Overview,” provides an overview of the features and architecture.

Chapter 2, “Installing Solstice SyMON,” describes how to install Solstice SyMON.

Chapter 3, “Using the Solstice SyMON Consoles,” provides instructions on how to use the consoles.

Chapter 4, “Understanding and Writing Event Rules,” explains how to modify event rules to meet specific monitoring needs. This chapter describes the basic Tcl commands and gives examples of event rules.

Chapter 5, “Command Line Options,” describes the options you can invoke on the command line.

Chapter 6, “Troubleshooting,” describes troubleshooting tips.
Appendix A, “Kernel Reader,” provides a summary of the Kernel Reader data hierarchy.


Appendix C, “Installing SNMP Traps,” describes how to install and set up SNMP traps.

Appendix D, “Default Solstice SyMON 1.3 Rules,” describes the default Solstice SyMON 1.3 rules.

Related Documents

Refer to the following documents for more information on the Tcl scripting language and Sun system performance tuning:


- Reference card on Tcl, available from Specialized Systems Consultants, Inc., P.O. Box 55549, Seattle WA, 98155-0549.


Typographic Conventions

The following table describes the typographic conventions used in this book.
Table P-1  Typographic Conventions

<table>
<thead>
<tr>
<th>Typeface or Symbol</th>
<th>Meaning</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>AaBbCc123</td>
<td>The names of commands, files, and directories; on-screen computer output</td>
<td>Edit your .login file. Use ls -a to list all files. machine_name% You have mail.</td>
</tr>
<tr>
<td>AaBbCc123</td>
<td>What you type, contrasted with on-screen computer output</td>
<td>machine_name% su</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Password:</td>
</tr>
<tr>
<td>AaBbCc123</td>
<td>Command-line placeholder: replace with a real name or value</td>
<td>To delete a file, type rm filename.</td>
</tr>
<tr>
<td>AaBbCc123</td>
<td>Book titles, new words or terms, or words to be emphasized</td>
<td>Read Chapter 6 in the User’s Guide. These are called the class options. You must be root to do this.</td>
</tr>
</tbody>
</table>

**Shell Prompts**

The following table shows the default system prompt and superuser prompt for the C shell, Bourne shell, and Korn shell.

Table P-2  Shell Prompts

<table>
<thead>
<tr>
<th>Shell</th>
<th>Prompt</th>
</tr>
</thead>
<tbody>
<tr>
<td>C shell</td>
<td>machine_name%</td>
</tr>
<tr>
<td>C shell superuser</td>
<td>machine_name#</td>
</tr>
<tr>
<td>Bourne shell and Korn shell</td>
<td>$</td>
</tr>
<tr>
<td>Bourne shell and Korn shell</td>
<td>#</td>
</tr>
</tbody>
</table>

Preface
Ordering Sun Documents

The SunDocs Order Desk is a distribution center for Sun Microsystems technical documents. You can use major credit cards and company purchase orders. You can order documents in the following ways:

<table>
<thead>
<tr>
<th>Country</th>
<th>Telephone</th>
<th>Fax</th>
</tr>
</thead>
<tbody>
<tr>
<td>United States</td>
<td>1-800-873-7869</td>
<td>1-800-944-0661</td>
</tr>
<tr>
<td>United Kingdom</td>
<td>0-800-89-88-88</td>
<td>0-800-89-88-87</td>
</tr>
<tr>
<td>France</td>
<td>0800-90-61-57</td>
<td>0800-90-61-58</td>
</tr>
<tr>
<td>Belgium</td>
<td>02-720-09-09</td>
<td>02-725-88-50</td>
</tr>
<tr>
<td>Luxembourg</td>
<td>32-2-720-09-09</td>
<td>32-2-725-88-50</td>
</tr>
<tr>
<td>Germany</td>
<td>01-30-81-61-91</td>
<td>01-30-81-61-92</td>
</tr>
<tr>
<td>The Netherlands</td>
<td>06-022-34-45</td>
<td>06-022-34-46</td>
</tr>
<tr>
<td>Sweden</td>
<td>020-79-57-26</td>
<td>020-79-57-27</td>
</tr>
<tr>
<td>Switzerland</td>
<td>0800-55-19-26</td>
<td>0800-55-19-27</td>
</tr>
<tr>
<td>Japan</td>
<td>0120-33-9096</td>
<td>0120-33-9097</td>
</tr>
</tbody>
</table>

World Wide Web: http://www.sun.com/sunexpress/

Sun Welcomes Your Comments

Please use the Reader Comment Card that accompanies this document. We are interested in improving our documentation and welcome your comments and suggestions.

If a card is not available, you can email or fax your comments to us. Please include the part number of your document in the subject line of your email or fax message.

- Email:—smcc-docs@sun.com
- Fax:—SMCC Document Feedback, 1-415-786-6443
Solstice SyMON Overview

This chapter gives an overview of the main features of the Solstice SyMON system monitor, which offers simple yet powerful monitoring capabilities for the following servers:

- Ultra™ Enterprise™ 3000, 4000, 5000, and 6000 servers
- Ultra Enterprise 2 server
- Ultra Enterprise 150 server
- SPARCserver™ 1000/1000E servers
- SPARCcenter™ 2000/2000E servers

Solstice SyMON uses a CDE/Motif™-based graphical user interface (GUI).

Product Features

Solstice SyMON identifies a range of hardware and system status states quickly. For example, it can monitor a major condition such as a CPU failure or a minor condition such as low swap space. You can also monitor hardware performance to detect incipient hardware failures, such as soft read errors on a disk.

To give you this critical performance information, Solstice SyMON analyzes system performance in real time; when performance problems occur, the event system alerts you, if desired, to the status of most system components.
Table 1-1 lists the main features.

Table 1-1  Solstice SyMON Features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance Monitoring</td>
<td>Diagnoses and addresses potential problems such as capacity problems or bottlenecks. Solstice SyMON monitors four categories of performance data: CPU, disk, memory, and network.</td>
</tr>
<tr>
<td>Configuration Monitoring</td>
<td>Displays physical and logical views of exact server configurations; configuration monitoring improves system serviceability.</td>
</tr>
<tr>
<td>Remote Monitoring</td>
<td>Allows a server within a network running Solstice SyMON to be monitored from any location in the network.</td>
</tr>
<tr>
<td>Fault Management</td>
<td>Isolates potential problems or failed components. Provides access to system log file and maintains a log file of conditions for future analysis.</td>
</tr>
<tr>
<td>Graphical User Interface (GUI)</td>
<td>Ensures that users get the information they need quickly and easily with the configurable GUI. The GUI provides access to SunVTS™ diagnostics, which diagnoses hardware.</td>
</tr>
</tbody>
</table>

Software Components

Solstice SyMON consists of three interdependent subsystems:

- **Server subsystem**—The server subsystem consists of a set of server agents on the monitored server, the Kernel Reader, Config Reader, and Log Scanner (see Figure 1-2). The agents continuously monitor the hardware status of the server.
• **Event Manager**—The Event Manager consists of the Event Generator and the Event Viewer. The Event Generator compares the conditions on the server to a set of pre-defined rules. If the conditions defined in the rule exist on the server, then the actions specified in the rule will be taken. You typically configure the Event Generator on a machine other than the one being monitored so that it will continue to run even if the monitored server is down. Each instance of the Event Generator monitors one server.

For more information on the Event Manager, see “Event Manager” later in this chapter.

• **GUI**—You use the GUI, consisting of seven consoles, to view information generated by the Event Generator and Server subsystem, and to control the execution of SunVTS. You may install the GUI on several machines so others can remotely monitor from multiple locations. The software on the Event Generator communicates to the GUI machine by the GUI polling the server and the Event Generator. In general, the Solstice SyMON architecture is a polling/pulling once, not an asynchronous push type.

Figure 1-1 shows the relationship and flow of information between these subsystems.
Server Subsystem

The server subsystem consists of four agents:

- Kernel Reader
- Config Reader
- Log Scanner
- Symond
These agents are briefly described in the following sections. Figure 1-2 shows the server subsystem agents.

**Figure 1-2  Server Subsystem Agents**

**Kernel Reader**

The Kernel Reader extracts summary and process operating system data from the Solaris operating system kernel on a periodic basis. It determines which processes are CPU-and resource-intensive. Also, it monitors and reports on items such as:

- CPU usage
- Disk I/O
- Network I/O
- Memory usage
- Swap space usage
- Paging and swapping rates

**Config Reader**

The Config Reader monitors the server hardware. It reports system configuration data such as the number of CPU boards and the number and type of I/O boards. It monitors and tracks changes to the system configuration and the state of its components.
It reports on items such as:

- Disk hot plug
- Board hot swap
- Board temperature

**Log Scanner**

The Log Scanner monitors designated system log files searching for a user-specified list of regular expressions as specified in the rules. When the Log Scanner finds a set of messages that match that list, it notifies the Event Generator and triggers the corresponding event rule.

The Log Scanner can also run in a demand-driven mode from the GUI. It looks for specific entries as indicated by user-specified search parameters.

It searches the `/var/adm/messages` system log. The Log Scanner can capture panic messages immediately preceding a system crash.

**symond Daemon**

The `symond` daemon starts when the server or the event host is started. `symond` starts the agents, monitors their activity, and restarts them if they stop. It also provides a central contact point for any clients that want to connect to the agents.

**Event Manager**

The Event Manager subsystem consists of the Event Generator and the Event Viewer. The Event Generator evaluates the conditions on the server against a set of rules, which the user can modify, that define an *event*. When an event is logged, the software can be set to take an action, such as highlighting a component in the display or executing a script.

A pre-defined set of rules, written in the Tcl scripting language, is provided with Solstice SyMON. Figure 1-3 illustrates the Event Manager monitoring system by showing how users can modify events or define new events that tell the software what to do when a particular event occurs.
The Event Generator polls for information about the server. By the Event Generator polling the Server Subsystem this is how the Server Subsystem communicates to the Event Generator (the monitoring machine). It evaluates the conditions of the server against a set of pre-defined rules. If the conditions of the server meet the defined set of conditions in the rule, an event is created and the defined actions of the rule are triggered. At this point, the event is known as an open event.

Point events are events that are generated due to log messages. Because they are closed right away, they are displayed in the All Events display of the Event Viewer but not by the Open Events display of the Event Viewer.

Once an event is open, the defined actions of the rule may include sending e-mail or running a script that alerts the user of this event. Routines are also available so events can generate a SNMP trap, which are directed to the Solstice Site Manager™ and Solstice Domain Manager™, Solstice Enterprise Manager™ or other SNMP-listening management platforms.

When the condition that generated the event no longer exists, the Event Manager closes the event and the event is referred to as a closed event. The event log file records the opening and closing of events.
Graphical User Interface

When you start Solstice SyMON, the main GUI window, called the Launcher, is displayed (see Figure 1-4).

Launcher and Consoles

The Launcher provides an easy to use, windowed display showing vital signs for Solstice SyMON and top level status information of the monitored server. The Launcher enables you to launch consoles (subwindows) to view data about the conditions of the server in a variety of ways. For example, you can view data on events, log files, physical or logical views, kernel information, or process information. The System: box blinks green when Solstice SyMON is operating normally.

The Launcher does the following:

- Tests for available agents (Kernel Reader, Config Reader, Event Generator, and Log Scanner)
• Displays the console icons and names; each icon displays an “unavailable” symbol (Ø) until it receives data from the appropriate agent. For more information on the unavailable symbol, see “Launcher Window” in Chapter 3, “Using the Solstice SyMON Consoles.”

• Shows the status of agents; red indicates that the GUI is unable to contact the agent, yellow indicates that the GUI has found the agent but is not yet receiving data

• Initiates online diagnostics through SunVTS, a powerful diagnostic tool that incorporates multi-functional tests of the system through operating system-level calls

There are seven consoles on the Launcher. Table 1-2 describes the information presented by each console.

Table 1-2  Solstice SyMON Consoles

<table>
<thead>
<tr>
<th>Console</th>
<th>Feature</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Viewer</td>
<td>Displays events that have occurred on the server</td>
</tr>
<tr>
<td>Log Viewer</td>
<td>Displays log files, for example syslog</td>
</tr>
<tr>
<td>Physical View</td>
<td>Displays a pictorial representation of the server; any component with an open event is highlighted</td>
</tr>
<tr>
<td>Logical View</td>
<td>Displays a hierarchical schematic view of the server; any component with an open event is highlighted</td>
</tr>
<tr>
<td>Kernel Data Catalog</td>
<td>Displays a hierarchy of metrics showing CPU, disk, memory, and network performance; any metric that causes an event is highlighted</td>
</tr>
<tr>
<td>Process Viewer</td>
<td>Displays resource-intensive processes running on the server</td>
</tr>
<tr>
<td>Online Diagnostics</td>
<td>Initiates the SunVTS diagnostics GUI</td>
</tr>
</tbody>
</table>
Table 1-3 describes menu items that are typical in each of the seven consoles listed in Table 1-2.

Table 1-3 Menu Items

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Gives you the option to close the window, exit the GUI, save a file or settings, or restore a file or settings</td>
</tr>
<tr>
<td>Edit</td>
<td>Offers different ways to manipulate windows, objects, or text</td>
</tr>
<tr>
<td>View</td>
<td>Lists options for viewing data, or for displaying additional information about the data</td>
</tr>
<tr>
<td>Help</td>
<td>Provides access to online help</td>
</tr>
</tbody>
</table>

For detailed information on the Launcher and its consoles, see Chapter 3, “Using the Solstice SyMON Consoles.”

Information Messages

When an operation that is monitored is incorrect, the software generates information messages in the footer of the active window.

Error and Warning Messages

Solstice SyMON displays warning messages in dialog boxes that appear above the console you are viewing. When a warning message is displayed, you should acknowledge it by selecting an action button such as O. K. or Quit.

Some warning messages state that a prerequisite for an operation has not been met. To acknowledge this message, click the Continue button before attempting the operation again.
Monitoring Hardware, System Performance, Alarms, and Events

This section provides an overview of the consoles used to monitor:

- Hardware Status
- System Performance
- Alarms and Events

Chapter 3, “Using the Solstice SyMON Consoles” explains these consoles in more detail.

Monitoring Hardware Status

Use Solstice SyMON to view the configuration of your system, monitor the status of system hardware components, and launch diagnostic tests. The three consoles used to monitor hardware status are:

- Physical View
- Logical View
- Online Diagnostics

Physical View

The Physical View, a pictorial representation of the front and/or back of the server, provides a picture of your system as it is actually configured. Information about each component and visual identification of a failed or troubled component is displayed.

Logical View

The Logical View, a companion view for the Physical View, displays the components in a schematic hierarchy.

Online Diagnostics

To test and validate the CPUs, disks, and network connections of a server, the software launches SunVTS, Sun Validation and Test Suite Online Diagnostics. For information about running SunVTS Online Diagnostics, refer to “Using the Online Diagnostics Console” in Chapter 3. For complete information on SunVTS, refer to the SunVTS 2.0 User’s Guide, the SunVTS 2.0 Test Reference.
Monitoring System Performance

Solstice SyMON monitors system performance to isolate and identify system bottlenecks such as:

- Overloaded CPU
- Excessive traffic to a single disk

The three consoles that monitor system status are:

- Kernel Data Catalog
- Log Viewer
- Process Viewer

Additionally, System Meters, which are not consoles, also monitor system status.

Kernel Data Catalog

The Kernel Data Catalog provides a hierarchical diagram of the system performance parameters by category (CPU, memory, disk, and network).

System Meters

The performance parameters that the software captures can be displayed as graphs in the System Meter console windows to show you the type and quantity of activities of the CPUs, disks, memory, and network interfaces of the server (see Table 1-4). System Meter consoles do not appear on the Launcher, since they are built using the Kernel Data Catalog and the Logical View.
The Log Viewer displays entries from the log files, for example /var/adm/messages. It searches the log using a list of regular expressions. When a match is found, the corresponding log file entry is sent to the Log Viewer. The Log Viewer can also search the SunVTS error log /var/opt/SUNWvts/logs/sunvts.err, if desired.

Process Viewer

The Process Viewer gathers and displays information about resource-intensive processes. You can configure the columns of data.

Monitoring Alarms and Events

Events are system conditions that require the attention of a system administrator. Alarms are used to alert the system administrator of an event, which appears as a message in the Event Viewer and a visual highlight on a console.

Table 1-4  Performance Parameters

<table>
<thead>
<tr>
<th>Component</th>
<th>Performance Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Performance across all CPUs on a server, or individual CPU performance; parameters that the software monitors are: user, system, total busy, wait and idle times, context switches, interrupts, and so on</td>
</tr>
<tr>
<td>Memory</td>
<td>Memory available, page scan rate, and total swap space</td>
</tr>
<tr>
<td>Disk</td>
<td>Number of active disks, projected fastest service time, number of bytes written, and average disk queue length</td>
</tr>
<tr>
<td>Network</td>
<td>Packet load and the number of packet errors that are occurring on the network interfaces of the server (overflow, underflow, CRC, frame, output, and input errors, as well as collisions)</td>
</tr>
</tbody>
</table>
Event Generator

As the name implies, the Event Generator monitors the status and performance of the server. The software on the Server Subsystem communicates to the Event Generator (monitoring machine) by the Event Generator polling the server. The Event Generator detects any condition that violates the predefined performance parameters that are specified in the set of event rules.

If the Event Generator detects problems with the system, the affected component can be highlighted in red, yellow, (depending on the event severity) or blue (for capacity-related events). All related components are also highlighted. For example, if a CPU chip is highlighted, then the board on which it is mounted, and its chassis slot are also highlighted.

For more information on the Event Generator and the Event Manager, see “Event Manager” earlier in this chapter and Chapter 4, “Understanding and Writing Event Rules.”

Event Viewer

The console used to monitor events is the Event Viewer. The Event Viewer alerts you to any problems detected by the Event Manager. Each entry displayed in the Event Viewer window represents an event and gives you the following information:

- The rule number that generated the event
- The severity level (red, yellow, or blue)
- The time and date the event was detected
- A message indicating the type of event that was captured
- The node where the event occurred
- The event priority and severity

Interaction with SunReMon

SunReMon™ and the Remote Systems Monitoring service are part of the SunSpectrum™ program offering from SunService™. The Remote Systems Monitoring service uses the SunReMon software to collect key system data from critical servers. This data is automatically transferred to the local Sun Solution Center on a regular basis. When you report a problem, the support engineer has this data available to assist in problem analysis.
SunReMon also has the ability to generate a “Call-Home” email alert to the local Sun Solution Center when a critical problem is detected. This requires an Internet email connection at your site.

Solstice SyMON also has the ability to generate a “call-home” alert. Due to support requirements, the default Solstice SyMON rules do not use the “call-home” feature of the Remote Systems Monitoring service. For information on configuring the Remote Systems Monitoring service, contact your local Sun Solution Center.

The Remote Systems Monitoring service is available to SunSpectrumSM GoldSM and SunSpectrumSM PlatinumSM contract customers throughout of the world. For local availability, contact your SunService sales representative.
Installing Solstice SyMON

To install Solstice SyMON 1.3, you must be running at least the Solaris 2.5.1 Hardware: 4/97 software environment, which is the first operating system release that supports Solstice SyMON 1.3.

Installation Requirements

Table 2-1 lists the required disk space for each of the packages and the system on which the packages should be installed.
Table 2-1  Solstice SyMON Packages

<table>
<thead>
<tr>
<th>Package</th>
<th>Package Name</th>
<th>Description</th>
<th>Install On</th>
<th>Disk Space</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Subsystem</td>
<td>SUNWsys</td>
<td>Server subsystem package</td>
<td>Monitored server</td>
<td>~ 1.15 Mbytes</td>
</tr>
<tr>
<td></td>
<td>SUNWsyrt</td>
<td>Runtime package</td>
<td></td>
<td>~ 0.30 Mbytes</td>
</tr>
<tr>
<td>Event Manager</td>
<td>SUNWsysye</td>
<td>Event Generator package</td>
<td>Any SPARC system other than the monitored server</td>
<td>~ 1.26 Mbytes</td>
</tr>
<tr>
<td></td>
<td>SUNWsyrt</td>
<td>Runtime package</td>
<td></td>
<td>~ 0.30 Mbytes</td>
</tr>
<tr>
<td>GUI</td>
<td>SUNWsyu</td>
<td>GUI subsystem package</td>
<td>Desktop SPARC system</td>
<td>~ 4.06 Mbytes</td>
</tr>
<tr>
<td></td>
<td>SUNWsyua</td>
<td>Images for Ultra Enterprise 3000, 4000, 5000, and 6000 servers</td>
<td></td>
<td>~ 9.81 Mbytes</td>
</tr>
<tr>
<td></td>
<td>SUNWsyub</td>
<td>Images for the SPARCserver 1000(E) and SPARCCenter 2000(E)</td>
<td></td>
<td>~ 1.65 Mbytes</td>
</tr>
<tr>
<td></td>
<td>SUNWsyuc</td>
<td>Images for the Ultra Enterprise 2 and Ultra Enterprise 150</td>
<td></td>
<td>~ 4.57 Mbytes</td>
</tr>
<tr>
<td></td>
<td>SUNWsyrt</td>
<td>Runtime package</td>
<td></td>
<td>~ 0.30 Mbytes</td>
</tr>
<tr>
<td>man Pages</td>
<td>SUNWsym</td>
<td>Man pages</td>
<td>Any SPARC system</td>
<td>~ 0.03 Mbytes</td>
</tr>
<tr>
<td>SunVTS Online Diagnostics</td>
<td>SUNWsync</td>
<td>Standalone configuration reader; prerequisite for SunVTS Online Diagnostics</td>
<td>Monitored server</td>
<td>~ 0.29 Mbytes</td>
</tr>
<tr>
<td></td>
<td>SUNWodu</td>
<td>SunVTS Online Diagnostic utility</td>
<td>Monitored server</td>
<td>~ 1.6 Mbytes</td>
</tr>
<tr>
<td></td>
<td>SUNWvts</td>
<td>SunVTS kernel GUI, and tests</td>
<td>Monitored server</td>
<td>~ 23.0 Mbytes</td>
</tr>
</tbody>
</table>

Note – The SUNWsyrt package is required on the Server Subsystem, Event Manager, and GUI configurations.

Only one instance of the Server Subsystem and the Event Manager operate on a given server. However, you can have many instances of the GUI subsystem on different systems to monitor one server.
Installing the Software

Installing Solstice SyMON requires these steps:

1. Mounting the Updates CD
2. Saving any user-customized Solstice SyMON event rules and removing Solstice SyMON 1.0 or 1.1 and all previously installed packages (if upgrading from a previous release).
3. Installing the packages
4. Setting up your environment
5. Configuring the software
6. Starting agents

Installing Solstice SyMON from the Updates CD

The Solstice SyMON software is located on the SMCC Updates CD. You need to mount the SMCC Updates CD so you can retrieve the Solstice SyMON 1.3 software from the SMCC Updates CD.

Mounting the CD

Follow the procedure “To Mount the Locally Connected CD-ROM” or “To Mount the Remotely Connected CD-ROM.”

▼ To Mount the Locally Connected CD-ROM

1. Become superuser and create the /cdrom directory (if one doesn’t exist).

2. Place the SMCC Updates CD in the CD-ROM drive and close the drive door.
   If Volume Manager is running the CD is mounted and the path is: /cdrom/upd_sol_2_5_1_hw497_smcc/SMCC.
   If Volume Manager is not running complete Step 3, mounting the /cdrom directory manually.
3. Mount the CD manually by typing:

```
# mount -r -F hsfs /dev/dsk/c0t6d0s0 /cdrom
```

▼ **To Mount the Remotely Connected CD-ROM**

1. Export the /cdrom directory from the server:
   a. Edit the /etc/dfs/dfstab file by adding the following line at the end of the /etc/dfs/dfstab file:

   ```
   share -F nfs -o ro /cdrom/upd_sol_2_5_1_hw497_smcc/SMCC
   ```

   where: /cdrom/upd_sol_2_5_1_hw497 is the CD-ROM directory

   b. Start NFS and the mount daemon:

   ```
   # /usr/lib/nfs/nfsd -a 16
   # /usr/lib/nfs/mountd
   ```

   c. Export the /cdrom file system:

   ```
   # shareall
   ```

2. Mount the /cdrom directory from the server.
   • If automountd is running, type:

   ```
   # cd /net/server_hostname/cdrom/upd_sol_2_5_1_hw497_smcc/SMCC
   ```

   • If automountd is not running, type:

   ```
   # mkdir /cdrom
   # mount server_hostname:/cdrom /cdrom
   # cd /cdrom/upd_sol_2_5_1_hw497_smcc/SMCC
   ```
Installing Packages

Note – The packages you install for the Server Subsystem, Event Manager, and GUI subsystem are dependent on SUNWsyrt, the SyMON Runtime Library package, and SUNWdtbase, the CDE-base package. Ignore warning messages if you do not install the SUNWsyrt package first.

Updating Solstice SyMON from a Previous Release

Before you can install the Solstice SyMON 1.3 packages, you must completely remove the currently installed Solstice SyMON configuration and remove the previously installed packages.

▼ To Save Customized Rules Files and Remove Solstice SyMON

1. Save any customized rules files.
   Some older Solstice SyMON rules and Solstice SyMON 1.3 rules are incompatible.

2. Completely remove the currently installed Solstice SyMON configuration by typing as superuser:

   ```
   # /opt/SUNWsymon/sbin/sm_confsymon -D
   ```

3. Install Solstice SyMON 1.3 by following the procedures that follow.
   The first step in each procedure describes how to remove the existing packages.

Identifying Previously Installed Packages with pkginfo

Before removing all previously installed packages, you must identify which previously installed packages are installed on each system with the pkginfo command. For example:

```
# pkginfo SUNWsyrt
```
If the SUNWsyrtpackage is installed, the following is displayed:

```
application scripts SUNWsyrtsolstice SyMON Runtime library and Tcl
```

If the SUNWsyrtpackage is not installed, the following is displayed:

```
ERROR: information for “SUNWsyrtpackage was not found
```

Use pkginfo to identify the remaining previously installed packages.

▼ To Install the Server Packages

1. If you are upgrading from a previous release, remove the existing SUNWsystand SUNWsyrtpackages on the monitored server by typing the following as superuser:

```
# /usr/sbin/pkgrm SUNWsyst SUNWsyrtpackage
```

   a. Answer yes to all questions.

2. Go to the installation directory on the monitored server:

```
# cd dirname
```

   where:

   `dirname` is the directory where the Solstice SyMON packages are located

3. Add the SUNWsyrtpackage and SUNWsystpackages:

```
# /usr/sbin/pkgadd -d source_directory SUNWsyrtpackage SUNWsystpackage
```

   where:

   `source_directory` is the full path name of the directory where the packages you want to add are located. You can also use ‘pwd’ for the `source_directory`. 
To Install SunVTS for Online Diagnostics

1. Install the SUNWsyc package, which is a prerequisite for SunVTS, on the monitored system by typing:

```bash
# /usr/sbin/pkgadd -d source_directory SUNWsyc
```

where:

`source_directory` is the full path name of the directory where the packages you want to add are located. You can also use `pwd` for the `source_directory`.

**Note** – You also need to install the SunVTS Online Diagnostics packages which are SUNWvts and SUNWodu. Refer to Chapter 4 in the section on SunVTS installation of the SMCC SPARC Hardware Platform Guide, shipped in the Solaris 2.5.1 Hardware: 4/97 carton.

To Install the Event Generator Packages

**Note** – If you are installing both the Event Generator and the User GUI subsystem packages on the same system, install SUNWsyr only one time.

1. If you are upgrading from a previous release, remove the existing Solstice SyMON Event Generator software from your desktop system (or on any other system other than the server) (by typing:

```bash
# /usr/sbin/pkgrm SUNWsy e SUNWsyr
```
2. Install the Event Generator packages on your desktop system (or on any other system other than the server) by typing:

```
# /usr/sbin/pkgadd -d source_directory SUNWsyrt SUNWsye
```

where:

- `source_directory` is the full path name of the directory where the packages you want to add are located.

▼ **To Install the GUI Subsystem Packages**

**Note** – If you are installing the Event Generator and User GUI Subsystem packages on the same system, **do not** remove SUNWsyrt (see Step 1, which follows) since you previously installed SUNWsyrt in Step 2 of the previous procedure.

1. If you are upgrading from a previous release, remove the existing SUNWsyu and SUNWsyrt packages from the desktop system by typing:

```
# /usr/sbin/pkgrm SUNWsyu SUNWsyrt
```

2. Install the GUI subsystem packages on the desktop system by typing:

```
# /usr/sbin/pkgadd -d source_directory SUNWsyrt SUNWsyu [SUNWsuya SUNWsyub SUNWsyc]
```

where:

- `source_directory` is the full directory path name where the packages are located
- SUNWsuya contains images for the Ultra Enterprise 3000, 4000, 5000, and 6000 systems
- SUNWsyub contains the images for the SPARCserver 1000(E) and SPARCcenter 2000(E)
- SUNWsyc contains the images for the Ultra Enterprise 2 and 150
Installing the man Pages

You can install the man pages in two ways:

- Without using the Windex database for man pages
- Using the Windex database for man pages

Review the following information before deciding which method to use.

The Windex database is generated with the `catman` command. The Windex man page database is used by the `man -k` and `apropos` commands. For example, if you need to know every man page that mentions disk, you would type `man -k disk`. You can also use the `apropos` command. For example, typing `apropos logout` returns man pages related to `logout`.

Use `pkgadd` to install the Windex database of man pages. The `catman` command indexes the Windex database.

▼ To install the man pages if you do not have a Windex database for man pages

1. If you are upgrading from a previous release, remove the existing `SUNWsym` package by typing:

```
# /usr/sbin/pkgrm SUNWsym
```

2. Add the new man page package by typing:

```
# /usr/sbin/pkgadd -d source_directory SUNWsym
```

where:

`source_directory` is the full path name of the directory where the packages you want to add are located.
To install the man pages if you have a Windex database for the man pages

1. If you are upgrading from a previous release, remove the existing SUNWsym packages and the Windex database by typing:

```
# /usr/sbin/pkgrm SUNWsym
# rm /opt/SUNWsymon/man/Windex
```

2. Add the new man page package by typing:

```
# /usr/sbin/pkgadd -d source_directory SUNWsym
```

where:

`source_directory` is the full path name of the directory where the packages are located that you want to add.

3. Create the new Windex database by typing:

```
# catman -w M /opt/SUNWsymon/man
```

Setting Up Your Environment

You can set up your environment for the GUI using the Bourne, Korn, or C shells as follows.

To Set Up the Environment for the GUI

- For Bourne and Korn shells
1. Add the following lines to the `.profile` file:

```
SYMONHOME=/opt/SUNWsymon
PATH=$SYMONHOME/bin:/opt/SUNWvts/bin:$PATH
MANPATH=$SYMONHOME/man:$MANPATH
LD_LIBRARY_PATH=$SYMONHOME/lib:$LD_LIBRARY_PATH
export SYMONHOME
export PATH
export MANPATH
export LD_LIBRARY_PATH
```

**Note** – If the software is not installed in `/opt/SUNWsymon`, replace the `/opt/SUNWsymon` path with the path you used to install the software in the line beginning with `SYMONHOME`.

2. Make the previous setup parameters effective by logging out and then logging in.

• For the C Shell

1. Add the following lines to the `.cshrc` file:

```
setenv SYMONHOME /opt/SUNWsymon
set path= $SYMONHOME/bin /opt/SUNWvts/bin $path
setenv MANPATH $SYMONHOME/man:$MANPATH
setenv LD_LIBRARY_PATH $SYMONHOME/lib:$LD_LIBRARY_PATH
```

**Note** – If the software is not installed in `/opt/SUNWsymon`, replace the `/opt/SUNWsymon` path with the path you used to install the software in the line beginning with `setenv`.

2. Make the previous setup parameters effective by typing:

```
# source .cshrc
# rehash
```
Configuring Solstice SyMON

Before you can run Solstice SyMON in your environment, you must configure the host and the Event Generator host (Event Host). For example, if you have two systems, server A and a desktop system B, and you want desktop system B to monitor server A, a diagram of the monitoring configuration would look something similar to Figure 2-1.

![Diagram of Desktop System B Monitoring Server A](image)

**Figure 2-1** Diagram of Desktop System B Monitoring Server A

▼ **To Configure the Host**

1. Type the following on server A:

   ```
   # /opt/SUNWsymon/sbin/sm_confsymon -s EventMonitor_host
   ```

   where:

   `EventMonitor_host` is the host that monitors this server, which is Server A in this example.

▼ **To Configure the Event Generator**

1. **Invoke the `uname -i` command on server A.**

   This command returns the platform name of the system. Use the platform name (for example SUNW,Ultra-Enterprise) as an argument to the `sm_confsymon -e` command.
Note – If the `uname -i` command returns `SUNW, Ultra-1` this platform name is for the Ultra Enterprise 150, which is supported by Solstice SyMON. The same platform name is used for the Ultra Enterprise 1 system, which is not supported by Solstice SyMON.

Also, the `uname -i` command returns `SUNW, Ultra 2` for both the Ultra Enterprise 2 server, which is supported by Solstice SyMON and the Ultra Enterprise 2 workstation, which is not supported by Solstice SyMON.

2. Type the following on the Event Host:

```
# /opt/SUNWsymon/sbin/sm_confsymon -e agent_host -P platformname
```

where:

- `agent_host` is the host name of the server running the Server Subsystem, which is Server A in this example.
- `platformname` (SUNW, Ultra-Enterprise in this example) is the platform type returned by the `uname -i` command.

Starting Solstice SyMON

This section describes how to start running Solstice SyMON. The Server Subsystem and the Event Manager start automatically after you reboot your system. To start the server subsystem without rebooting, follow the next procedure, “To Start Solstice SyMON without Rebooting.”

▼ To Start Solstice SyMON without Rebooting

Note – You can also use the `-v` flag (verbose installation) with the `sm_confsymon` command. The system echoes all actions and requests permission to continue when you use the `-v` flag.

1. Start Solstice SyMON on the Server Subsystem host by typing:

```
# /opt/SUNWsymon/sbin/sm_control start
```
2. Start the Event Generator on the Event Generator machine by typing:

```
# /opt/SUNWsymon/sbin/sm_control start
```

3. Run the GUI from your desktop as a regular user by typing:

```
CTRL-d (to become a regular user)

% rehash

% /opt/SUNWsymon/bin/symon -t target_system &
```

where:

- `target_system` is the name of the server running the monitor agents.

Solstice SyMON also recognizes command line options (see Chapter 5, “Command Line Options”). For example, in the previous screen, the `-t` option refers to the target system to monitor.

### Exiting the GUI

This section describes how to exit the GUI. Exiting the GUI shuts down the GUI but does not shut down the software application, which continues to monitor the server.

#### To Exit the GUI

The Launcher window contains a File menu that includes an Exit button.

- Close the current window and all other windows by clicking the Yes button to the exit inquiry.

If you need to view the information that the software has collected about the server, restart the GUI.
Shutting Down Solstice SyMON

Note – Normally, the agents and the Event Generator should run continuously, even if GUIs are not attached. Running them continuously monitors the server for events and gathers historical data.

▼ To Shut Down Solstice SyMON

♦ As superuser, type the following command on the server or the Event Host:

# /opt/SUNWsymon/sbin/sm_control stop

Removing Solstice SyMON

Caution – SUNWsyr is the runtime library. Remove SUNWsyr only if all the SyMON packages are removed from that machine.

▼ To Remove Solstice SyMON

Caution – If the Event Generator is also installed on this machine and you want to continue running the Event Generator on this machine, do not remove the SUNWsyr package.

Table 2-2  Solstice SyMON Packages

<table>
<thead>
<tr>
<th>If you remove</th>
<th>The following is removed</th>
</tr>
</thead>
<tbody>
<tr>
<td>SUNWsye package</td>
<td>Event Generator binaries and data</td>
</tr>
<tr>
<td>SUNWsyr package</td>
<td>Runtime library</td>
</tr>
<tr>
<td>SUNWsxs package</td>
<td>Server binaries and executables</td>
</tr>
<tr>
<td>SUNWsxyu package</td>
<td>GUI binaries and executable</td>
</tr>
</tbody>
</table>
1. Remove the Server Subsystem and runtime library on the Server Subsystem host by typing:

```
# /usr/sbin/pkgrm SUNWsys SUNWsyrt SUNWsyc
```

2. Remove the Event Manager and runtime library on a desktop system or any system except for the server host by typing:

```
# /usr/sbin/pkgrm SUNWsye SUNWsyrt
```

3. Remove the GUI and runtime library on the desktop system by typing:

```
# /usr/sbin/pkgrm SUNWsyu [SUNWsyua SUNWsyub SUNWsyc] SUNWsyrt
```

4. Remove the man pages.
   * If you do not have the Windex database of man pages, type:

```
# /usr/sbin/pkgrm SUNWsym
```
• If you have the Windex database of man pages, type:

```bash
#/usr/sbin/pkgrm SUNWsym
#/usr/bin/rm /opt/SUNWsymon/man/Windex
```

**Troubleshooting**

If you have problems installing Solstice SyMON, see Chapter 6, “Troubleshooting.”

**Installing and Setting Up SNMP Traps**

To install and set up SNMP traps, see Appendix C, “Installing SNMP Traps.” A SNMP trap is an asynchronous message directed at a specific monitor.
Using the Solstice SyMON Consoles

This chapter describes how to invoke and use the Solstice SyMON GUI and provides information on the menus and associated subwindows.

Invoking the Solstice SyMON GUI

This section describes how to launch a Solstice SyMON console.

▼ To Invoke the Solstice SyMON GUI

1. Type the following as a regular UNIX user:

```bash
% /opt/SUNWsymon/bin/symon -t monitored_servername &
```

where:

*monitored_servername* is the name of the server you want to monitor.

After a few moments, the main window, the Launcher, is displayed (see Figure 3-1). The Launcher establishes communication between the GUI, the agents, and the Event Generator. It launches different consoles.
2. Click the icon to launch a console.

Launcher Window

Figure 3-1 shows that the software is installed and is running on the server being monitored (owey). Table 3-1 describes the meanings of the colors you might see for the System: box in the upper left-hand corner of the Launcher window.

Table 3-1 The System Box on the Launcher Window

<table>
<thead>
<tr>
<th>System box colors</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blinking green</td>
<td>Target system is working; Solstice</td>
</tr>
<tr>
<td></td>
<td>SyMON is operating normally</td>
</tr>
<tr>
<td>Red</td>
<td>Target system is not running</td>
</tr>
</tbody>
</table>

Below the System: box, the next line shows the status of the agents. The Launcher polls the agents and various log files and displays the information in the appropriate consoles.
The lower section of the Launcher shows consoles (icons) for viewing information collected by other agents. The Launcher provides six consoles that monitor server conditions:

- Event Viewer
- Log Viewer
- Physical View
- Logical View
- Kernel Data Catalog
- Process Viewer

The seventh console, On-line Diagnostics, connects you directly to the online SunVTS diagnostics. If the console is unavailable, a slashed circle is displayed (⌀).

Any console with an associated event is highlighted in color. The colors are programmable using event rules. Note that only red, yellow, and blue can be used. Table 3-2 lists the meanings of the colors.

<table>
<thead>
<tr>
<th>Color</th>
<th>Indications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>Serious condition detected by the Event Generator</td>
</tr>
<tr>
<td>Yellow</td>
<td>Warning condition</td>
</tr>
<tr>
<td>Blue</td>
<td>Long term capacity-related condition</td>
</tr>
</tbody>
</table>

**Monitoring Hardware Status**

The following consoles are described in this section and are used to monitor hardware status:

- Physical View, which displays detailed information about the server
- Logical View, which displays the components in a schematic hierarchy
- On-line Diagnostics, which provides a launcher to SunVTS

**Using the Physical View Console**

The Physical View is a graphic (pictorial) representation of the server. Use this console to monitor the configuration and status of your server. If the Event Generator detects problems with a system component, the affected component is highlighted in red, yellow, or blue (see Table 3-2).
If you are monitoring a multi-sided system such as the Ultra Enterprise 6000, when you launch the Physical View, a submenu with three viewing options is displayed:

- Front view
- Rear view
- Both views

The Physical View shows detailed information about the status of individual components in the server. With this option you know exactly what hardware is installed on the server and if there is problem with a component on the server (the component is highlighted). More information on the Physical View is available through the Show Information window (see “Using the Show Information Window” later in this chapter.)

You can switch to an alternate view from any view in the Physical View by using the File menu. For example, if the system you are viewing has Front, Rear, and Side views and you selected Front view, from the Front view you can select the other two views using the File menu.

The Physical View also provides a way to access components that don’t have an image in the current view. For example, disk enclosures don’t have an image in the I/O card. You can access these disk enclosures by clicking on a connector to these disk enclosures. This displays a menu which lists all possible viewpoints from all disk enclosures.

**Displaying a Detailed View of a Component**

When you view a system component, you can also view its internal components. For example, when you view a CPU/Memory board on the Ultra Enterprise 6000 system, you can also view a more detailed image that includes the memory and UltraSPARC modules on the board. When a more detailed sub-view is available, the Physical View cursor changes to a pointing hand. If you don’t see the pointing hand, a more detailed view is not available.

**To Display a Detailed Picture of a Component**

- Click on the component with the pointing hand cursor.

Another Physical View window is displayed with a detailed picture of the component. Figure 3-2 shows the detailed picture of the CPU/Memory board in the Ultra Enterprise 6000 system.
Limitations of the Physical View

The SPARCserver 1000 and SPARCcenter 2000 systems can contain a disk board. However, Solstice SyMON does not sense the disk board because the hardware does not provide a way to sense the disk board. The Physical View does not show the disk board but shows an empty slot. Also, the SPARCserver 1000 and SPARCcenter 2000 do not provide a way to sense fiber optic modules. Their existence is inferred if a SPARCstorage Array is connected to the server.
Using the Show Information Window

The View menu on the Physical View and any sub-views of individual components include a Show Information window, which views more specific information about each system component. The information is continuously updated with information about the component the cursor is over as the cursor moves on the screen.

▼ To Display Component Specific Information in the Physical View

1. Select Show Information from the View menu.

An Information window is created.

2. Move the pointer to a component displayed on the Physical View.

Information about the component is displayed in the Information window (see Figure 3-3). For example, if you place the pointer over a CPU, critical information about the CPU is displayed, including: CPU type, status, cache-size, board number, port ID, processor ID, and model number.

Figure 3-3  Show Information Window
Using the Copy Information Window

In addition to viewing the status of a component with the Show Information window, you may also need a static screen of this information. To do this, use the Copy Information window. It presents the same information as the Show Information window, except that the information in the Copy Information window relates only to the component you selected and is static.

▼ To Select the Copy Information Window

1. Move the mouse on a component in the Physical View or node in the Logical View.

2. Hold down the Menu button of the mouse, which is the mouse button furthest away from the keyboard. This is the right mouse button for a right-handed person and the left mouse button for a left-handed person.

3. Select the copy information dialog box.
   A Copy Information window is displayed showing information about the component or node.

![Copy Information Window](image)

*Figure 3-4*  Copy Information Window Showing the FRU Status of the `peripheral_5v` Node in the Logical View
Using the Close Options

This section describes how to close a Physical View.

To Close a Physical View

- Select one of the following options from the File menu:
  - Close Self, which only closes the window
  - Close All Views of This Component and Descendants, which closes the window and more detailed views of the component
  - Close All Physical View, which closes all Physical View windows

Locating Troublesome Components

If a component has problems or fails, it is highlighted in a color (see Table 3-2). If the component is not highlighted, the component is operating normally.

To Quickly Locate Components that May Cause Problems

- Look at the Physical View and trace events that are highlighted from the top level of the hierarchy down to the component that generated the event.

Using the Logical View

The Logical View, a companion view of the Physical View, displays the components in a schematic hierarchy (see Figure 3-5) instead of showing pictures of the front or rear views. Like the Physical View, the Logical View shows detailed information about the status of many components in the server. If a component is responsible for generating an event, it and all higher level components are highlighted in a color (see Table 3-2), so you can quickly locate the component causing problems.

The bottom of the window contains instruments that may be opened. To display any instruments for a particular component, select (click the left mouse button) in the text of the component. In the Logical View, there are currently only board temperature instruments that are displayed by selecting the component of the SysMeter under the appropriate board.
▼ To Display a System Meter of an Instrument for a Specific Parameter

1. Expand the hierarchy by clicking the + sign.

2. Click the component label (such as disk) to display available instruments in the instrument panel.

3. Display the instrument using one of the following tasks:
   • Click the instrument (parameter) you want displayed, for example ops (op/sec), at the right of the display.
     A System Meter window is created with a graph of the selected parameter (Figure 3-10).
   • Drag the instrument and drop it in an existing System Meter.
     Use the middle or left mouse buttons as you move the mouse.
Figure 3-5  The Logical View
Expanding and Collapsing the Hierarchical Diagram

A button to the left of each component in the hierarchy is displayed (see Figure 3-5). The two states of the button are:

- **Collapsed (+)**, which contracts the entire hierarchy below the point you are at. The rightmost column in Figure 3-4, noted by + signs, shows a collapsed display. The hierarchy below these hardware components is not displayed.

- **Expanded (-)**, which displays the hierarchy below the point you are at one level at a time. The server owey in Figure 3-4, noted by a - sign, shows the expanded display to the right.

You cannot mix Logical View instruments with Kernel Data Catalog instruments in the same System Meter.

▼ To Expand the Hierarchy

♦ Click the (+) button one level.

The hierarchy below that point is expanded and is noted by a - sign. To view the entire hierarchy you may need to resize the window.

▼ To Hide the Contents of the Hierarchy

♦ Click the - button.

The button changes to a + sign and the contents of the lower level of the hierarchy are hidden.

Summary of Expanding and Collapsing the Hierarchical Diagram

If you double click the + button, the entire hierarchy is fully expanded. Clicking once returns you to the previous expansion. For information on how to set the double click, see the window manager documentation. See the CDE online help for instructions on how to set the double click time.

Limitations of the Logical View

The SPARCserver 1000 and SPARCcenter 2000 systems can contain a disk board. However, Solstce SyMON does not sense the disk board because the hardware does not provide a way to sense the disk board. The Logical View shows the disks that are located in the disk board. However, it does not show...
them as children of the disk board. Instead, it shows them as children nodes of an SBus card, which is a child node of one of the system boards. Also, the SPARCserver 1000 and SPARCcenter 2000 do not provide a way to sense fiber optic modules. Their existence is inferred if a SPARCstorage Array is connected to the server.

**Using the Show Information Window**

The View menu on the Logical View includes a Show Information window that is identical to the Physical View.

**Note** – The Show Information window is shared between the Physical View and the Logical View. If you launched the Show Information Window from the Physical View, you do not need to re-launch it from the Logical View (or vice-versa).

▼ **To Display Component-Specific Information in the Logical View**

1. Select Show Information from the View menu.

2. Move the pointer to a component displayed on the Logical View or Process Viewer.
   Information about the component is displayed in the Show Information window.

**Using the Copy Information Window**

You can use the Copy Information window to obtain a static screen of the same information presented in the Show Information window. The information in the Copy Information window relates only to the selected component.

For a step-by-step procedure on how to use the Copy Information window, see “To Select the Copy Information Window” earlier in this chapter. Using the Copy Information window works the same way for the Physical and Logical Views.
Using the Online Diagnostics Console

The On-line Diagnostics icon launches the SunVTS Online GUI. This GUI is used to perform online diagnostics and troubleshoot components (see Figure 3-6).

SunVTS is a suite of diagnostics that test and validate the configuration and functionality of most hardware devices of a server. It is a diagnostic tool that handles sequential testing of system resources and internal and external peripheral equipment.

When you click the On-line Diagnostics console, the following screen is displayed (see Figure 3-6).
Figure 3-6  SunVTS Online Diagnostic Tool
Table 3-3 describes the features shown in Figure 3-6:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
</table>
| Menu Bar           | Includes these menus at the top of the GUI:  
- Commands  
- View  
- Help |
| Tool Bar           | Provides a shortcut for executing commands in the Commands menu |
| System Map         | Creates a hierarchy of devices that you can select for testing. During testing, the System Map provides testing status for each device by changing the color of the device name.  
Green = pass and red = failure. |
| Select Devices     | Contains buttons from which you can select or deselect a group of devices from the System Map on which to run tests.                          |
| Select Mode        | Contains two options from which you can select the mode to run a test:  
- Connection Test mode—Quick check that each device is connected properly and ready to use  
- Functional Test mode—A more thorough functional check of the device in a non-destructive operation |
| Test Message       | Displays error and informational messages                                                                                                    |
Commands Menu

The Commands menu (see Figure 3-7) contains several commands that you can use to control the testing of the target server system.

![Commands Menu](image)

Figure 3-7  Commands Menu

The following selections are available from the Commands menu (see Table 3-4):

Table 3-4  Description of Commands in the Command Menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Testing</td>
<td>Begins executing tests on each device (after all the devices are selected and the testing mode is set.) Test execution proceeds sequentially.</td>
</tr>
<tr>
<td>Stop Testing</td>
<td>Stops all device testing and returns SunVTS to an idle state.</td>
</tr>
<tr>
<td>Reset</td>
<td>Resets all device name colors in the System Map to black.</td>
</tr>
<tr>
<td>Offline Testing</td>
<td>Terminates the SunVTS Online GUI and starts up the Offline GUI. Offline testing includes testing that may be destructive to the media (for example disk writes).</td>
</tr>
</tbody>
</table>
To Run a SunVTS Test

1. Select the devices you want tested:
   - If you want to run a predefined set of tests, select Default.
   - If you want to run tests on all of the devices, select All.
   - If you want to run a test on one device or just a few devices, select None.
     a. Select the device(s) you want tested by clicking the device name or check box (see Figure 3-6).

2. Select the testing mode.
   - Connection Test—A quick check that each device is connected properly and ready to use
   - Functional Test—A more thorough functional check of the device in a non-destructive operation

3. Start the test by clicking the Start button or select Start Testing from the Commands menu.
   As the tests are run on each device, an asterisk (*) appears next to the device in the System Map. The device name turns green if the tests pass; or red if the tests fail.

4. If you want to stop all testing and return SunVTS to an idle state, stop the test by clicking the Stop button or select Stop Testing from the Commands menu.

View Menu

Use the View menu (see Figure 3-8) to expand or contract the system hierarchy (also known as the System Map), which has two options:

- Open System Map
- Close System Map
To Expand the System Map

♦ Select Open System Map from the View menu.
The hierarchy of devices in the System Map is expanded to show all devices in the System Map.

To Contract the System Map

♦ Select Close System Map from the View menu.
The hierarchy of devices in the System Map is contracted. Only major devices are displayed.

Additional Information on SunVTS

For more information about SunVTS, refer to the SunVTS 2.0 User’s Guide, the SunVTS 2.0 Test Reference Manual, and the SunVTS 2.0.1 Test Supplement in the Solaris 2.5.1 Hardware: 4/97 Solaris on Sun Hardware AnswerBook on the Updates for Solaris Operating Environment 2.5.1 Hardware: 4/97 for Sun Microsystems Computer Company CD.

Monitoring System Performance

Solstice SyMON also monitors system performance and identifies potential bottlenecks. Solstice SyMON uses the Log Viewer and the Process Viewer consoles to monitor system performance. Solstice SyMON also uses System Meters to monitor performance. How to use the System Meter and Kernel Data Catalog consoles is explained in the sections that follow.

Using the Kernel Data Catalog

System Meters are graphical displays of system performance. You build System Meter displays using the Kernel Data Catalog.

To Evaluate the Extended Performance of the Server

♦ Create one or more System Meters using the Kernel Data Catalog.
System Meters can help to identify bottlenecks and anticipate potential capacity and hardware problems. To build System Meters, see “Building System Meter Windows” later in this chapter.
Kernel Data Catalog Instruments

The Kernel Data Catalog console displays the system performance parameters (see Figure 3-9). These parameters are displayed as instruments within the instrument panel of the Kernel Data Catalog (see Figure 3-9). When you select (click on) a particular text of a component, a menu of available parameters (instruments) for that component is displayed in the instrument panel.

Like the Logical View, you can choose whether the instruments associated with each hierarchy are displayed (-) or hidden (+). Instruments can be used in System Meters and the Kernel Data Catalog. However, you cannot mix Kernel Data Catalog instruments with Logical View instruments in the same System Meter.

For a complete listing of the Kernel Reader data hierarchy, see Appendix A, “Kernel Reader.”

Figure 3-9  Kernel Data Catalog Console

When the status of a parameter results in an event, the Event Manager highlights the parameter and its ancestors on the Kernel Data Catalog.
Building System Meter Windows

The System Meter windows provide a graphical display of system performance parameters. Use the instruments displayed in the Kernel Data Catalog to:

• Create a graph for one parameter in a System Meter
• Combine multiple parameters on the same graph in a System Meter
• Combine multiple graphs in the same System Meter
• Locate multiple System Meters

For information on locating troublesome components, see “To Quickly Locate Components that May Cause Problems” earlier in this chapter. To expand or collapse the hierarchical diagram, see “Expanding and Collapsing the Hierarchical Diagram” earlier in this chapter.

▼ To Display a System Meter of An Instrument for a Specific Parameter

1. Expand the hierarchy by clicking the + sign.

2. Click the component label (such as disk) to display available instruments in the instrument panel.

3. Display the instrument using one of the following tasks:
   • Click the instrument (parameter) you want displayed, for example ops (op/sec), at the right of the display. A System Meter window is created with a graph of the selected parameter (Figure 3-10).
   • Drag the instrument and drop it in an existing System Meter. Use the middle or left mouse buttons as you move the mouse.

▼ To Display Multiple System Meters in the Same Window

1. Click the System Meter window you want to activate.

2. Select the legend for the desired parameter (for example writes (ops/sec)) and drag it to the footer of the second System Meter window (see Figure 3-10). A second pane is added to the System Meter window and the graph for the new parameter is displayed in the new pane.
To Select One Graph at a Time per System Meter

♦ Click the selected graph within the System Meter window. The graph with a darker background is selected.

![Figure 3-10 Displaying Two System Meters in the Same Window](image)

To Display Multiple Parameters on the Same Graph

♦ Drag an instrument and drop it in the graph to which you want added.

Customizing a System Meter

To customize a System Meter window, use the following options under the View menu. The View menu options are:

- Layout
- Graph Style
- Title
To Control the Appearance of a System Meter

Use the Layout option to control the appearance of a System Meter window that contains multiple graphs:

- Horizontal displays graphs horizontally, from left to right
- Vertical displays multiple graphs vertically, from top to bottom
- Matrix displays multiple graphs in a grid format

To Use the Graph Style Option

1. Select Graph Style from the View menu.
   The Graph Style window is displayed (see Figure 3-11).

2. Select one of three options under the submenu “Scope of Changes:” in the top portion of the Graph Style window.
   - All Graphs
   - All Graphs in Selected System Meter
   - Currently Selected Graph in Selected System Meter

   For an explanation of the bottom half of the window, see Table 3-5.
▼ To Change the Title of the SysMeter

♦ Use the title option to change the title of the SysMeter or the title of the currently selected graph.

▼ To Modify the Selected SysMeter

1. Select the SysMeter using the “System Meter Selection” field (Figure 3-11).

2. Modify graph attributes of the SysMeter using the bottom half of the window (Table 3-5).

   For example, you can change graph scaling, Y axis minimum and maximum, legend gravity, and legend orientation.

   Table 3-5 shows the graph attributes that you can modify.

   Table 3-5  Graph Style Window Attributes

<table>
<thead>
<tr>
<th>Field</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Defaults</td>
<td>Active/Inactive</td>
<td>Selects default settings for all fields at the bottom of the form</td>
</tr>
<tr>
<td>Y-Axis Scaling</td>
<td>Automatic</td>
<td>Makes Y-axis scaling changes to reflect changing values (default)</td>
</tr>
<tr>
<td></td>
<td>Fixed</td>
<td>Makes Y-axis scaling constant, regardless of changes in values</td>
</tr>
<tr>
<td>Y-Axis Scaling</td>
<td>Linear</td>
<td>Makes Y-axis scaling linear (default)</td>
</tr>
<tr>
<td></td>
<td>Log</td>
<td>Makes Y-axis scaling logarithmic; useful when a graph includes two parameters with vastly different values</td>
</tr>
<tr>
<td>Legend</td>
<td>Normal</td>
<td>Shows the legend name for each variable (default)</td>
</tr>
<tr>
<td></td>
<td>None</td>
<td>Omits the legend</td>
</tr>
<tr>
<td></td>
<td>Long</td>
<td>Extended label for each variable; for example, cpu.cpu0.busy (%)</td>
</tr>
</tbody>
</table>
To Change the Title of the System Meter or the Currently Selected Graph

1. Select Title from the View menu with the left mouse button.
   A window is displayed.

2. Type the new title in the text field and click Apply.
   The title of the System Meter or graph is changed.

To Change a Graph Within a System Meter

1. Choose the Graph Styles option from the View menu of any System Meter.

2. Select the graphs that you want to change, using the top section of the window.

Table 3-5  Graph Style Window Attributes (Continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graph Type</td>
<td>Area</td>
<td>Draws an area graph</td>
</tr>
<tr>
<td></td>
<td>Line</td>
<td>Draws a line graph (default)</td>
</tr>
<tr>
<td>Y-Axis Minimum</td>
<td></td>
<td>Sets the minimum value for the Y-axis; used only if Y-Axis is “Fixed”</td>
</tr>
<tr>
<td>Y-Axis Maximum</td>
<td></td>
<td>Sets the maximum value for the Y-axis; used only if the Y-Axis if “Fixed”</td>
</tr>
<tr>
<td>Legend Gravity</td>
<td>Top</td>
<td>Default setting</td>
</tr>
<tr>
<td></td>
<td>Top-right</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Right</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Bottom-Right</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Bottom</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Bottom-Left</td>
<td>Default setting</td>
</tr>
<tr>
<td></td>
<td>Left</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Top-Left</td>
<td></td>
</tr>
<tr>
<td>Legend Orientation</td>
<td>Vertical</td>
<td>Displays the legend in a vertical format</td>
</tr>
<tr>
<td></td>
<td>Horizontal</td>
<td>Displays the legend in a horizontal format (default)</td>
</tr>
</tbody>
</table>
3. Make the desired changes to the controls on the bottom half of the window.

4. Click Apply.

▼ **To Delete a Graph Within a System Meter Window**

1. Select a graph

2. Select Delete from the SysMeter Edit menu.

▼ **To Undo a Change in a Graph**

♦ Select Undo from the SysMeter Edit menu.

▼ **To Delete a Variable from a Graph**

**Note** – If you have more than one legend in a graph, you can delete one of the legends. See the following procedure for details.

1. Place the pointer over the legend for the variable and click the left mouse button.
   A dialog box asks, “Do you want to delete the following data set?” with the following information in the dialog box:
   - System Meter: Variable name
   - Graph: Defines parameters being displayed
   - Data Set: Lists the operation being monitored

2. Delete the variable by clicking the YES button.
Displaying the System Meter Graphs

You can move, rotate, scale, or zoom the contents of your graph to better display the information with the following procedures:

▼ To Shift the Graph Within its Framer

1. Position the pointer within the System Meter.
2. Press and hold the Shift key and the middle mouse button.
3. Move the graph using the mouse.

▼ To Scale a Graph

1. Position the pointer within the selected graph.
2. Press and hold both the Control key and the middle mouse button.
3. Move the mouse to scale the graph.
   Releasing the mouse button stops graph movement within the graph.

▼ To Zoom a Graph

1. Press and hold down the Control and Shift keys and the left mouse button at one corner of the graph.
2. Drag the mouse to form a rectangle around the area you want to magnify while holding down the left mouse button.
3. Release the mouse button to define the rectangle and to complete the zoom.
4. Release the Control and Shift keys.

Note – If you release the Control or Shift keys too early, you start to drag-and-drop instead of zoom.
To Restore a Graph to the Default Setting

♦ Position the cursor within the desired graph and type r.

Saving and Redisplaying System Meter Configurations

You can save and recall the System Meter your defined layouts and configurations. For example, you may have a specific set of CPU monitoring graphs that you would like to view every time you run the software.

To Save the System Meter Configuration into a New File

1. Choose the Save As option from the File menu.
The File Selection Dialog box is displayed.

2. Select the directory and file name from the Directories and Files submenu or enter a new file name in the Selection submenu.

To Save an Altered System Meter Configuration

♦ Choose the Save option from the File menu.
The SysMeter contents is written to the existing file and displays the name of the saved file in the footer of the System Meter window.

To Recall a Saved System Meter

1. Choose the Open option from the File menu.
The File Selection Dialog box is displayed.

2. Select the file name from the Directories and Files submenu or enter the file name in the Selection panel.

To Save or Restore Sets of System Meters

♦ Use the File menu in the Kernel Data Catalog.
Using the Log Viewer

Use the Log Viewer to search `/var/adm/messages` as defined in 
`/etc/opt/SUNWsymon/log_scan.tcl`, for entries that occur at a 
specific time or for entries that contain a specific keyword or word 
pattern. With Solstice SyMON 1.3 you can also search 
`/var/opt/SUNWvts/logs/sunvts.err`. You can use keywords or 
expressions to search for particular types of items in `/var/adm/messages` 
without using UNIX commands. Open the Log Viewer console to 
display the Log File Viewer window as shown in Figure 3-12.

A new Log File Viewer window is opened each time you select the Log Viewer 
console. This enables you to monitor different criteria at the same time.

![Figure 3-12 Log File Viewer Window](image-url)
View Menu in the Log File Viewer Window

The View menu of the Log File Viewer controls the appearance of the window and provides status information. The options are:

- **Log File Status**: Describes the Log Scanner status
- **Show Search Criteria Summary**: Displays or hides the Search Criteria Summary pane of the window (toggle button)
- **Display Oldest/Newest Messages First** (toggle button): Defines how results are displayed in the Search Result window; displays either the oldest message first or the newest message first.
- To make the Oldest Message First active, select Display Oldest Messages First item in the View menu. The small square indicates that the menu selection is active.

Searching for Log File Entries

The Search Results window is empty until you specify the search criteria in the Search for Expression entry (see Figure 3-12) and initiate the search. You can specify your own Search Criteria, retrieve and use a stored Search Criteria, or retrieve and modify a stored Search Criteria. Log entries retrieved by a search include the items listed in Table 3-6.

Table 3-6 Log Entry Search Criteria

<table>
<thead>
<tr>
<th>Searches for</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log File</td>
<td>Name of the log file viewed</td>
</tr>
<tr>
<td>Search for Expression</td>
<td>User-defined keyword, string, or regular expression</td>
</tr>
<tr>
<td>Messages From</td>
<td>Start date and start time of search</td>
</tr>
<tr>
<td>Messages To</td>
<td>End date and end time of search</td>
</tr>
<tr>
<td>Periodic Query</td>
<td>Interval (in minutes) between repeated searches</td>
</tr>
<tr>
<td>Maximum Number of Matches</td>
<td>Only this number of messages specified is reported</td>
</tr>
<tr>
<td>Search Order</td>
<td>Oldest (or newest) message searched first</td>
</tr>
</tbody>
</table>

If Solstice SyMON locates entries in the selected log file that meet the search criteria, they are displayed in the Search Results display.
To Initiate a Search

♦ Select the Start Search button from the Log File Viewer window (Figure 3-12).

To Stop a Search

♦ Select the Stop Search button from the Log File Viewer window.

Note – Due to the client-server structure of Solstice SyMON, results may not appear for several seconds after submitting the search. This condition is more evident when the server is fully loaded.

To Sort the Results of the Search

♦ Select either the Display Oldest Message First or the Newest Message First from the View menu.

To Define Your Search Criteria for Specific Log File Entries

♦ Select the Change Search Criteria button in the Log File Viewer window (Figure 3-12).

To Specify the Start Date, Start Time, End Date, and End Time

1. Move the pointer to the “From” field text field.
   Enter the time in 24-hour format (see Figure 3-13). The “From” time defaults to the time that the log was created.

2. Move the pointer to the “To” text field.
   Enter the time and date field. The “To” time defaults to the current time. See Figure 3-13.
To Search for Log File Entries that Contain a Specific Expression or Keyword

♦ Move to the Search for Expression field and enter the expression or keyword.

To Perform More Complex Searches

♦ Specify a grep-like regular expression instead of a keyword.
For regular expression syntax, refer to the grep man page.
Search Criteria and Results

From the File menu of the Log File Viewer window (see Figure 3-14), you can:

- Load search criteria
- Save search criteria
- Save search results
- Close

Using the Process Viewer

To monitor the most demanding processes and determine if you need to reallocate resources, use the Process Viewer.

By viewing what particular processes are running on the CPU, you can determine if a particular server is busy due to a temporary overload or because of a progressive increase in system usage. Processes that are inactive or consume little CPU time are not reported in the Process Viewer.

Each entry displayed on the Process Viewer console represents a process with the following data:

- When the process was started
- Who started the process
- How much CPU time the process used
- Current process status
Table 3-7 describes the information displayed in each Process Viewer entry:

**Table 3-7 Process Viewer Entry Descriptions**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID</td>
<td>Process ID</td>
</tr>
<tr>
<td>command</td>
<td>Name of program</td>
</tr>
<tr>
<td>UNAME</td>
<td>User name</td>
</tr>
<tr>
<td>UID</td>
<td>User ID</td>
</tr>
<tr>
<td>nice</td>
<td>Determines when the process can voluntarily lower its priority. As the nice value increases, the process is more willing to give up CPU scheduling priority (value defaults to 20). For more information, see the nice man page.</td>
</tr>
</tbody>
</table>
| status | Lists the current status of the process:  
  - Sleeping: No activity generated  
  - Running: Generating activity  
  - Runable: Waiting for I/O  
  - Trace: Running a debugger |
To Customize the Process Viewer Display

- See “Customizing the Event Viewer and Process Viewer” later in this chapter.

You can customize the Process Viewer window to display specific information. You can set the order in which columns are displayed, their default width, and the default sort column through the common.tcl file, which is read when Solstice SyMON is first started.

To Control the Sorting of Entries in the Process Viewer Display

- Use the options under the View menu.
  - Sort: The menu displays a list of the fields (columns) for each process view. You can choose one of these fields as the basis for sorting the process views. You can also click the column’s header to change the sort order.
  - Ascending Sort Order: Presents the display in ascending sort order for the selected column.
  - Descending Sort Order: Presents the display in descending sort order for the selected column.

### Customizing the Process Viewer Display

#### Table 3-7  Process Viewer Entry Descriptions  (Continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>% CPU</td>
<td>Percentage of CPU time used over the life of the process</td>
</tr>
<tr>
<td>Total CPU</td>
<td>The CPU time used by the system, user, and short-lived processes</td>
</tr>
<tr>
<td>Start</td>
<td>Time the process started; if the process has been running for more than 24 hours, it displays the date the process started</td>
</tr>
</tbody>
</table>

Solstice SyMON 1.3 User’s Guide—April 1997
Resizing Columns

You may need to resize the columns to read the displayed information. You’ll know if the column is too narrow because a small black triangle in the column will be displayed. To view all of the information in the column, you’ll need to resize the column.

To Resize a Column

1. Place the pointer in the column that you want to resize.
2. Move the pointer to the left or right margin of the column. The pointer changes from a cross hair to an arrow (→).
3. Press and hold the left mouse button.
4. Drag the margin to the desired spot and release the mouse button.

Monitoring Alarms and Events

The Event Manager monitors data from the server and generates events when abnormal conditions occur on your server. The condition, and their corresponding alarms, are described by a set of event rules. Chapter 4, “Understanding and Writing Event Rules,” which describes the syntax of the Tcl commands used to write event rules and provides examples of event rules.

Using the Event Viewer

The Event Viewer gives users a tabular listing of potential problems or failures. Use this information to react proactively to prevent problems or to quickly identify and repair failures. When you launch the Event Viewer, the information in the Event Log file is displayed (see Figure 3-16).
When the Event Viewer is notified of an event, it adds a description of the event to its display, which includes the information listed in Table 3-8. You can alter the order and column width. To learn how to customize the Event Viewer display, see “Customizing the Event Viewer and Process Viewer” later in this chapter.

Table 3-8 Description of Entries in the Event Viewer for Open Events

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Sequential number assigned to the event</td>
</tr>
<tr>
<td>Lvl</td>
<td>Level of events: yellow (caution), red (danger), blue (capacity warning)</td>
</tr>
<tr>
<td>Opened</td>
<td>Time (and date, if over 24 hours) the event was opened</td>
</tr>
<tr>
<td>Message</td>
<td>Event message (failure detected, for example)</td>
</tr>
<tr>
<td>Node</td>
<td>Where the error was encountered</td>
</tr>
<tr>
<td>Pri</td>
<td>Priority of the event rule, which is an arbitrary integer; in the default rules, 1 = highest priority; 4 = lowest priority</td>
</tr>
<tr>
<td>Sev</td>
<td>Severity level of the event, which is an arbitrary integer; in the default rules, 1 = most severe; 4 = least severe</td>
</tr>
</tbody>
</table>
You can add or change Acked, Ack By, or Rule (see Table 3-8) by specifying them in `common.tcl`.

**Event Viewer Menus**

The menu choices available from the View menu of the Event Viewer are:

- **All Events**: Displays all events (even if closed), until they are deleted.
- **Open Events**: Displays only currently open events. This view is displayed when you select the Event Viewer icon.
- **Sort**: The menu displays a list of the fields (columns) for each Event View. You can choose one of these fields as the basis for sorting the Event Views. You can also click the column title bar to change the sort order (see Table 3-8).
- **Ascending Sort Order**: Presents the display in ascending sort order.
- **Descending Sort Order**: Presents the display in descending sort order.

When an event is open, the Event Manager highlights the event in the Logical View and Physical View or the Kernel Data Catalog until the cause of the event is corrected or the event is closed.

When the condition that caused an event ends, the description of the event is removed from the Open Event view and any associated highlighted consoles. The Event Manager notes the closing of the event in the event log.

**Acknowledging and Deleting Events**

When you acknowledge an event, it has no effect on the event condition or alarms. However, it informs all users that the event has been observed.
To Acknowledge an Event

1. Select the event to be acknowledged by clicking any column in the row with the left mouse button. The entire row is highlighted.

2. Select Acknowledge from the Edit menu. The Event Manager enters the time and date in the Acked column and your User ID in the Ack By column.

Note – If you acknowledge or delete an event, the change appears in all GUIs.

After the event is closed, it remains in the All Events view until you delete it.

To Delete a Closed Event

1. Select All Events from the View menu.

2. Select the event to be deleted by clicking the event (which highlights it) and select Delete from the Edit menu.

Note – You cannot delete an Open event from the event list.

Customizing the Event Viewer and Process Viewer

You can customize the Event Viewer and Process Viewer windows to suit your particular display requirements.

To Customize the Event Viewer and Process Viewer

• If you are responsible for customizing Event Viewer and Process Viewer for all Solstice SyMON users, you must edit the /opt/SUNWsymon/lib/tcl/C/common.tcl file.

• If you are a Solstice SyMON user, copy the /opt/SUNWsymon/lib/tcl/C/common.tcl file to $HOME/.symon/lib/tcl/C/common.tcl. Replace any symbolic links for common.tcl in that directory. Edit the personal copy.
The common.tcl file is read and interpreted when you start the GUI. This file controls the appearance of these consoles.

You can set the following attributes:

- Order in which columns are displayed
- Default column width
- Default sort column
- Justification for column titles

The common.tcl file sets three major Tcl variables:

- `symon_process_columns_2`—Controls the appearance of the Process Viewer
- `event_display_open_columns_2`—Controls the appearance of the Open Events display
- `event_display_all_columns_2`—Controls the appearance of the All Events display

Within each of these variables is a line for each data item. The order in which these data item lines appear in the Tcl variable is the order in which their respective columns appear in the displays.

A typical line looks like this:

```
{"tpcnt" " Total (%) " " + "}
```

Table 3-9 describes the meaning of the strings in the line listed above.

<table>
<thead>
<tr>
<th>String</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;tpcnt&quot;</td>
<td>Internal name for the data item.</td>
</tr>
</tbody>
</table>
| " Total (%) " | Title for the column in which it is displayed.  
The total length of this string (including spaces) controls the default width of the column. |
| " + "    | Controls the default sort order of the column (+ for ascending, - for descending). This string can be only - or +. |
Some lines may have a fourth string with a format specifier such as %s or %d; these are not used and may be omitted.

You can also customize the icon that is displayed in the lvl (level) column of the Event Viewer. These Tcl variable are:

- \texttt{event\_display\_red\_ pixmap\_path}
- \texttt{event\_display\_yellow\_ pixmap\_path}
- \texttt{event\_display\_blue\_ pixmap\_path}

You must specify the absolute path of the icon file.

Associated with each of the appearance-controlling Tcl variables are two other variables. In the All Events display they are

- \texttt{event\_display\_all\_ columns\_ alternate\_2}—Holds control lines for data items that do not appear in the display
- \texttt{event\_display\_all\_ columns\_ sort\_ node}—Takes a single argument: the name of the data item used to sort the display when it initially appears

There are similar variables for the Open Events and Process displays.

\textit{Troubleshooting}

To troubleshoot problems with the GUI, see Chapter 6, “Troubleshooting.”
Understanding and Writing Event Rules

This chapter explains how to write or modify event rules that are written in the Tcl scripting language. It describes the categories of event rules, the syntax of the Tcl functions, and how to write or modify event rules for agents including: Config Reader, Kernel Reader, Log Scanner, and Event Generator. At the end of this chapter, examples of simple and complex rules are presented.

Overview of Event Rules

This section describes and explains:

- Terminology used with event rules
- Categories of event rules
- Rules files
- Special characters and reserved words
- Attributes

Event rules are not required to include an action and can set a value that is used in other rules. All rules are combined into a single Tcl variable called Rules.tcl, which is case sensitive.

For a list of books describing the Tcl language, see “Related Documents” in the Preface.

Caution – You must know Tcl to modify event rules. Do not modify event rules if you do not know Tcl. Incorrectly modifying an event rule will cause an error or an incorrect result to occur.
Terminology

*Events* are hardware or operating system conditions that may require the attention of a system administrator. Examples of events include:

- Processor overload
- Excessive swapping
- Failed power supply
- Failed fan
- Soft disk errors
- Extreme temperature conditions

Before the Event Generator subsystem can alert you of an event, you must first write a rule that defines the event. A *rule* includes a *condition* and other attributes that define the state of the rule and the subsequent *actions* to take.

A condition is an expression that defines when a rule is active. An example of a condition is a failed board. Actions identify how to tell users about a situation that may require attention. For example, an action tells Solstice SyMON what to do when a condition is true, if the condition changes, or if the system shuts down.

In addition to conditions and actions, a rule may also include the attributes listed in Table 4-1.
Sun supplies a set of pre-defined rules with Solstice SyMON. They are divided into four major categories (see Table 4-2).

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LEVEL</td>
<td>Causes the appearance of an appropriately colored icon in the LEVEL column of the event display. By convention, YELLOW is caution, RED is danger, and BLUE is a capacity warning.</td>
</tr>
<tr>
<td>PRIORITY</td>
<td>Arbitrary integer value. For the rules that accompany Solstice SyMON, 1 is the highest priority and 4 is the lowest priority. You can swap or customize these values. For example, you can make 4 the highest priority and 1 the lowest priority. You can also customize the priority by assigning other numeric values, such as 99 to PRIORITY.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>Arbitrary integer value. For the rules that accompany Solstice SyMON, 1 is the highest priority and 4 is the lowest priority. You can swap or customize these values. For example, you can make 4 the highest priority and 1 the lowest priority. You can also customize the severity by assigning other numeric values, such as 99 to SEVERITY.</td>
</tr>
</tbody>
</table>

Types of Event Rules

Sun supplies a set of pre-defined rules with Solstice SyMON. They are divided into four major categories (see Table 4-2).
Appendix D, “Default Solstice SyMON 1.3 Rules” describes the default Solstice SyMON 1.3 rules. By knowing what the default rules are, you can easily determine if you need to write any new rules.

### Description of Rules Files

The `rules.tcl` file defines the location of the rules that tell Solstice SyMON what to do in a given situation. Each type of event rule has a rule file (see Table 4-3). To tell the Event Generator where to look for these rules files, set the path in `event_gen.servername.tcl`. For a list of the default paths, see “Locating Rule Files” later in this chapter.

The `rules.tcl` file reads the rest of the rules files listed in Table 4-3 into the input stream by doing a `psource` of each of the rule files. The `n` after the `psource` command in the `rules.tcl` file means to not complain if it can’t find the file. The `y` after the `psource` command in the `rules.tcl` file means to complain if it can’t find the file.
All of the rules files listed in Table 4-3 are located in rultext.tcl. There is a different rultext.tcl file for each country in which the software is localized. These rultext.tcl files are located in subdirectories. For example, the English rultext.tcl file is located in the C subdirectory.

The following rules files (see Table 4-3) contain generic rules, which apply to any system type. However, platform specific rules (see Table 4-4) apply only to one type or one class of system.

Table 4-3 Description of Rules Files

<table>
<thead>
<tr>
<th>Rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>rules.tcl</td>
<td>Organizer (master file)</td>
</tr>
<tr>
<td>cprules.tcl</td>
<td>Capacity planning rules</td>
</tr>
<tr>
<td>hwrules.tcl</td>
<td>Hardware monitoring rules</td>
</tr>
<tr>
<td>syrules.tcl</td>
<td>Monitoring rules</td>
</tr>
<tr>
<td>egrules.tcl</td>
<td>Event Generator rules</td>
</tr>
<tr>
<td>pfrules.tcl</td>
<td>Predictive failure rules</td>
</tr>
<tr>
<td>swrules.tcl</td>
<td>System monitoring rules</td>
</tr>
<tr>
<td>rultext.tcl</td>
<td>Message string definition rules</td>
</tr>
</tbody>
</table>

Table 4-4 lists platform-specific rules files and the platforms to which they apply.
For each hardware platform, there is a corresponding \texttt{rultext_<hardwarename>\_tcl} file. For example, for the SPARCserver 1000 and 1000E, there is a \texttt{rultext\_SS1000.tcl} file and for the SPARCcenter 2000 there is a \texttt{rultext\_SC2000.tcl} file. The \texttt{rultext_<hardwarename>\_tcl} files contain messages that can be translated into different languages.

### Special Characters

The following special characters are used in the Tcl language:

- " " (double quotes)
- \{ \} (curly brace)
- [ ] (square bracket)
- # (pound sign)
- * (asterisk)

Follow these guidelines when using these special characters:

- Enclose each Tcl function string in curly braces \{ \}.
- If you include spaces in an attribute data item, enclose the data item in double quotes."
Reserved Words

Table 4-5 describes the Tcl reserved variable names, which contain certain values that have specific meaning for the Event Generator.

Note – Do not redefine these variable names.

Table 4-5   Reserved Tcl Variable Names

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>symond_status</td>
<td>Tells whether the symond daemon is running</td>
</tr>
<tr>
<td>server_status</td>
<td>Tells whether the monitored system is up</td>
</tr>
<tr>
<td>LogScanner_status</td>
<td>Tells if the Log Scanner agent is running</td>
</tr>
<tr>
<td>ConfigReader_status</td>
<td>Tells if the Config Reader agent is running</td>
</tr>
<tr>
<td>KernelReader_status</td>
<td>Tells if the Kernel Reader agent is running</td>
</tr>
<tr>
<td>node</td>
<td>Contains the root hierarchy that is being evaluated in the rule. Accessible only from within a MULTI rule (see “MULTI Rules” later in this chapter.)</td>
</tr>
<tr>
<td>my_root</td>
<td>Contains the root node for the Event Generator hierarchy; this variable should not be changed</td>
</tr>
<tr>
<td>value</td>
<td>Contains the value of the node returned by the findlist function in a MULTI rule. Accessible only from within a MULTI rule (see “MULTI Rules” later in this chapter)</td>
</tr>
<tr>
<td>timestamp</td>
<td>Contains the timestamp of the matched message</td>
</tr>
</tbody>
</table>

Attributes

A rule is a list of attributes. Attributes list conditions under which the rules should activate or close down and what actions to take when the rule is activated. A condition of a rule can look at time or other values in the environment.

Each attribute has a label followed by a value. Separate the components of an attribute with spaces, tabs, or new lines and separate each attribute with a new line or space.
Table 4-6 describes attribute descriptions.

**Table 4-6  Attribute Descriptions**

<table>
<thead>
<tr>
<th>Label</th>
<th>Value</th>
<th>Attribute Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RULE</td>
<td>Integer</td>
<td>Rule number displayed by the Event Viewer to show which rule generated the event. The rule number must be unique across all rule files.</td>
</tr>
<tr>
<td>ON_OPEN</td>
<td>Tcl script</td>
<td>Tcl string giving actions to take when the condition of the rule becomes true</td>
</tr>
<tr>
<td>ON_CONTINUE</td>
<td>Tcl script</td>
<td>Tcl string giving actions to take when the condition of a rule continues to be true</td>
</tr>
<tr>
<td>ON_CLOSE</td>
<td>Tcl script</td>
<td>Tcl string giving actions to take when the condition of a rule is no longer true</td>
</tr>
<tr>
<td>ON_ACKNOWLEDGE</td>
<td>Tcl script</td>
<td>Interpreted when the Event Generator receives an acknowledgment of an event from the GUI</td>
</tr>
<tr>
<td>ON_SHUTDOWN</td>
<td>Tcl script</td>
<td>Tcl string to be interpreted when the Event Generator shuts down</td>
</tr>
<tr>
<td>PARAMETERS</td>
<td>String</td>
<td>User-defined parameters</td>
</tr>
<tr>
<td>MULTI</td>
<td>Tcl script</td>
<td>Tcl string to provide a list of data node variables for multiple events of a single rule</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>Integer</td>
<td>Severity of the event (user-defined and interpreted); 1 = most severe and 4 = least severe. See also Table 4-1 earlier in this chapter, which describes in more detail this attribute</td>
</tr>
<tr>
<td>PRIORITY</td>
<td>Integer</td>
<td>Priority of the event (user-defined and interpreted); 1 = most severe and 4 = least severe. See also Table 4-1 earlier in this chapter, which describes in more detail this attribute</td>
</tr>
</tbody>
</table>
MULTI Rules

This section describes MULTI rules, which are used in Tcl functions. The following paragraph explains this code example:

```
MULTI { expr { [ findlist KernelReader.disk.*.busy .busy ] } }
```

The MULTI statement tells the Event Generator to repeat the same rule on each node that is returned from the findlist function. The findlist function finds the node whose name matches KernelReader.disk.*.busy. Since the strip string (strip string means remove or strip out) is defined as .busy the node name that is returned in the node variable by the findlist function contains only the matched node name, which excludes .busy. For example, if the findlist function matches a node named KernelReader.disk.sd8.busy, the $node variable contains KernelReader.disk.sd8. Because the strip string is not null, it does not have to be in double quotes.

<table>
<thead>
<tr>
<th>Label</th>
<th>Value</th>
<th>Attribute Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RATE</td>
<td>Integer</td>
<td>The frequency to execute the rule (seconds). For example, RATE 60 means the rule will evaluate every 60 seconds. The default is to execute the rule every time the Event Generator receives new data from the server</td>
</tr>
<tr>
<td>COMMENTS or C</td>
<td>String</td>
<td>Comments field</td>
</tr>
<tr>
<td>LOG_RULES</td>
<td>Log script</td>
<td>Tcl script that defines the Log Scanner activity that supports rules</td>
</tr>
</tbody>
</table>
Rule Functions

This section describes the Tcl rule functions associated with the Rules.tcl variable.

alarm

The alarm function makes an event active, highlights the hierarchy node (RED, YELLOW, or BLUE), and creates entries in both the Event Log and the Event Viewer with a predefined message of the event. The syntax of the alarm function is:

```
alarm level node "message" "Tcl command"
```

where:

- `level` can be RED, YELLOW, or BLUE. By convention, these levels mean:
  - RED—Situation or event that requires immediate attention
  - YELLOW—Warning events
  - BLUE—Capacity planning events

- `node` is the path name for a hierarchy node to be highlighted on the display. Using an empty string (""") instead of the node name means you do not want the node to be highlighted. `node` contains the name of the node that is in question or in error.

- `message` is a string that is displayed in the Event Viewer. Messages can be either text strings or variables. For internationalization, the text strings are set to variables in double quotes, which expands to the expected string. The variables are used to reference entries in rultext.tcl. For example, the following line of a Tcl function uses the “r0mess” variable for internationalization. For the complete rule, see Code Example 4-3.

```
ON_OPEN { alarm RED "" "$r0mess" "
```

- `Tcl command` is a Tcl string that is executed by the GUI when it receives the event. If you do not want to execute a Tcl function, use an empty string (""").
To close an open alarm condition, see the end_alarm function.

**crnode**

The crnode function generates a Config Reader node based on elements returned from the Log Scanner. The syntax is:

```
crnode keyword
```

Examples of the keyword are: DISK, SIMM, CPU, QLGC, PLN, SOC. Table 4-7 defines the keywords.

**Table 4-7  Keywords for the crnode Command**

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DISK</td>
<td>Uses one argument. Examples are sd0 or ssd0.</td>
</tr>
<tr>
<td>SIMM</td>
<td>Uses two arguments (for example 0 J3201). In this example, 0 is the board number and J3201 is the SIMM reference number.</td>
</tr>
<tr>
<td>CPU</td>
<td>Uses one argument, the CPU number.</td>
</tr>
<tr>
<td>QLGC</td>
<td>Uses one argument, the instance number. For more information, see the isp man page.</td>
</tr>
<tr>
<td>PLN</td>
<td>Uses one argument, the instance number. For more information, see the pln man page.</td>
</tr>
<tr>
<td>SOC</td>
<td>Uses one argument, the instance number. For more information, see the soc man page.</td>
</tr>
</tbody>
</table>

Examples of the crnode function are: crnode DISK sd0 and crnode SIMM 0 J3201.

**debug**

The debug function provides output to a person who is writing rules to explain what is happening to a rule. This function is analogous to puts in Tcl.
The syntax is as follows in which *msg* is a text string that is placed in *debug* and must appear in double quotes (" ").

```
  debug "msg"
```

The *debug* function writes debug messages to:
/var/opt/SUNWsymon/<monitored_machine>/EG/eq_debug.<pid>

**dynlink**

The *dynlink* function takes a shared object file (.so) and procedure name and dynamically links the shared object and calls the specific procedure. The syntax of the *dynlink* function is:

```
  dynlink file name_of_function
```

- *file* is the full path of the shared object (typically ending in .so).
- *name_of_function* is the function name within the dynamically loadable object.

An example of the *dynlink* function is:

```
  dynlink /opt/SUNWsymon/lib/eg_pfa.so pfainit
```

- /opt/SUNWsymon/lib/eg_pfa.so is the file name.
- pfainit is the function name. Only pfainit is needed to do the initialization.

**end_alarm**

The *end_alarm* function has no arguments. Use *end_alarm* to close an open alarm condition. An example of this function is:

```
  end_alarm
```
findlist

The findlist function takes a hierarchy path in which wildcards replace nodes, and replaces it with a list of valid paths in the hierarchy that match the wildcard. It builds the list of matching nodes and returns the most recent value associated with the path, such as set foo $value.

The syntax is:

```
findlist hierarchy_path "strip_string"
```

An example of a hierarchy_path is `KernelReader.cpu.cpu1.busy`. The hierarchy path uses the period ( . ) as a path separator.

“strip_string” (strip string means remove or strip out) is any subpath that is on the full path. Enclosing an item in the “strip_string” deletes that item from the expanded path (see Figure 4-1). If the strip string is null, you must use double quotes. If the strip string is not null, you don’t need to enclose the strip string in double quotes.

![Figure 4-1 KernelReader.cpu.*.busy Hierarchy Example](image-url)
For example, when you invoke the `findlist` function, the following function

```
findlist KernelReader.cpu.*.busy ""
```

is expanded to:

```
KernelReader.cpu.cpu1.busy
KernelReader.cpu.cpu2.busy
KernelReader.cpu.cpu3.busy
```

Another example of the `findlist` function is

```
findlist KernelReader.cpu.*.busy ".busy"
```

which expands to:

```
KernelReader.cpu.cpu1
KernelReader.cpu.cpu2
KernelReader.cpu.cpu3
```

Note that `.busy` is not in the expanded paths because in the `findlist` function, `.busy` was enclosed in double quotes in the `strip_string`. By placing `.busy` in the `strip_string`, this deletes `.busy` from the expanded path.

Use the `findlist` function only in a Tcl script related to the `MULTI` attribute. The entire list that is created is kept internal to the Event Generator and is not available all at once to the script.

Each member of the list is available to the script, one at a time. The action is called once for each node-value pair. If this were the rule:

```
MULTI {command}
{command2 }
```
It could look like this in the C shell:

```
foreach i ( 'command' )
    command 2
```

For an example of the `findlist` function, see Rule 10000 later in this chapter.

**findstatus**

The `findstatus` function finds the status of a node. The syntax is as follows in which `node` is the hierarchy endpoint. Two valid values of `node` are `dead` or `alive`.

```
findstatus node
```

For an example of a rule that uses the `findstatus` function, see RULE 201 in Code Example 4-6.

**findvalue**

The `findvalue` function takes the name of any data hierarchy variable and returns the value of the variable. The syntax is:

```
findvalue node
```

`node` is the hierarchy endpoint.

An example of the `findvalue` function is:

```
findvalue $node
```

You cannot specify a time value for the value. The value used depends on the agents providing the data. For an example of a rule using the `findvalue` function, see RULE 201 in Code Example 4-6.
getfield

The `getfield` function returns the internal values associated with a rule or a rule-node combination (list from a `MULTI` string). It accesses publicly available fields of data from within rules.

The syntax is:

```
getfield [rule#] field_type
```

The optional variable `rule#` is the rule number, which is assigned when you write the rule. For example, 0, 1, 2, and so on.

The `field_types` are listed in Table 4-8:

<table>
<thead>
<tr>
<th>Field Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PARAMETERS</td>
<td>User-defined string associated with the rule; use this field type to pass data between invocations of the rule</td>
</tr>
<tr>
<td>RATE</td>
<td>Frequency of the execution of the rule (seconds)</td>
</tr>
<tr>
<td>ACTIVE</td>
<td>Returns a value of either true or false. <code>ACTIVE</code> equals true when the event is active or open (when the <code>ON_OPEN</code> section of the rule is executed but the <code>ON_CLOSE</code> section is not executed.) The event is closed or inactive once the <code>ON_CLOSE</code> is executed.</td>
</tr>
<tr>
<td>COUNT</td>
<td>Returns the number of consecutive iterations of the rule (read only)</td>
</tr>
<tr>
<td>PRIORITY</td>
<td>Returns the priority value of the rule (see Table 4-1)</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>Returns the severity value of the rule (see Table 4-1)</td>
</tr>
<tr>
<td>RULE</td>
<td>Returns the rule number (read only)</td>
</tr>
<tr>
<td>START_TIME</td>
<td>Returns the time the rule became active (read only)</td>
</tr>
</tbody>
</table>

An example of the `getfield` function is:

```
getfield COUNT
```
The `getfield COUNT` function returns a count of the number of consecutive iterations where the condition of the rule has been true for a non-MULTI rule. This function also returns the number of consecutive iterations where the condition of a rule has been true for the specified rule or node combination for a MULTI rule. In a MULTI rule, the rule is evaluated for more than one node. If the rule number, which is optional, is not specified (as in the example), the rule number you are presently in is used.

For an explanation of the converse function to `getfield`, see “putfield” later in this chapter.

**Caution** – If you are using `get_parameter` and/or `put_parameter`, do not use `putfield` or `getfield` with the `PARAMETERS` field type on the same rule. Your data may become corrupt.

### get_parameter

The `get_parameter` function takes a single argument and gets a value that is unique to the rule from the `PARAMETERS` attribute that is associated with that argument. Rules can pass values to each other. A parameter is a way to pass the value to a different rule. Parameters are placeholders for values that are used at a later time.

The `get_parameter` function manages a parameter list. One use of `get_parameter` is for MULTI rules that require historical records.

The syntax is:

```plaintext
get_parameter argument
```

- `argument` is an identification string (without spaces) where a particular value is stored in memory.

You initialize the `get_parameter` function by using the `PARAMETERS` attribute to set the initial default value. For example `PARAMETERS {default 1000}`. If the `get_parameter` argument does not have a value currently associated with it, the default value is returned.
An example of the `get_parameter` function follows:

```c
{
    set oldtempdegree [ get_parameter $node ]
    .
    .
}
```

For a description of a rule containing the `PARAMETERS` attribute and the `get_parameter` function, see Code Example 4-7.

Additionally, see the `put_parameter` function in “put_parameter” later in this chapter which is the compliment to `get_parameter`.

**gettime**

The `gettime` function returns the last sample time of the monitored machine as a long integer. There are no arguments. The syntax is:

```c
gettime
```

**hotlist**

The `hotlist` function works like `findlist` except that it returns only the nodes whose values changed. Do not use the `hotlist` function in `cprules`, `pfrules`, or rules that contain `ON_CONTINUE` in them. That is because in these circumstances you want every node to be returned. In these instances, use the `findlist` function instead.

Following is a partial code example for RULE 1201. The complete rule is listed later in this chapter in Code Example 4-6.
Note – If any component of a hierarchy path contains a period (.) in it, you may not be able to use the hotlist function to locate it. For example, if you search for the mount point /export/a0.test reported by the Config Reader via the following path:

```
/system.slot.board.io-unit.sbi.dma.esp.sd./export/a0.test
```

the node will not be found. Instead, use the following path to find this node:

```
/system.slot.board.io-unit.sbi.dma.esp.sd/*.
```

Refer to “findlist” for more information on hotlist.

load

The load function, which is specific to the Log Scanner, takes more than one argument to create a Log Scanner hierarchy that is checked as part of the condition of the rule. An example is:

```
LOG_RULES { { grep { Ecc error on board ([0-9]), reference number (J[0-9]) } syslog } { load LR10000 "$logword(1)" "$logword(2)" } }
```

For a complete listing of this code example, see “Partial Listing of RULE 10000 and Description” later in this chapter.

The load command has three arguments:
• Rule number LR10000
• $logword(1)
• $logword(2)

$logword(1)$ is substituted for the value that matches the first regular expression between parentheses ( ); in this case, the board number $logword(2)$ is substituted for the value that matches the second regular expression enclosed between parentheses ( ), which in this case is the reference number. For example, the following line in the syslog file: “Ecc error on board 5, reference number J3200” generates the following hierarchy: LogScanner.LR10000.5.J3200.

For more information on how to use the load command, see “Log Scanner” later in this chapter.

mailto

The mailto function mails a message string to the specified address. The syntax of the function is:

```
mailto address "msg_string"
```

If there are spaces in msg_string, include msg_string in double quotes (“ ”). All existing rule messages are in rultext*.tcl, to facilitate translation into other languages.

An example of the mailto function is:

```
mailto root "$mess"
```

Another example of the mailto function is:

```
mailto root "We have a problem."
```

putfield

The putfield function is the converse of getfield. It uses a field type and data and assigns the data to the field of the current rule.
The syntax is:

```
putfield {rule#} field_type "value"
```

The optional variable `rule#` is the rule number that is assigned when you write the rule. For example, 0, 1, 2, 3, and so on.

The `field_types` are described in Table 4-9.

**Table 4-9 putfield Field Type Descriptions**

<table>
<thead>
<tr>
<th>Field Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PARAMETERS</td>
<td>Sets the user-defined string associated with the rule. Use this field type to pass data between invocations of the rule.</td>
</tr>
<tr>
<td>RATE</td>
<td>Sets the frequency of the execution of the rule (seconds)</td>
</tr>
<tr>
<td>PRIORITY</td>
<td>Sets the priority value of the rule. For meanings of the values of PRIORITY, see “Terminology” earlier in this chapter.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>Sets the severity value of the rule. For meanings of the values of SEVERITY, see “Terminology” earlier in this chapter.</td>
</tr>
</tbody>
</table>

If there are spaces in `value`, use double quotes (" ").

An example of the `putfield` function is:

```
putfield 1 RATE 50
```

This example changes the frequency with which RULE 1 is checked. RULE 1 is checked at 50 second intervals.

For an explanation of the converse function to `putfield`, see “getfield.”

### put_parameter

The syntax of the `put_parameter` function is:

```
put_parameter tag value
```
The `put_parameter` function manages a parameter list. It provides a way for rules to pass values to each other (or between iterations of the same rule).

One use of the `put_parameter` function is for `MULTI` rules that require historical records. It saves a part of the data that is associated with a tag.

The arguments have the following meanings:
- `tag` is the key that is used to store data; the legal values can be any string.
- `value` is the data to be store.

You initialize the `put_parameter` function by using the `PARAMETERS` attribute to set the initial default value. For example, `PARAMETERS {default 1000}`.

An example of the `put_parameter` function follows:

```
put_parameter [$node] RED
```

Using the `$node` parameter is optional. Leaving out `$node` makes the `put_parameter` function more efficient. For a complete code example that includes the `put_parameter` function, see “RULE 100 Code Example.”

Additionally, see the `get_parameter` function in “get_parameter,” which is related to `put_parameter`.

---

The `snmp` function takes a string as an argument and generates an SNMP trap. A trap message is sent to every machine in the `snmp_hosts` variable, which is defined in `event_gen.tcl`. The syntax is as follows in which `string` is the message sent to programs such as Solstice Site Manager and Solstice Domain Manager, which monitors the system.

```
snmp "string"
```

An example follows:

```
snmp "$imsg"
```
Messages can either appear explicitly in `snmp` or the identifier of a message in `rultext.tcl` can be given. All existing rule messages are in `rultext.tcl`, which facilitates translation into other languages. The `snmp` function goes to the `rultext.tcl` file, picks up the variables from `rultext.tcl`, runs it through the `format` function, and then displays the messages (see Code Example 4-3).

**syslog**

The `syslog` function takes a string as an argument and places the string in the `syslog`. Use this function for debugging purposes only. Use this function as you use the `printf` function in C. The syntax is as follows in which `msg` is a text string that is placed in `syslog` and must be in double quotes (" "). All existing event messages are in `rultext.tcl`, which can be translated into other languages.

```
syslog "msg"
```

An example of the `syslog` function is:

```
syslog "Show me the value of $variablename"
```

This example prints out the message and gives the value of the variable name.

Output from the `syslog` function are treated as warning messages. The message level for the `syslog` call is `LOG_WARNING`. To be sure that the warning messages appear in the system log file, make sure that the `/etc/syslog.conf` file is set correctly. For more information, see the `syslog.conf` man page.

**Hierarchies**

The next part of this chapter explains how hierarchies work and how to write event rules.
Hierarchies are used to structure data and group-related information. Each node and subnode organize the data beneath it. For example, in this hierarchy, the following is true:

```
KernelReader.cpu.cpu1.busy
```

- Top level, KernelReader, indicates that this is KernelReader data.
- KernelReader.cpu indicates that this is cpu data.
- KernelReader.cpu.cpu1 indicates that this data is related to cpu1.
- KernelReader.cpu.cpu1.busy is the percentage of time that the cpu1 was busy.

Hierarchies use the period (.) as a separator for hierarchy paths. For specifics on how to use the findlist function for locating hierarchy paths, see “findlist” earlier in this chapter. The findlist function cannot find the hierarchy path if any component of the hierarchy path contains a period.

For more information on the Kernel Reader see “Kernel Reader” later in this chapter. For information on the Kernel Reader hierarchy, see Appendix A, “Kernel Reader.”

### Writing Event Rules

This section provides procedures for writing event rules and explains how to create rules from any of the four agents:

- Config Reader
- Kernel Reader
- Log Scanner
- Event Generator

#### To Create New or Modified Rules

1. As root or superuser, use a text editor to call up the appropriate rules files to edit (see Table 4-3.)
   For example, if you need to add a capacity planning rule, call the cprules.tcl file and add the new rule to this file. Go on to Step 3.

2. If a rules file does not exist for your rule category, create a new rules file using a text editor and add the rule to this file.
a. Modify the master file rules.tcl after you create the new rule by adding a \texttt{psource} command to tell the rules.tcl file to read the new rule file.

b. Add the new rule file name to Tcl variable Rules in the \texttt{set Rules "file_names" statement.}
Note that within the quotes, the file names should be separated by spaces.

3. Verify the rule.
See “Verifying New Event Rules” later in this chapter.

4. Activate the rule.
See “Activating New or Modified Event Rules” later in this chapter.

The following sections describe the four agents in more detail, explain how to determine the path for the Config Reader and Kernel Reader hierarchies, explain the LOG_RULES that are used for the Log Scanner, and describe the functions of the Event Generator.

\textbf{Config Reader}

The Config Reader collects the data for the system hardware configuration and status and provides data continuously to the Event Generator. Rules written against the Config Reader describe hardware-related failures, such as power supply or fan failures. The Config Reader data begins with \texttt{system.<complete_path>}. An example is: \texttt{system.hot_plug_charges.auxillary_5v.status}. 

The following screen shows a partial display of Rule 1201, which describes hot plug charge DC status. The complete rule is presented later in “Complex Rule Example 2: RULE 1201” later in this chapter.

```c
{
    COMMENTS { for hot plug charge DC status }
    RULE 1201
    MULTI {
        expr { [ hotlist system.hot_plug_charges.*.status "" ] } }
    set hpustatus [ findstatus $node ]
    expr { ("$value" != "OK") && ("$hpustatus" == "alive") }
}
```

The `MULTI` label indicates that this rule might apply to more than one node. Each node found using the `hotlist` function matches the pattern `system.hot_plug_charges.*.status`. For example:

- `system.hot_plug_charges.auxiliary_5v.status`
- `system.hot_plug_charges.peripheral_12v.status`
- `system.hot_plug_charges.peripheral_5v.status`

Since the strip string is null (empty double quotes), the value assigned to the `$node` variable after the evaluation does not change.

The statements in the condition do the following:

- Obtains the status of the `$node` variable and assigns it to the `$hpustatus` variable.
- Checks if the value of the `$value` variable is not equal to “OK” and the value of the variable `hotplugstatus` is equal to “alive.”

**Determining the Path for the Config Reader**

To write rules for the Config Reader, use the Logical View console to determine the Config Reader path.
To Determine the Path for the ConfigReader

1. Click the Logical View icon.

2. Expand the hierarchy by clicking the + signs in the hierarchy.
   Figure 4-2 shows an example of the `owey.*` hierarchy. The expanded path is as follows:

   ```
   oway.hot_plug_charges.peripheral_5v.peripheral_5v_precharge.status
   ```

   ![Diagram of the hierarchy](image)

   Figure 4-2  ConfigReader Data Hierarchy Example

3. Replace `owey` with `system`.
   The path is now:

   ```
   system.hot_plug_charges.peripheral_5v.peripheral_5v_precharge.status
   ```

   For information on the Config Reader hierarchy, see Appendix B, “Config Reader.”
Kernel Reader

The Kernel Reader monitors system performance data such as disk queue length, forks, and CPU load. Rules written against the Kernel Reader data test Kernel Reader data. The Kernel Reader, like the Config Reader, provides data continuously to the Event Generator.

Kernel Reader data path names begin with KernelReader. Code Example 4-2 shows a partial display of RULE 100, which uses a MULTI attribute to define a Kernel Reader path. The complete rule is presented later in “Complex Rule Example 3: RULE 100” later in this chapter.

```
{  
    RULE 100
    COMMENTS {
      This rule generates a YELLOW alarm if it finds any disk with an increasing wait queue while busy.
    }
    
    MULTI { expr { [ hotlist KernelReader.disk.*.busy .busy ] }
    
    
    
    Code Example 4-2  Partial Rule 100 Display
  }
```

The MULTI statement tells the Event Generator to repeat the same rule on each node that is returned from the hotlist function. The hotlist function finds the node whose name matches KernelReader.disk.*.busy. Since the strip string is defined as .busy (because the strip string is not null, it has to be in double quotes), the node name that is returned in the node variable by hotlist function contains only the matched node name, which excludes .busy. For example, if the hotlist function matches a node named KernelReader.disk.sd8.busy, the $node variable contains KernelReader.disk.sd8.
Determining the Path for the Kernel Reader

To write rules for the Kernel Reader, determine the Kernel Reader path.

▼ To Determine the Path for the Kernel Reader

1. Double click the Kernel Data Catalog.

2. Expand the hierarchy by clicking the + signs in the hierarchy. Figure 4-3 shows an example of the _OWEEY_.disk hierarchy.

3. Replace the machine name, _OWEEY_, with KernelReader.
   An example of a path is KernelReader.disk.ssd93.runtime.

Figure 4-3 Example of the Kernel Reader Data Hierarchy

For information on the Kernel Reader hierarchy, see Appendix A, “Kernel Reader.”
Log Scanner

Event rules can search the system log files for specific strings or regular expressions. The LOG_RULES attribute specifies the desired string. The Log Scanner parses the system log file and converts any matching message to a hierarchy that is similar to hierarchies generated by the Kernel Reader and Config Reader.

Rules written against the Log Scanner describe the following type of conditions and messages:

- Panic conditions (such as a system dying)
- Conditions that require immediate attention, such as a corrupted database
- Critical conditions such as hard disk errors
- Errors and warning messages
- Conditions that require special handling (these conditions are user-defined)
- Informational messages (such as hot plug information)
- Messages that contain information normally used when debugging a program

For more information on these conditions and warnings, see the syslog(3) man page.

Event Generator and Log Scanner Tasks

The Event Generator and the Log Scanner work together to perform the following tasks:

- The Event Generator reads the rules. When it finds the LOG_RULES statement, it places the rules on its hierarchy. The Log Scanner reads this hierarchy and performs actions.

- The Log Scanner goes through the system log files and uses the pattern supplied in LOG_RULES to find a match in the log file. If found, it constructs another hierarchy beginning with LogScanner.<completepath>, which is similar to the Config Reader and Kernel Reader hierarchies. By convention, the complete path is LogScanner.LR<rule#>.<what is dynamically assigned by the Log Scanner>. It obtains the complete path by reading this hierarchy as explained earlier. The LS_MONITOR statement in the /etc/opt/SUNWsymon/log_scan.tcl file identifies the file that contains the system log for the Log Scanner.

- The Event Generator executes the rules.
Partial Listing of RULE 10000 and Description

The following screen shows RULE 10000, an oversimplified rule that describes memory errors. This rule is oversimplified to present the following concepts.

```plaintext
{
    COMMENTS { memory error }
    RULE 10000
        LOG_RULES { { grep { Ecc error on board ([0-9]), reference number (J[0-9]) } syslog } }  
                    { load LR10000 "$logword(1)" "$logword(2)" } } 
    MULTI { expr { [ findlist LogScanner.LR10000.* "" ] } } 
    { set found 1 }
}
```

The LOG_RULES statement tells the Log Scanner what message to look for, and what to do if the message is found in the syslog. In this example, the Log Scanner looks for a system message that matches the regular expression defined in a pair of brackets `{}` followed by in syslog.

If a system message that matches the regular expression is found, the load command (which is specific to the Log Scanner) is called to construct a hierarchy that begins with LogScanner. The load command has three arguments:

- Rule number LR10000
- $logword(1)
- $logword(2)

$logword(1)$ is substituted for the value that matches the first regular expression enclosed between parentheses ( ), in this case, the board number. $logword(2)$ is substituted for the value that matches the second regular expression enclosed between parentheses ( ), in this case, the reference number. For example, the following line in the syslog file: “Ecc error on board 5, reference number J6” generates the following hierarchy: LogScanner.LR10000.5.J6.

The Event Generator executes the findlist function in the MULTI statement searches and returns the list of hierarchies or nodes that match LogScanner.LR10000. The next statement assigns the value 1 to the found variable.
Guidelines for Using LOG_RULES

When using LOG_RULES follow these guidelines:

- The `load` function takes more than one argument to create a Log Scanner hierarchy that is checked as part of the condition of the rule.
- LOG_RULES are always MULTI rules. For example:

  ```tcl
  MULTI {expr {[findlist LogScanner.* ""]}}
  ```

- To get data loaded by the Log Scanner, use `findvalue $node`.
- To parse the logword data, use the `split` and `lindex` Tcl functions. The logword data is created by specifying subexpressions in the regular expression. These subexpressions are loaded by the `load` function on a Log Scanner property. Use the `split` and `lindex` Tcl functions in the Event Generator action to parse the string data on that Log Scanner property.

  For a complete listing of a rule for the Log Scanner, see Code Example 4-7.

Event Generator

The Event Generator collects information from the Config Reader, Kernel Reader, and Log Scanner, and evaluates the data against its rules. It also maintains data about itself and the state of the server agents. This allows rules to be written against the status of agents (including itself) as well as data from the server. One example of a rule is written against the Event Generator would be a warning of a high number of open events.

When a condition is true, the Event Generator logs an event and carries out the appropriate action in the rule. When the condition that generated the event is no longer true, the Event Generator may run a special action such as closing the event.
Getting Functions

The Event Generator gets functions from the 
/opt/SUNWsymon/etc/event_gen.tcl file. The sm_confsymon -e command copies the /opt/SUNWsymon/etc/event_gen.tcl file to the 
/etc/opt/SUNWsymon/event_gen.servername.tcl file, where servername is the server being monitored.

The event_gen.servername.tcl file defines variables and procedures used by the Event Generator. For example, the psource procedure is defined in 
event_gen.servername.tcl and is used in rules.tcl.

The Event Generator looks first in /etc/opt/SUNWsymon for rules files. If it cannot find the files, it then looks in /opt/SUNWsymon.

To Customize Procedures and Commands

♦ Edit the event_gen.servername.tcl file.
   Editing the event_gen.servername.tcl enables you to include your own procedures and commands, such as adding the psource procedure.

Caution – Do not modify defaults of procedures and commands unless you are extremely sure of your Tcl knowledge. Modifying the defaults incorrectly can cause massive errors or malfunctioning rules.

Locating Rule Files

The Event Generator reads a file called rules.tcl. This file tells what files to read and where the rules files are located. For more information on this file, see “Description of Rules Files” earlier in this chapter.

The event_gen.servername.tcl file defines the path used to search for the rule files. By default, the paths are:

• /etc/opt/SUNWsymon
• /opt/SUNWsymon/etc
• /opt/SUNWsymon/etc/lib
• /etc/opt/SUNWsymon/platform
• /opt/SUNWsymon/etc/platform
• /opt/SUNWsymon/etc/locale
Verifying and Activating Rules

This section describes how to verify and activate rules. After you write or modify the event rule, you need to first verify it then activate it.

Verifying New Event Rules

To Check for the Correct Syntax

♦ Invoke the verify_rules command by typing:

$ verify_rules [-I filename] [-R filename] [-o]

The command has three optional arguments (see Table 4-10.)

Table 4-10 Arguments to the verify_rules Command

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-I</td>
<td>Checks the file that contains supporting functions; the default is event_gen.tcl</td>
</tr>
<tr>
<td>-R</td>
<td>Checks the file that contains the EVENTS variable; the default is ./rules.tcl</td>
</tr>
<tr>
<td>-o</td>
<td>Provides debugging information on rules to the standard error output</td>
</tr>
</tbody>
</table>

When you run verify_rules and the rules are correct, the software responds, “GOOD RULES.” If a syntax error is detected, the program responds, “BAD RULES.” However, this does not guarantee that the rule will work as expected.

Activating New or Modified Event Rules

You can change rules by stopping and restarting the Event Generator or sending a signal to the Event Generator process.
To Activate New or Modified Event Rules by Stopping and Restarting the Event Generator

1. Kill the Event Generator by typing:

```
% ps -ef | grep sm_egd
% kill pid
```

   a. Type the `pid` number for the `kill` command that was returned from the `ps -ef | grep sm_egd` command.

2. Restart the Event Generator.

To Activate New or Modified Event Rules by Sending a Signal

♦ Activate the new or modified rule by typing:

```
% kill -HUP pid
```

This causes the Event Generator to re-read and execute all rules files.

Debugging Tips

Use the following debugging tips to debug event rules:

- Run `verify_rules` to make sure the syntax is accurate. See “Verifying and Activating Rules” earlier in this chapter.
- If you have a problem with the rules, change the `rules.tcl` file to test only one rule at a time.
- Look for error messages in the event log file:
  `/var/opt/SUNWsymon/monitored_machine_name/event_log`.
- Use the `debug` function to do debugging. For information on the `debug` function see “debug” earlier in this chapter.
Troubleshooting

If you have problems with event rules, such as when the Event Generator fails to start properly, you may have to upgrade to Solstice SyMON 1.3 event rules. For information on troubleshooting event rules problems, see Chapter 6, “Troubleshooting.”

Rule Examples

This section describes rule examples. The rule description follows the Tcl code example.

Simple Rules

The sections that follow present Tcl code and a description of a simple rule.

Simple Rule Example 1: RULE 0

Code Example 4-3 lists the Tcl code for RULE 0.
Code Example 4-3  RULE 0 Code Example

RULE 0 checks whether the value of variable \texttt{symond\_status} is equal to “dead.” If so, ON\_OPEN does the following:

- Calls the \texttt{alarm} function with level RED, null node name, message \texttt{$r0mess}, which is defined in \texttt{rultext.tcl}, and a null Tcl function to the GUI (empty double quotes).
- Assigns the first formatted message \texttt{format "$ir0msg" "$target"} to the \texttt{imsg} variable.
- Takes the string \texttt{imsg} as an argument and generates SNMP traps on every machine in the \texttt{snmp\_host} variable, which is defined in \texttt{event\_gen.tcl}. The string \texttt{imsg} is sent to Solstice Site Manager, Solstice Domain Manager, Solstice Enterprise Manager, or other SNMP-listening management platforms.
If the condition changes from True to False, ON_CLOSE calls the end_alarm function. For an explanation of SEVERITY and PRIORITY, see Table 4-1 earlier in this chapter.

**Simple Rule Example 2: RULE 403**

Code Example 4-4 presents a second example of a simple rule.

```tcl
{ RULE 403
  C { Test for meta CPU events }
  set level [ check_cpa_cpu ]
  expr { "$level" == "BLUE" } 
  ON_OPEN { alarm BLUE KernelReader.cpu "$r403mess" ""
            set imsg [ format "$ir403msg" "$target" ]
            snmp "$imsg" }
  ON_CLOSE { end_alarm }
  RATE 3600
}
```

**Code Example 4-4  RULE 403 Code Example**

RULE 403, which tests for meta CPU events, assigns the returned value of the check_cpa_cpu function to the level variable and checks whether the value of variable level is equal to “BLUE.”

The check_cpa_cpu function checks the cpu cpa-related data that is collected from another rule, compares it with the predefined threshold and then returns a capacity pacing level. If there is a capacity concern, the variable level returned is “BLUE.” ON_OPEN does the following if the variable level is equal to “BLUE”:

- Calls the alarm function with level BLUE, node name KernelReader.cpu, message $r403mess, which is defined in rultext.tcl, and a null Tcl function to the GUI (empty double quotes).
- Formats a message with "$ir403msg" (defined in rultext.tcl) as the base and "$target" as its first argument. It stores the formatted message in the variable imsg.
• Broadcasts an SNMP message, which is defined in the variable `imsg`, to machines defined in `snmp_host` variable (defined in `event_gen.tcl`). The string `imsg` is sent to Solstice Site Manager, Solstice Domain Manager, Solstice Enterprise Manager, or other SNMP-listening management platforms.

If the condition changes from True to False, `ON_CLOSE` calls the `end_alarm` function. The statement `RATE 3600` means that the rule is evaluated every 3600 seconds.

**Complex Rules**

This section contains examples and explanations of complex rules.

**Complex Rule Example 1: RULE 102**

Code Example 4-5 describes the Tcl code for RULE 102.
The MULTI attribute checks the current value of free swap space by getting the value of `KernelReader.mem.swap_free` using the `hotlist` function.

There are two statements in the condition for this rule:

- The first statement checks whether this rule is currently active by getting the value of the ACTIVE field with the `getfield` function. If this rule is active, it gets the value of total swap space (`KernelReader.mem.swap_total`) using the `findvalue` function; it then calculates twenty percent of the total swap space and assigns the value to the `ts` variable. If the rule is not active, it gets the value of the total swap space as in the previous statement and then calculates ten percent of the total swap space and assigns the value to the `ts` variable.
• The second statement compares the value ($value) with the threshold and determines the current condition of this rule.

If the condition changes from False to True, ON_OPEN does the following:

• Calls the alarm function with level YELLOW, node name KernelReader.mem.swap_free, message $r102mess (defined in rultext.tcl), and no Tcl function to the GUI (empty quotes).

• Assigns the first formatted message format "$ir0msg" that is defined in rultext.tcl and its target, "$target" to the imsg variable.

• Takes the string imsg as an argument and generates SNMP traps on every machine in the snmp_host variable, which is defined in event_gen.tcl. The imsg string is sent to Solstice Site Manager, Solstice Domain Manager, Solstice Enterprise Manager, or other SNMP-listening management platforms.

If the condition changes from True to False, ON_CLOSE calls the end_alarm function.

For an explanation of SEVERITY and PRIORITY, see Table 4-1 earlier in this chapter.

The GUI highlights the node in the Physical and Logical Views, or the Kernel Data Catalog, because a node name is passed to the alarm function.

The sections that follow present Tcl code and descriptions of three complex rules.

Complex Rule Example 2: RULE 1201

Code Example 4-6 lists the Tcl code for RULE 1201.
Code Example 4-6  RULE 1201 Code Example

The MULTI label indicates that this rule might apply to more than one node. Each node found using the hotlist function matches the pattern system.hot_plug_charges.*.status. For example:
- system.hot_plug_charges.auxiliary_5v.status
- system.hot_plug_charges.peripheral_12v.status
- system.hot_plug_charges.peripheral_5v.status

Since the strip string is null (empty double quotes), the value assigned to the $node variable after the evaluation doesn’t change.

The statements in the condition do the following:
- Obtains the status of the node variable and assigns it to the hpustatus variable.
- Checks if the value of the value variable is not equal to “OK” and the value of the variable hotplugstatus is equal to “alive”.
If the condition changes from False to True, the following actions in ON_OPEN take place:

- Assigns the first formatted message $r1201mess (defined in rultext.tcl) to the mess variable with its argument, $value.
- Calls the alarm function with the RED level, the $node node name, the formatted $mess message, and no Tcl function to be executed (empty double quotes).
- Assigns the first formatted message format "$ir0msg", defined in rultext.tcl, and its target, "$target," with its $value argument to the imsg variable.
- Takes the string imsg as an argument and generates SNMP traps on every machine in the snmp_host variable, which is defined in event_gen.tcl. The imsg string is sent to Solstice Site Manager, Solstice Domain Manager, Solstice Enterprise Manager, or other SNMP-listening management platforms.

If the condition changes from True to False, ON_CLOSE calls the end_alarm function.

For an explanation of SEVERITY and PRIORITY, see Table 4-1 earlier in this chapter.

The process is repeated until all nodes are found using the findlist function in the MULTI statement.
Complex Rule Example 3: RULE 100

Code Example 4-7 describes the Tcl code for RULE 100.

```
{
    RULE 100
    COMMENTS {
      This rule generates a YELLOW alarm if it finds any
      disk with an increasing wait queue while busy.

      YELLOW flag when disk is over 75% busy and average
      queue length is over 10 and increasing wait queue.
      Flag stays on till disk is not over 70 and average
      queue length is no longer than 8.

      This is a transitory event.
    }
    {
      set oldwait [ get_parameter]
      set projwait [ expr $oldwait*1.25 ]
      set diskwait [ findvalue $node.queuelength ]
      put_parameter $diskwait
      if { [getfield ACTIVE] } { set th1 0.7; set th2 8 } \
        else     { set th1 0.75; set th2 10}
      expr { (($value>$th1)&&($diskwait>$th2)) && \ 
        ($diskwait>$projwait)) } 
    }
    ON_OPEN { alarm YELLOW $node.busy "$r100mess" "
      set imsg [ format "$r100msg" "$target" "$node" ]
      snmp "$imsg" }
    MULTI { expr { [ hotlist KernelReader.disk.*.busy .busy ] } } 
    ON_CLOSE { end_alarm }
    PARAMETERS { default 1000 }
    SEVERITY 3
    PRIORITY 2
}
```

Code Example 4-7  RULE 100 Code Example

The first part of the rule has these statements:
• The first statement gets a user-defined value using the `get_parameter` function. The first time the rule is evaluated, the value is the default value defined after the `PARAMETERS` value. The `oldwait` variable (old wait time) stores the value.

• The second statement multiplies the old wait time, `$oldwait`, by 1.25 and stores it in the `projwait` variable (projected wait time).

• The third statement gets the current disk wait time. It obtains the value of the `queuelength` field of the node that is currently being evaluated. It stores the value in the `diskwait` variable.

• The fourth statement saves the current disk wait time, `$diskwait`, using the `put_parameter` function.

• The fifth and sixth statements check if the rule is currently active (if the condition is currently True) and assign the threshold values to the `th1` and `th2` variables. They compare the amount of time the node is busy (`$diskbusy`) with the `th1` threshold. Also, they compare the wait time of the node (`$diskwait`) with the `th2` threshold.

If the condition changes from False to True, `ON_OPEN` does the following:

• Calls the `alarm` function with the level `YELLOW`, the node name with its property name (`$node.busy`), event message (`r100mess`), which is defined in `rultext.tcl` and no Tcl function for the GUI (empty double quotes).

• Assigns the first formatted message `format "$ir000msg"`, defined in `rultext.tcl` and its target, "$target," to the `imsg` variable.

• Takes the `imsg` string as an argument and generates SNMP traps on every machine in the `snmp_host` variable, which is defined in `event_gen.tcl`. The string `imsg` is sent to Solstice Site Manager, Solstice Domain Manager, Solstice Enterprise Manager, or other SNMP-listening management platforms.

The `MULTI` statement tells the Event Generator to repeat the same rule on each node that is returned from the `hotlist` function. The `hotlist` function finds the node whose name matches `KernelReader.disk.*.busy.busy`. Since the strip string is defined as `.busy`, (because the strip string is not null, it has to be in double quotes), the node name that is returned in the `node` variable by the `hotlist` function contains only the matched node name excluding `.busy.`
For example, if the hotlist function matches a node named
KernelReader.disk.sd8.busy.busy, the $node variable contains
KernelReader.disk.sd8.

If the condition changes from True to False, ON_CLOSE calls the end_alarm
function.

The PARAMETERS statement sets a default value to 1000. Thus, the condition
will not be True the first time this rule is evaluated.

For an explanation of SEVERITY and PRIORITY, see Table 4-1 earlier in this
chapter.

**Complex Rule Example 4: RULE 106**

Code Example 4-8 lists the Tcl code for RULE 106 that monitors system
messages.

```tcl
{
    COMMENTS { no swap space }
    RULE 106
    RATE 300
    LOG_RULES { {grep { no swap space.*pid ([0-9]+)} syslog }
        { load LR106 "$logword(1)" } }
    MULTI { expr { [ hotlist LogScanner.matches.LR106.* "" ] }
        { set found 1 }
    }
    ON_OPEN {
        set lsdata [ split $value ]
        set pid [ lindex $lsdata 0 ]
        set mess [ format "$r106mess" "$pid" ]
        alarm YELLOW "$mess"
        end_alarm
        set imsg [ format "$ir106msg" "$target" "$pid" ]
        snmp "$imsg"
    }
    SEVERITY 2
    PRIORITY 2
}
```
The `LOG_RULES` statement tells the Log Scanner what message to look for, and what to do if the message is found in the `syslog`. In this example, the Log Scanner looks for a system message that matches the regular expression, which is defined in a pair of brackets `{}` followed by `in syslog`.

If a system message that matches the regular expression is found, the Log Scanner creates a hierarchy named `LogScanner.matches.LR106.*`. The value of `LogScanner.LR106.*` contains arguments following the `load` function. The element, `$logword(1)`, contains the string that is matched in the regular expression defined between parentheses. You count the pairs of parentheses from left to right. In this example, it is the first pair of parentheses whose matched string is stored in `$logword` with an index of 1, `$logword(1)`. If there were a second pair of parentheses, you would find the matched information between the second pair of parentheses to the second string.

The `hotlist` function in the `MULTI` statement searches and returns the list of hierarchies or nodes created by the Log Scanner whose name can be matched with `LogScanner.matches.LR106.*`. The condition has one statement, which assigns the value 1 to the `found` variable.

Next, the following seven actions take place in `ON_OPEN`:

- Splits the list into elements and stores them in the `lsdata` variable. For more information on the `split` function, refer to the Tcl books listed in the Preface.
- Obtains the process ID number from the first list element (index 0) and stores it in the `pid` variable.
- Formats the event message and stores it in the `mess` variable. This is done by passing the message body `$r106mess` and the process ID number `$pid`. The `$r106mess` variable is stored in `rultext.tcl`.
- Calls the `alarm` function with `YELLOW` level, no node name, formatted message `$mess`, and no Tcl function for the GUI (empty double quotes).
- Calls `end_alarm` to close the event.
- Formats the `ir106msg` message and stores it in the `imsg` variable. This is done by passing the following:
  - The message body, `ir106msg`; this variable is stored in `rultext.tcl`
  - Its target, `$target`
- The process ID number \$pid

- Takes the string imsg as an argument and generates SNMP traps on every machine in the snmp_host variable, which is defined in event_gen.tcl. The string imsg is sent to Solstice Site Manager, Solstice Domain Manager, Solstice Enterprise Manager, or other SNMP-listening management platforms.

For an explanation of SEVERITY and PRIORITY, see Table 4-1 earlier in this chapter.
Use the Solstice SyMON options described in this chapter on the command line when you invoke Solstice SyMON. For example, the `-t` option refers to the target system to monitor:

```
% /opt/SUNWsymon/bin/symon -t targetsystemname &
```

Solstice SyMON also recognizes the standard X Window System toolkit options.

**Options to Solstice SyMON**

The following entries describe the Solstice SyMON command line options.
colorMap

Name: -colorMap

Abbreviated Name: -cm

Default: colorMap

Resource: *colorMap

Description: Uses a private color map to avoid incorrect colors in the Physical View images. Use the private color map option if you see a small box instead of icons anywhere in Solstice SyMON; or if colors are distorted in the Physical View when other color-intensive programs are running.

dragthreshold

Name: -dragthreshold

Abbreviated Name: None

Default: 10

Resource: *dragthreshold

Description: This is the mouse drag threshold (pixels) for SysMeters.

flashDuration

Name: -flashDuration

Abbreviated Name: -fd

Default: 30

Resource: *flashDuration
**Description:** Controls the duration (msec) of the flashes of the **System:** button. The **System:** button is the button in the upper left corner of the Launcher window, which tells the server being monitored. Once Solstice SyMON has established communication with the server, this button flashes according to the `-fd` and `-fi` options until communication is broken.

*Table 5-1*  Flash Duration Settings

<table>
<thead>
<tr>
<th>Flash Duration Setting</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>zero (0)</td>
<td>Turns off the feature</td>
</tr>
<tr>
<td>Less than 0</td>
<td>Error message is printed and flash duration is set to 0</td>
</tr>
<tr>
<td>Greater than the flash interval</td>
<td>Flash duration is set to the flash interval and an error message is printed to the standard error</td>
</tr>
<tr>
<td>Equal to the flash interval</td>
<td>Turns the system button green constantly; the button may flicker as it is updated at each interval</td>
</tr>
</tbody>
</table>

**See Also:** `flashInterval`

**flashInterval**

**Name:** `-flashInterval`

**Abbreviated Name:** `-fi`

**Default:** 10000 ms (10 seconds)

**Resource:** `*flashInterval`

**Description:** Controls the frequency of flashing (msec) of the **System:** button. The **System:** button is the button in the upper left corner of the Launcher window, which gives the name of the server being monitored. Once Solstice SyMON has established communication with the server, this button flashes according to the `-fd` and `-fi` options until communication is terminated.

If the interval is less than 1000 ms, an error message is printed to the standard error and the flash interval is set to 1000. Setting the flash interval and flash duration equally, turns the system button green constantly. The button may flicker as it is updated at each interval.
After each interval, Solstice SyMON executes a RPC ping of the target system. With the default flash interval and flash duration, each flash indicates a successful ping.

See Also: flashDuration

heartbeatInterval

Name: -heartbeatInterval
Abbreviated Name: -hi
Default: 10
Resource: *heartbeatInterval

Description: The heartbeat interval (seconds) is the interval between successive updates of the message in the Launcher footer, which states the amount of time remaining until the next data update. For example: “Next update request in 10 seconds.”

help

Name: -help
Abbreviated Name: -h
Default: None
Resource: None
Description: Prints a list of options with default values and exits.

installDir

Name: -installDir
Abbreviated Name: -I
Default: /opt/SUNWsymon
Resource: *installDir
**Description**: Sets the root directory to examine Tcl files (default is /opt/SUNWsymon)

**interval**

**Name**: -interval

**Abbreviated Name**: -i

**Default**: 10

**Resource**: *interval

**Description**: Polling interval (in seconds). This is the time between requests for data from agents. The minimum polling interval is 5 seconds. The maximum polling interval is 120 seconds.

To change the polling interval while Solstice SyMON is running, use the Launcher Options menu. From the Options menu of the Launcher, select Data Controls. From the Data Controls menu, set the polling interval.

Solstice SyMON polls the agents for data every interval seconds. It does all GUI updates necessary, then waits for at least minWait, and possibly until interval seconds from the start of the last update (whichever is greater) before polling again.

**See Also**: minWait

**minWait**

**Name**: -minWait

**Abbreviated Name**: -mw

**Default**: 1

**Resource**: *minWait

**Description**: Minimum wait (in seconds) between polls or updates to guarantee user interaction time. This specifies how long to wait after processing one data update before asking the target system for another update. This creates a time for you to reduce the polling frequency.
Solstice SyMON polls the agents for data every interval seconds. It does all GUI updates necessary, then waits for at least minWait, and possibly until interval seconds from the start of the last update (whichever is greater) before polling again.

See Also: interval

pruneTime

Name: -pruneTime

Abbreviated Name: -pt

Default: 120

Resource: *pruneTime

Description: Length of time (in minutes) for the Kernel Reader data to be retained in the GUI. For example, if the prune time is 180 minutes, Solstice SyMON deletes data older than 180 minutes.

rpcNum

Name: -rpcNum

Abbreviated Name: -rn or -n

Default: 100244

Resource: *rpcNum

Description: Enables you to assign a custom RPC number to Solstice SyMON. All client applications that want to connect to Solstice SyMON must know this custom RPC number. The default Solstice SyMON RPC number of 100244 is usually supplied to client applications. If you change this RPC number, you must provide the new RPC number to all client applications.

The RPC number you provide should be the RPC number for Solstice SyMON running on the monitored host from which all clients retrieve connectivity information (not the RPC number of the spawning Solstice SyMON on a remote system with an Event Generator).
session

Name: -session
Abbreviated Name: none
Default:""
Resource: *session
Description: The session option specifies a file to read when Solstice SyMON starts up. This file is a Tcl file in the same format as Tcl files that are saved in the System Meter, Kernel Data Catalog, or Logical View consoles. It defines the layout and contents of a Solstice SyMON instance.

This option is used by the CDE session manager to restore previously saved layouts. Not all windows are currently saved or restored—only the Launcher and System Meters. When you invoke Solstice SyMON at a later date, your previous environment is restored.

target

Name: -target
Abbreviated Name: -t
Default: target_system_name
Resource: *target
Description: Name of the server to be monitored.

tempPruneTime

Name: -tempPruneTime
Abbreviated Name: -tpt
Default: 1440
Resource: *tempPruneTime
**Description:** Length of time (in minutes) for Config Reader data (such as board temperature) to be retained by the GUI. For example, if the `tpt` is 180 minutes, Solstice SyMON deletes data more than three hours old.

---

**vtsui**

- **Name:** `-vtsui`
- **Abbreviated Name:** None
- **Default:** `vtsui.online`
- **Resource:** `*vtsui`
- **Description:** Path of SunVTS user interface binary.
This chapter presents troubleshooting tips when using Solstice SyMON.

**Troubleshooting Tips**

Table 6-1 presents troubleshooting problems and the suggested corrective actions.

<table>
<thead>
<tr>
<th>Problem</th>
<th>System Display</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Generator fails to start properly</td>
<td>&quot;We need the TCL variable Rules to proceed&quot; is displayed in the Event Log file</td>
<td>The upgraded Event Generator is running with an older rules file. Upgrade the event rules by installing the new rules you obtained from the Updates CD (see Chapter 2.)</td>
</tr>
<tr>
<td>All agents are displayed in red on the Solstice SyMON console and there are no daemons running on your server</td>
<td>Agents are displayed in red</td>
<td>You may have installed Solstice SyMON agents on an unsupported platform such as an Ultra Enterprise 1 system. Install the Solstice SyMON agents on one of the supported platforms listed in Chapter 1.</td>
</tr>
<tr>
<td>Agents are displayed in red on the Solstice SyMON console or no daemons are running on your server</td>
<td>Agents are displayed in red</td>
<td>Check /var/adm/messages for Solstice SyMON-related error messages.</td>
</tr>
<tr>
<td>Problem</td>
<td>System Display</td>
<td>Corrective Action</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Solstice SyMON agents are running but the GUI or Event Generator cannot connect to the agents</td>
<td>Event Generator messages will be written to: /var/opt/SUNWsymon/host/EG/eg_debug.&amp;&lt;pid&gt;</td>
<td>Set the debug flag to 4 to trace connectivity; for example: symon -aildebug 4 or in sm_symond.conf, use: sm_egd -D 4 in addition to other arguments.</td>
</tr>
<tr>
<td>You are experiencing problems with the Event Generator</td>
<td>(See Corrective Action)</td>
<td>Check for error messages in the Event Generator log file either by using the Log file Viewer or examining this file: /var/opt/SUNWsymon/&lt;host&gt;/EG/event_log</td>
</tr>
<tr>
<td>You are experiencing difficulties with the log file scanner</td>
<td>(See Corrective Action)</td>
<td>Check for error messages in the Log file scanner log file either by using the Log file Viewer or by examining this file: /var/opt/SUNWsymon/&lt;host&gt;/LS/ls_log</td>
</tr>
<tr>
<td>Solstice SyMON 1.0 and later releases require CDE 1.0.1 and later</td>
<td>“ld.so.1: ./symon: fatal: relocation error: symbol not found: braelist: referenced in /usr/dt/lib/libDtHelp.so.1”</td>
<td>Upgrade your CDE installation to CDE version 1.01 or later; refer to your CDE documentation.</td>
</tr>
<tr>
<td>Your system is too heavily loaded</td>
<td>“do_accept : too many open files” appears in the /var/adm/messages file</td>
<td>Close some of the GUIs polling the system</td>
</tr>
<tr>
<td>The Event Generator is saturated with polling requests</td>
<td>“get_all_event_string: data not ASCII type =”</td>
<td>Kill and restart the Event Generator; refer to “To Activate New or Modified Event Rules by Stopping and Restarting the Event Generator” in Chapter 4.</td>
</tr>
<tr>
<td>Solstice SyMON is installed improperly</td>
<td>A message similar to “ld.so.1: /opt/SUNWsymon/shlib/sm_symond: fatal: libaip.so.1: can’t open file: errno=2” appears on the system console or the command terminal</td>
<td>Remove the SUNWsyrt package and install the Solstice SyMON 1.3 SUNWsyrt package (see Chapter 2).</td>
</tr>
</tbody>
</table>
### Table 6-1 Troubleshooting Tips (Continued)

<table>
<thead>
<tr>
<th>Problem</th>
<th>System Display</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solstice SyMON is installed improperly</td>
<td>When starting the SyMON GUI, a message like &quot;ld.so.1: symon: fatal: relocation error: symbol not found: called_on_incoming_fd_data: referenced in /opt/SUNWsymon/lib/libaip.so&quot; appears</td>
<td>Remove the SUNWsyu package and install the Solstice SyMON 1.3 SUNWsyu package (see Chapter 2.)</td>
</tr>
<tr>
<td>Solstice SyMON is installed improperly</td>
<td>When starting the SyMON agents or Event Generator, a message such as &quot;ld.so.1: /opt/SUNWsymon/sbin/sm_symond: fatal: relocation error: symbol not found: called_on_incoming_fd_data referenced in /opt/SUNWsymon/lib/libaip.so&quot; appears on the system console, or the command terminal in /var/adm/messages</td>
<td>Remove the SUNWsys or SUNWsye package and install the Solstice SyMON 1.3 SUNWsys or SUNWsye packages, respectively (see Chapter 2.)</td>
</tr>
<tr>
<td>A Solstice SyMON client not running Solstice SyMON 1.3 is attempting to monitor a host running Solstice SyMON 1.3.</td>
<td>When starting the SyMON GUI, a message appear such as &quot;symon: _AIP_request_V14: RPC: Program/version mismatch; low version = XX, high version = XX&quot; where XX is a number greater than 14</td>
<td>Upgrade the client to Solstice SyMON 1.3 (see Chapter 2.)</td>
</tr>
</tbody>
</table>
The SyMON GUI shows the Event Generator in red. This means the Event Viewer is not accessible.

Table 6-1  Troubleshooting Tips  (Continued)

<table>
<thead>
<tr>
<th>Problem</th>
<th>System Display</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The SyMON GUI shows the Event Generator in red. This means the Event</td>
<td>On the agent host, a message in /var/adm/messages like ... /opt/SUNWsymon/sbin/sm_symond [...]: Version mismatch. Symond on &lt;Event Generator host&gt; is not version 1.3 or on the Event Generator host, a message such as .... /opt/SUNWsymon/sbin /sm_egd[...] Got an error: AIL error in /opt/SUNWsymon/sbin/sm_egd: Version mismatch. Symond does not use AIP version 14&gt;</td>
<td>Upgrade the Event Generator host to Solstice SyMON 1.3 (see Chapter 2.)</td>
</tr>
<tr>
<td>Viewer is not accessible. The version of Solstice SyMON on the agent host is earlier than version 1.3.</td>
<td></td>
<td>Upgrade the agent host to Solstice SyMON 1.3 (see Chapter 2.)</td>
</tr>
<tr>
<td></td>
<td>In /var/adm/messages a message such as &quot;. . /opt/SUNWsymon/sbin /sm_symond[...]: AIL error in /opt/SUNWsymon/sbin /sm_symond: Version mismatch. Symond does not use AIP version 14 or on the Event Generator host, a message in /var/adm/messages like . . /opt/SUNWsymon/sbin/sm_egd[. . .]: Got an error: AIL error in /opt/SUNWsymon/sbin/sm_egd: Version mismatch. Symond on &lt;agent host&gt; is not version 1.3&gt;</td>
<td></td>
</tr>
</tbody>
</table>
The Solstice SyMON GUI displays unusual colors. Error messages may be displayed on the system terminal stating that the GUI cannot allocate certain colors. The shared default color map is full. There are two ways to alleviate this problem:

• Make Solstice Symon use a private color map.
• Reduce the number of colors used by other applications.

To have a private color map for the Physical View images, invoke Solstice SyMON as `symon -cm`. There may be some color map switching as the cursor focus is moved from the Physical Views to other windows. Each window should display correct colors when the cursor focus is in that window. The main application that uses colors is likely to be Netscape. Try invoking Netscape as `netscape -ncol 64` & to limit its color map use.

<table>
<thead>
<tr>
<th>Problem</th>
<th>System Display</th>
<th>Corrective Action</th>
</tr>
</thead>
</table>
| The Solstice SyMON GUI displays unusual colors. | Error messages may be displayed on the system terminal stating that the GUI cannot allocate certain colors. | The shared default color map is full. There are two ways to alleviate this problem:
• Make Solstice Symon use a private color map.
• Reduce the number of colors used by other applications.
To have a private color map for the Physical View images, invoke Solstice SyMON as `symon -cm`. There may be some color map switching as the cursor focus is moved from the Physical Views to other windows. Each window should display correct colors when the cursor focus is in that window. The main application that uses colors is likely to be Netscape. Try invoking Netscape as `netscape -ncol 64` & to limit its color map use. |
This appendix provides a summary of the Kernel Reader data hierarchy.

**Kernel Reader**

The Kernel Reader is one of the three system agents. Use the information in this appendix if you want to write event rules that monitor the output of the Kernel Reader.

Table A-1 lists the Kernel Reader hierarchy.

The first column contains the name of the node or property.

The second column specifies whether the parameter is a node (N) or a property (P). A node in the hierarchy is a starting point for a branch of the hierarchy. All properties that belong to a node appear below the node and are marked with a P. For example, `cpu.busy` and `cpu.user` fall under the `cpu` node. The node and its properties are grouped together.

The third column lists the value type. The Kernel Reader generates five types of values:

- (I) Instant value at the sample time
- (S) Summary over the last sample interval
- (A) Average value over last sample interval
- (\%) Percentage value (100.0 == 100\%) over the last sample interval
- (R) Rate value (per second) over the last sample interval
The fourth column describes the node or property.

<table>
<thead>
<tr>
<th>Name of Node or Property</th>
<th>Node or Property</th>
<th>Value Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>KernelReader</td>
<td>N</td>
<td>Kernel Reader root</td>
<td></td>
</tr>
<tr>
<td>control</td>
<td>N</td>
<td>Control information</td>
<td></td>
</tr>
<tr>
<td>control.pid</td>
<td>P</td>
<td>I</td>
<td>Process ID for the Kernel Reader</td>
</tr>
<tr>
<td>cpu</td>
<td>N</td>
<td>%</td>
<td>CPU usage over all CPUs</td>
</tr>
<tr>
<td>cpu.busy</td>
<td>P</td>
<td>%</td>
<td>CPU busy time (user + system)</td>
</tr>
<tr>
<td>cpu.user</td>
<td>P</td>
<td>%</td>
<td>User time</td>
</tr>
<tr>
<td>cpu.sys</td>
<td>P</td>
<td>%</td>
<td>System time</td>
</tr>
<tr>
<td>cpu.wait</td>
<td>P</td>
<td>%</td>
<td>Wait time</td>
</tr>
<tr>
<td>cpu.idle</td>
<td>P</td>
<td>%</td>
<td>Idle time</td>
</tr>
<tr>
<td>cpu.ncpu</td>
<td>P</td>
<td>I</td>
<td>Number of CPUs</td>
</tr>
<tr>
<td>cpu.context_switch</td>
<td>P</td>
<td>R</td>
<td>Context switches rate</td>
</tr>
<tr>
<td>cpu.interrupt</td>
<td>P</td>
<td>R</td>
<td>Interrupts rate</td>
</tr>
<tr>
<td>cpu.syscalls</td>
<td>P</td>
<td>R</td>
<td>System call rate</td>
</tr>
<tr>
<td>cpu.mutex</td>
<td>P</td>
<td>R</td>
<td>Mutex rate</td>
</tr>
<tr>
<td>cpu.forks</td>
<td>P</td>
<td>R</td>
<td>Fork call rate</td>
</tr>
<tr>
<td>cpu.execs</td>
<td>P</td>
<td>R</td>
<td>Exec call rate</td>
</tr>
<tr>
<td>cpu.swapout</td>
<td>P</td>
<td>R</td>
<td>Number of swapouts per second</td>
</tr>
<tr>
<td>cpu.swapin</td>
<td>P</td>
<td>R</td>
<td>Number of swapsins per second</td>
</tr>
<tr>
<td>cpu.pgout</td>
<td>P</td>
<td>R</td>
<td>Number of page-outs per second</td>
</tr>
<tr>
<td>cpu.pgin</td>
<td>P</td>
<td>R</td>
<td>Number of page-ins per second</td>
</tr>
<tr>
<td>cpu.pgpgout</td>
<td>P</td>
<td>R</td>
<td>Number of pages paged out per second</td>
</tr>
<tr>
<td>cpu.pgpgin</td>
<td>P</td>
<td>R</td>
<td>Number of pages paged in per second</td>
</tr>
<tr>
<td>cpu.run_queue_length</td>
<td>P</td>
<td>A</td>
<td>Number of jobs waiting to be run</td>
</tr>
<tr>
<td>cpu.swap_queue_length</td>
<td>P</td>
<td>A</td>
<td>Number of jobs waiting for page swap</td>
</tr>
<tr>
<td>cpu.io_queue_length</td>
<td>P</td>
<td>A</td>
<td>Number of jobs waiting for I/O</td>
</tr>
</tbody>
</table>
Table A-1  Kernel Reader Data Hierarchy  (Continued)

<table>
<thead>
<tr>
<th>Name of Node or Property</th>
<th>Node or Property</th>
<th>Value Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cpu.cpuX</td>
<td>N</td>
<td></td>
<td>Individual CPU data (X=0, 1, 2...)</td>
</tr>
<tr>
<td>cpu.cpuX.instance</td>
<td>P</td>
<td>I</td>
<td>CPU instance (the X in the label)</td>
</tr>
<tr>
<td>cpu.cpuX.busy</td>
<td>P</td>
<td>%</td>
<td>CPU busy time (user + system)</td>
</tr>
<tr>
<td>cpu.cpuX.user</td>
<td>P</td>
<td>%</td>
<td>User time (100.00 == 100%)</td>
</tr>
<tr>
<td>cpu.cpuX.sys</td>
<td>P</td>
<td>%</td>
<td>System time</td>
</tr>
<tr>
<td>cpu.cpuX.wait</td>
<td>P</td>
<td>%</td>
<td>Wait time</td>
</tr>
<tr>
<td>cpu.cpuX.idle</td>
<td>P</td>
<td>%</td>
<td>Idle time</td>
</tr>
<tr>
<td>cpu.cpuX.context_switch</td>
<td>P</td>
<td>R</td>
<td>Context switches rate</td>
</tr>
<tr>
<td>cpu.cpuX.interrupt</td>
<td>P</td>
<td>R</td>
<td>Interrupts rate</td>
</tr>
<tr>
<td>cpu.cpuX.syscalls</td>
<td>P</td>
<td>R</td>
<td>System call rate</td>
</tr>
<tr>
<td>cpu.cpuX.mutex</td>
<td>P</td>
<td>R</td>
<td>Mutex rate</td>
</tr>
<tr>
<td>cpu.cpuX.forks</td>
<td>P</td>
<td>R</td>
<td>Fork call rate</td>
</tr>
<tr>
<td>cpu.cpuX.execs</td>
<td>P</td>
<td>R</td>
<td>Exec call rate</td>
</tr>
<tr>
<td>cpu.cpuX.swapouts</td>
<td>P</td>
<td>R</td>
<td>Number of swapouts per second</td>
</tr>
<tr>
<td>cpu.cpuX.swapins</td>
<td>P</td>
<td>R</td>
<td>Number of swapins per second</td>
</tr>
<tr>
<td>cpu.cpuX.pgpgout</td>
<td>P</td>
<td>R</td>
<td>Number of pages paged out per second</td>
</tr>
<tr>
<td>cpu.cpuX.pgpgin</td>
<td>P</td>
<td>R</td>
<td>Number of pages paged in per second</td>
</tr>
<tr>
<td>cpu.cpuX.pgout</td>
<td>P</td>
<td>R</td>
<td>Number of page-outs per second</td>
</tr>
<tr>
<td>cpu.cpuX.pgin</td>
<td>P</td>
<td>R</td>
<td>Number of page-ins per second</td>
</tr>
<tr>
<td>mem</td>
<td>N</td>
<td></td>
<td>Physical memory</td>
</tr>
<tr>
<td>mem.mem_avail</td>
<td>P</td>
<td>I</td>
<td>Total memory available (physmem) (Mbytes)</td>
</tr>
<tr>
<td>mem.mem_inuse</td>
<td>P</td>
<td>A</td>
<td>Physical memory in use (Mbytes)</td>
</tr>
<tr>
<td>mem.mem_inuse_p</td>
<td>P</td>
<td>%</td>
<td>Physical memory in use</td>
</tr>
<tr>
<td>mem.mem_free</td>
<td>P</td>
<td>A</td>
<td>Physical memory free (Mbytes)</td>
</tr>
<tr>
<td>mem.mem_free_p</td>
<td>P</td>
<td>%</td>
<td>Physical memory free (%)</td>
</tr>
<tr>
<td>mem.swap_avail</td>
<td>P</td>
<td>A</td>
<td>Swap space available (Mbytes)</td>
</tr>
<tr>
<td>mem.swap_resv</td>
<td>P</td>
<td>A</td>
<td>Swap space reserved (Mbytes)</td>
</tr>
</tbody>
</table>
### Table A-1  Kernel Reader Data Hierarchy  (Continued)

<table>
<thead>
<tr>
<th>Name of Node or Property</th>
<th>Node or Property</th>
<th>Value Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>mem.swap.alloc</td>
<td>P</td>
<td>A</td>
<td>Swap space allocated (Mbytes)</td>
</tr>
<tr>
<td>mem.swap.free</td>
<td>P</td>
<td>A</td>
<td>Swap space free (Mbytes)</td>
</tr>
<tr>
<td>mem.swap.total</td>
<td>P</td>
<td>I</td>
<td>Total swap space (Mbytes)</td>
</tr>
<tr>
<td>mem.swap.devfree</td>
<td>P</td>
<td>A</td>
<td>Total free swap space (Mbytes)</td>
</tr>
<tr>
<td>disk</td>
<td>N</td>
<td></td>
<td>For disk I/O, summary on all disks</td>
</tr>
<tr>
<td>disk.ndisk</td>
<td>P</td>
<td>I</td>
<td>Number of disks</td>
</tr>
<tr>
<td>disk.ops</td>
<td>P</td>
<td>R</td>
<td>Average disk operations (r+w) rate (op/s)</td>
</tr>
<tr>
<td>disk.reads</td>
<td>P</td>
<td>R</td>
<td>Average disk read rate (op/s)</td>
</tr>
<tr>
<td>disk.write</td>
<td>P</td>
<td>R</td>
<td>Average disk write rate (op/s)</td>
</tr>
<tr>
<td>disk.nread</td>
<td>P</td>
<td>R</td>
<td>Number of bytes read (bytes/s)</td>
</tr>
<tr>
<td>disk.nwritten</td>
<td>P</td>
<td>R</td>
<td>Number of bytes written (bytes/s)</td>
</tr>
<tr>
<td>disk.queuelength</td>
<td>P</td>
<td>A</td>
<td>Average disk queue length</td>
</tr>
<tr>
<td>disk.waittime</td>
<td>P</td>
<td>A</td>
<td>Average wait time (ms)</td>
</tr>
<tr>
<td>disk.runtime</td>
<td>P</td>
<td>A</td>
<td>Average run time</td>
</tr>
<tr>
<td>disk.X</td>
<td>N</td>
<td></td>
<td>Individual disks (disk name as label, such as sd3)</td>
</tr>
<tr>
<td>disk.X.reads</td>
<td>P</td>
<td>R</td>
<td>Average disk read rate (op/s)</td>
</tr>
<tr>
<td>disk.X.write</td>
<td>P</td>
<td>R</td>
<td>Average disk write rate (op/s)</td>
</tr>
<tr>
<td>disk.X.nread</td>
<td>P</td>
<td>R</td>
<td>Number of bytes read (Kbytes/s)</td>
</tr>
<tr>
<td>disk.X.nwritten</td>
<td>P</td>
<td>R</td>
<td>Number of bytes written (Kbytes/s)</td>
</tr>
<tr>
<td>disk.X.busy</td>
<td>P</td>
<td>%</td>
<td>Disk busy</td>
</tr>
<tr>
<td>disk.X.svctime</td>
<td>P</td>
<td>A</td>
<td>Average service time (ms)</td>
</tr>
<tr>
<td>disk.X.waittime</td>
<td>P</td>
<td>A</td>
<td>Average wait time (ms)</td>
</tr>
<tr>
<td>disk.X.runtime</td>
<td>P</td>
<td>A</td>
<td>Average run time (ms)</td>
</tr>
<tr>
<td>disk.X.queuelength</td>
<td>P</td>
<td>A</td>
<td>Average queue length</td>
</tr>
<tr>
<td>net</td>
<td>N</td>
<td></td>
<td>Network-related values, all interfaces</td>
</tr>
<tr>
<td>net.nnet</td>
<td>P</td>
<td>I</td>
<td>Number of net interface</td>
</tr>
</tbody>
</table>
If any component of a hierarchy path contains a period (.), you may not be able to use the findlist function to find it. For example, if you search for the mount point /export/a0.test reported by the Config Reader via the path: system.slot.board.io-unit.sbi.dma.esp.sd./export/a0.test the node will not be found. Instead, use: system.slot.board.io-unit.sbi.dma.esp.sd.* to find this node.
The Config Reader determines the configuration of a machine, along with the status of its components. Its output is depicted in these consoles:

- Physical View
- Logical View

Tables B-2 through B-4 list the Config Reader data hierarchy. Use the information in this appendix if you want to write event rules that monitor the output of the Config Reader.
Terminology

The terms in Table B-1 are used to explain the information in Table B-2.

Table B-1  Definitions of Common Config Reader Terms

<table>
<thead>
<tr>
<th>Property</th>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>P</td>
<td>instance</td>
<td>This is a decimal or hexadecimal number acquired by reading <code>/etc/path_to_inst</code>, which maps physical device names to the instance number; refer to the man page for more information.</td>
</tr>
<tr>
<td>P</td>
<td>upa-portid</td>
<td>This property exists for SBus and CPU units. Each board has two CPU slots, A and B, which have unique numbers. For example, board 0 has <code>upa-portid</code> 0 and 1, and board 1 has <code>upa-portid</code> 2 and 3, and so on. <code>portid/2</code> = slot number.</td>
</tr>
<tr>
<td>P</td>
<td>upa-mid</td>
<td>This property is displayed for fhc, sbus, cpu-unit and central modes. It is always equal to <code>upa-portid</code>.</td>
</tr>
<tr>
<td>P</td>
<td>hpu</td>
<td>This stands for hot pluggable unit. You can replace hot pluggable units without powering the system down.</td>
</tr>
</tbody>
</table>

Data Hierarchy

These abbreviations are used in the following tables in this chapter:

- I = Integer
- H = Hexadecimal
- A = ASCII

Table B-2 lists the Config Reader data hierarchy for the Ultra Enterprise 3000, 4000, 5000, and 6000 systems that describe the configuration of the host. They can also be electrical entities. For example, the `system_3v` node is not a physical entity but is the input voltage to system boards.

Each node has a set of properties that describe its state; for example, if an LED is on or off, or if a voltage level is acceptable. The node and its properties are grouped together in Table B-2 in the following order:
• The first column contains the node or property name.

• The second column specifies whether the parameter is a node (N) or a property (P). A node in the hierarchy is a starting point for a branch of the hierarchy. All properties that belong to a node appear below the node and are marked with a P. For example, `cpu.busy` and `cpu.user` fall under the `cpu` node. The node and its properties are grouped together.

• The third column contains the data type of the property. Note that the Config Reader always encloses the value of a property between double quotes (" ").

• The fourth column lists the default value, which is not listed for every entry.

• The last column explains the meaning of the node or property.

### Ultra Enterprise 3000, 4000, 5000, and 6000

The following table is the Config Reader data hierarchy for the Ultra Enterprise 3000, 4000, 5000, and 6000 server systems.

**Table B-2  Config Reader Data Hierarchy for the Ultra Enterprise 3000, 4000, 5000, and 6000 Systems**

<table>
<thead>
<tr>
<th>Name</th>
<th>Node or Property</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC_PS</td>
<td>N</td>
<td></td>
<td></td>
<td>AC connector and switch</td>
</tr>
<tr>
<td>status</td>
<td>P</td>
<td>&quot;A&quot;</td>
<td>&quot;OK&quot;/&quot;FAIL&quot;</td>
<td></td>
</tr>
<tr>
<td>SUNW,fas</td>
<td>N</td>
<td></td>
<td></td>
<td>Host Bus Adapter driver</td>
</tr>
<tr>
<td>tape_count</td>
<td>P</td>
<td>&quot;I&quot;</td>
<td></td>
<td>Number of tapes attached to a particular slot</td>
</tr>
<tr>
<td>disk_count</td>
<td>P</td>
<td>&quot;I&quot;</td>
<td></td>
<td>Number of disks attached to a particular slot</td>
</tr>
<tr>
<td>instance*</td>
<td>P</td>
<td>&quot;I&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>device_type*</td>
<td>P</td>
<td>&quot;A&quot;</td>
<td>&quot;scsi&quot;</td>
<td></td>
</tr>
<tr>
<td>SUNW,ffb (N)</td>
<td>N</td>
<td></td>
<td></td>
<td>UPA color frame buffer and graphics accelerator (N) = instance number</td>
</tr>
</tbody>
</table>

* Refer to Table B-1.
Table B-2  Config Reader Data Hierarchy for the Ultra Enterprise 3000, 4000, 5000, and 6000 Systems (Continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Node or Property</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>buffer</td>
<td>P</td>
<td>“A”</td>
<td>“Single”/“Double”</td>
<td></td>
</tr>
<tr>
<td>3DRAM</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>3-D RAM model and version number</td>
</tr>
<tr>
<td>DAC</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>Revision of DAC chip</td>
</tr>
<tr>
<td>FBC_version</td>
<td>P</td>
<td>“H”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>revision</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>Revision of FFB board</td>
</tr>
<tr>
<td>instance*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>upa-portid*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>width</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td>Pixels</td>
</tr>
<tr>
<td>height</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td>Pixels</td>
</tr>
<tr>
<td>device_type</td>
<td>P</td>
<td>“A”</td>
<td>“display”</td>
<td></td>
</tr>
<tr>
<td>model</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SUNW,hme</td>
<td>N</td>
<td></td>
<td></td>
<td>Fast Ethernet device driver</td>
</tr>
<tr>
<td>instance*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>device_type</td>
<td>P</td>
<td>“A”</td>
<td>“network”</td>
<td></td>
</tr>
<tr>
<td>SUNW,leo</td>
<td>N</td>
<td></td>
<td></td>
<td>Double-buffered SBus color frame buffer and graphics accelerator</td>
</tr>
<tr>
<td>instance*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>width</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td>Pixels</td>
</tr>
<tr>
<td>height</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td>Pixels</td>
</tr>
<tr>
<td>model</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>device_type</td>
<td>P</td>
<td>“A”</td>
<td>“display”</td>
<td></td>
</tr>
<tr>
<td>SUNW,pln(N)</td>
<td>N</td>
<td></td>
<td></td>
<td>SPARCstorage Array</td>
</tr>
<tr>
<td>disk_count</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td>Number of attached disks</td>
</tr>
<tr>
<td>device_type</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>SPARCstorage Array</td>
</tr>
<tr>
<td>instance*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Refer to Table B-1.
### Table B-2  Config Reader Data Hierarchy for the Ultra Enterprise 3000, 4000, 5000, and 6000 Systems (Continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Node or Property</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SUNW,rtvc</td>
<td>N</td>
<td></td>
<td></td>
<td>Real-time video capture</td>
</tr>
<tr>
<td>instance*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>model</td>
<td>P</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SUNW,soc (N)*</td>
<td>N</td>
<td></td>
<td></td>
<td>Serial Optical Controller device driver; (N) = instance number</td>
</tr>
<tr>
<td>device_type</td>
<td>P</td>
<td>“A”</td>
<td>See Description</td>
<td>Serial Optical Channel Processor Host Adapter</td>
</tr>
<tr>
<td>instance*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>model</td>
<td>P</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>soc-wwn</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td>World Wide Web device name</td>
</tr>
<tr>
<td>port-wwns</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>board(N)</td>
<td>N</td>
<td></td>
<td></td>
<td>(N) = board number</td>
</tr>
<tr>
<td>hpu</td>
<td>P</td>
<td>“A”</td>
<td>“yes”</td>
<td>Hot plug unit</td>
</tr>
<tr>
<td>temperature</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>N C&lt; ” where N is an integer</td>
</tr>
<tr>
<td>state=</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>• “active:” Normal state for boards after the operating system has booted</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• “disabled:” Disabled by the PROM because it was listed in the ‘disabled-</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>board-list’ property in the options node</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• “failed:” A board that is failed by POST and powered off in the testing</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>phase of PROM operations</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• “hot-plug:” Intermediate state after a board is hotplugged</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• “low-power:” The state that hotplug boards are in before they are removed</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• “unknown:” Unused</td>
</tr>
<tr>
<td>fru</td>
<td>P</td>
<td>“A”</td>
<td>“yes”</td>
<td>Field replaceable unit</td>
</tr>
</tbody>
</table>

* Refer to Table B-1.
Table B-2  Config Reader Data Hierarchy for the Ultra Enterprise 3000, 4000, 5000, and 6000 Systems (Continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Node or Property</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>type</td>
<td>P</td>
<td>“A”</td>
<td>See Description</td>
<td>One of: clock, cpu/memory, Dual SBus I/O, disk-board, SBus/FFB 1/0, pci I/O</td>
</tr>
<tr>
<td>board-num</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td>For example, Ultra-Enterprise 3000: up to 4</td>
</tr>
<tr>
<td>memory_size</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>“N MB,” N is an integer (CPU/memory boards only)</td>
</tr>
<tr>
<td>cdrom</td>
<td>N</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>mounted_partitions</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td>“CD-ROM”</td>
</tr>
<tr>
<td>device_type</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>name</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>For example c0t6d0</td>
</tr>
<tr>
<td>instance*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>central</td>
<td>N</td>
<td></td>
<td></td>
<td>Only exists under the clock board</td>
</tr>
<tr>
<td>instance*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>upa-mid*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>clock-board</td>
<td>N</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>instance*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cpu-unit(N)</td>
<td>N</td>
<td></td>
<td></td>
<td>(N) = unit</td>
</tr>
<tr>
<td>fru</td>
<td>P</td>
<td>“A”</td>
<td>“yes”</td>
<td>Field replaceable unit</td>
</tr>
<tr>
<td>clock-frequency</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>N MHz, where N is an integer</td>
</tr>
<tr>
<td>cpu-type</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>For example sparcl</td>
</tr>
<tr>
<td>status</td>
<td>P</td>
<td>“A”</td>
<td>“online”*/“offline”</td>
<td></td>
</tr>
<tr>
<td>model</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>processor-id</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td>2*board number (+1 if cpu-unit=B )</td>
</tr>
<tr>
<td>unit</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>“A” or “B” (each board takes two CPUs)</td>
</tr>
<tr>
<td>upa-mid*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Refer to Table B-1.
### Table B-2  Config Reader Data Hierarchy for the Ultra Enterprise 3000, 4000, 5000, and 6000 Systems  (Continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Node or Property</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>upa-portid*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>icache-size*</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>“N KB” or “N MB,” where N is a fixed point number</td>
<td></td>
</tr>
<tr>
<td>dcache-size</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>“N KB” or “N MB,” where N is a fixed point number</td>
<td></td>
</tr>
<tr>
<td>ecache-size</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>“N KB” or “N MB,” where N is a fixed point number</td>
<td></td>
</tr>
<tr>
<td>device_type</td>
<td>P</td>
<td>“A”</td>
<td>“cpu”</td>
<td></td>
</tr>
<tr>
<td>board#</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>Board number on which this node resides</td>
</tr>
<tr>
<td>disk_fan</td>
<td>N</td>
<td></td>
<td></td>
<td>Exists only in Ultra Enterprise 3000 systems</td>
</tr>
<tr>
<td>hpu</td>
<td>P</td>
<td>“A”</td>
<td>“yes”</td>
<td>Hotplug unit?</td>
</tr>
<tr>
<td>status</td>
<td>P</td>
<td>“A”</td>
<td>“OK” / “FAIL”</td>
<td></td>
</tr>
<tr>
<td>fan</td>
<td>N</td>
<td></td>
<td></td>
<td>In the Ultra Enterprise 4000, 5000, and 6000, the AC_PS has a fan node</td>
</tr>
<tr>
<td>status</td>
<td>P</td>
<td>“A”</td>
<td>“OK” / “FAIL”</td>
<td></td>
</tr>
<tr>
<td>fhc</td>
<td>N</td>
<td></td>
<td></td>
<td>Fire Hose controller; one associated with each AC; contains board CSR, which controls on-board devices such as PROMs, RAM and UARTs</td>
</tr>
<tr>
<td>instance*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>upa-mid*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>version#</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td>Version number</td>
</tr>
<tr>
<td>board#</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td>Board number on which this node resides</td>
</tr>
<tr>
<td>model</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>Address controller</td>
</tr>
<tr>
<td>ac</td>
<td>N</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Refer to Table B-1.
Table B-2  Config Reader Data Hierarchy for the Ultra Enterprise 3000, 4000, 5000, and 6000 Systems  (Continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Node or Property</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>instance*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>version#</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>model</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>device_type</td>
<td>P</td>
<td>“A”</td>
<td>“memory-controller”</td>
<td></td>
</tr>
<tr>
<td>eeprom</td>
<td>N</td>
<td></td>
<td></td>
<td>Electrically programmable read-only memory</td>
</tr>
<tr>
<td>model</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>environment</td>
<td>N</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>instance*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>flashprom</td>
<td>N</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>instance*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>model</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>sbus-speed</td>
<td>P</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>keyswitch</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>position</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>“Normal Mode,” “Secure mode,” or “Diagnostic mode”</td>
</tr>
<tr>
<td>led(N)</td>
<td>N</td>
<td></td>
<td></td>
<td>Power supplies have two LEDs: green (off = no power) and amber (on=FAIL). Boards have three LEDs. Refer to the Ultra Enterprise Maintenance Manual for LED combinations.</td>
</tr>
<tr>
<td>led-num</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td>1, 2, or 3</td>
</tr>
<tr>
<td>state</td>
<td>P</td>
<td>“A”</td>
<td>“on”、“off”</td>
<td></td>
</tr>
<tr>
<td>peripheral_PS(N)</td>
<td>N</td>
<td></td>
<td></td>
<td>184w power supply for SCSI peripherals, additional power for boards in system and pre-charge power for hot plugging boards.</td>
</tr>
<tr>
<td>hpu</td>
<td>P</td>
<td>“A”</td>
<td>“yes”</td>
<td>Hot plug unit</td>
</tr>
</tbody>
</table>

* Refer to Table B-1.
Table B-2  Config Reader Data Hierarchy for the Ultra Enterprise 3000, 4000, 5000, and 6000 Systems  (Continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Node or Property</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>status</td>
<td>P</td>
<td>“A”</td>
<td>“OK”/“FAIL”</td>
<td></td>
</tr>
<tr>
<td>unit#</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td>Unique number of this power supply</td>
</tr>
<tr>
<td>fru</td>
<td>P</td>
<td>“A”</td>
<td>“yes”</td>
<td>Field replaceable unit</td>
</tr>
<tr>
<td>nf(N)</td>
<td>N</td>
<td></td>
<td></td>
<td>SBus FDDI Driver</td>
</tr>
<tr>
<td>ether</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>Ethernet address; for example 8:0:20:75:af:f8</td>
</tr>
<tr>
<td>inet</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td>Internet address; for example 129.146.65.45</td>
</tr>
<tr>
<td>symbol</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>Network name corresponding to the inet address above</td>
</tr>
<tr>
<td>name</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>Driver name; for example, nf0</td>
</tr>
<tr>
<td>instance*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>model</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>device_type</td>
<td>P</td>
<td>“A”</td>
<td>“network”</td>
<td></td>
</tr>
<tr>
<td>power_supply(N)</td>
<td>N</td>
<td>“A”</td>
<td>“yes”</td>
<td>300w board supply, (N) = unit number</td>
</tr>
<tr>
<td>hpu</td>
<td>P</td>
<td>“A”</td>
<td>“yes”</td>
<td>Hot plug unit</td>
</tr>
<tr>
<td>status</td>
<td>P</td>
<td>“A”</td>
<td>“OK”/“FAIL”</td>
<td>Unique number of the power supply</td>
</tr>
<tr>
<td>unit#</td>
<td>P</td>
<td>“A”</td>
<td>“yes”</td>
<td>Field replaceable unit</td>
</tr>
<tr>
<td>fru</td>
<td>P</td>
<td>“A”</td>
<td>“yes”</td>
<td></td>
</tr>
<tr>
<td>sbus(N)</td>
<td>N</td>
<td></td>
<td></td>
<td>Peripheral bus; N=instance number</td>
</tr>
<tr>
<td>instance*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>upa-portid*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>upa-mid*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>version*</td>
<td>P</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>board#</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>Board number on which this node resides</td>
</tr>
</tbody>
</table>

* Refer to Table B-1.
Table B-2  Config Reader Data Hierarchy for the Ultra Enterprise 3000, 4000, 5000, and 6000 Systems  (Continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Node or Property</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>device_type*</td>
<td>P</td>
<td>“A”</td>
<td>“sbus”</td>
<td></td>
</tr>
<tr>
<td>model</td>
<td>P</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>network_count</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td>Network devices attached to this SBus</td>
</tr>
<tr>
<td>remote_console</td>
<td>N</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>status=</td>
<td>P</td>
<td>“A”</td>
<td>“Enabled/Disabled”</td>
<td></td>
</tr>
<tr>
<td>sd(0)</td>
<td>N</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>fru</td>
<td>P</td>
<td>“A”</td>
<td>“yes”</td>
<td>Field replaceable unit</td>
</tr>
<tr>
<td>mounted_partitions</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>device_type</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>name</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>“disk” for example, “c0t0d0”</td>
</tr>
<tr>
<td>instance</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The following data, which is a continuation of the properties that go with the sd(0) node (above) is the output of Config Reader if the disk has mounted partition.

<table>
<thead>
<tr>
<th>Name</th>
<th>Node or Property</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>For example, c0t0d0s0</td>
</tr>
<tr>
<td>percent_used</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td>For example, 49%</td>
</tr>
<tr>
<td>total_bytes</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td>n Mbytes or n Kbytes</td>
</tr>
<tr>
<td>avail_bytes</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td>n Mbytes or n Kbytes</td>
</tr>
<tr>
<td>used_bytes</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td>n Mbytes or n Kbytes</td>
</tr>
<tr>
<td>device_type*</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>Partition</td>
</tr>
<tr>
<td>export name</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>For example, c0t0d0s7</td>
</tr>
<tr>
<td>simm(0)</td>
<td>N</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>board_reference_number</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>slot</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td>CPU/memory slot where this SIMM resides</td>
</tr>
<tr>
<td>size</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>type</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>DRAM</td>
</tr>
</tbody>
</table>

* Refer to Table B-1.
Table B-2  Config Reader Data Hierarchy for the Ultra Enterprise 3000, 4000, 5000, and 6000 Systems  (Continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Node or Property</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fru</td>
<td>P</td>
<td>“A”</td>
<td>“yes”</td>
<td>Field replaceable unit</td>
</tr>
<tr>
<td>sram</td>
<td>N</td>
<td></td>
<td></td>
<td>Static RAM</td>
</tr>
<tr>
<td>instance*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>st (N)</td>
<td>N</td>
<td></td>
<td></td>
<td>SCSI tape, N is the instance number</td>
</tr>
<tr>
<td>fru</td>
<td>P</td>
<td>“A”</td>
<td>“yes”</td>
<td>Field replaceable unit</td>
</tr>
<tr>
<td>model</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>For example, Exabyte EXB-8500 8mm</td>
</tr>
<tr>
<td>name</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>For example, /dev/rmt/0n</td>
</tr>
<tr>
<td>status</td>
<td>P</td>
<td>“A”</td>
<td>“OK/FAIL”</td>
<td></td>
</tr>
<tr>
<td>device_type</td>
<td>P</td>
<td>“A”</td>
<td>“tape drive”</td>
<td></td>
</tr>
<tr>
<td>instance*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>system</td>
<td>N</td>
<td></td>
<td></td>
<td>Contains general properties of the system</td>
</tr>
<tr>
<td>total_processors</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td>Number of processors in the machine</td>
</tr>
<tr>
<td>total_memory</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>N MB, where N is an integer</td>
</tr>
<tr>
<td>total_disks</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>total_tape_devices</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>sample number</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td>Since daemon started on server</td>
</tr>
<tr>
<td>timestamp</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>For example Tue Mar 26 10:33:08 1996</td>
</tr>
<tr>
<td>hostname</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>Machine name</td>
</tr>
<tr>
<td>OS</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>Value as returned by <code>uname(2)</code> in release field</td>
</tr>
<tr>
<td>OS_version</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>Value as returned by <code>uname(2)</code> in release field</td>
</tr>
<tr>
<td>architecture</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>For example, <code>sparc</code>, <code>mc68030</code>, <code>m32100</code>, or <code>8386</code></td>
</tr>
<tr>
<td>machine</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>For example <code>sun4u</code></td>
</tr>
</tbody>
</table>

* Refer to Table B-1.
Table B-2  Config Reader Data Hierarchy for the Ultra Enterprise 3000, 4000, 5000, and 6000 Systems  (Continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Node or Property</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>platform</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>Value as returned by the <code>uname -i</code> command</td>
</tr>
<tr>
<td>serial_number</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>System_clock_frequency</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>$N$ MHz, where $N$ is an integer</td>
</tr>
</tbody>
</table>

The following nodes are not physical entities. They are the output of different power supplies in the system that is used for purposes such as hotplugging and peripherals.

<table>
<thead>
<tr>
<th>Name</th>
<th>Node or Property</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hotplug_charges</td>
<td>N</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>fru</td>
<td>P</td>
<td>“A”</td>
<td>“no”</td>
<td>Field replaceable unit</td>
</tr>
</tbody>
</table>

auxiliary_5v

<table>
<thead>
<tr>
<th>Name</th>
<th>Node or Property</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>status</td>
<td>P</td>
<td>“A”</td>
<td>“OK”/“FAIL”</td>
<td>Field replaceable unit</td>
</tr>
<tr>
<td>fru</td>
<td>P</td>
<td>“A”</td>
<td>“no”</td>
<td>Field replaceable unit</td>
</tr>
</tbody>
</table>

peripheral_12v

<table>
<thead>
<tr>
<th>Name</th>
<th>Node or Property</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>status</td>
<td>P</td>
<td>“A”</td>
<td>“OK”/“FAIL”</td>
<td>Field replaceable unit</td>
</tr>
<tr>
<td>fru</td>
<td>P</td>
<td>“A”</td>
<td>“no”</td>
<td>Field replaceable unit</td>
</tr>
</tbody>
</table>

peripheral_12v_precharge

<table>
<thead>
<tr>
<th>Name</th>
<th>Node or Property</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>status</td>
<td>P</td>
<td>“A”</td>
<td>“OK”/“FAIL”</td>
<td>Field replaceable unit</td>
</tr>
<tr>
<td>fru</td>
<td>P</td>
<td>“A”</td>
<td>“no”</td>
<td>Field replaceable unit</td>
</tr>
</tbody>
</table>

peripheral_5v

<table>
<thead>
<tr>
<th>Name</th>
<th>Node or Property</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>status</td>
<td>P</td>
<td>“A”</td>
<td>“OK”/“FAIL”</td>
<td>Field replaceable unit</td>
</tr>
<tr>
<td>fru</td>
<td>P</td>
<td>“A”</td>
<td>“no”</td>
<td>Field replaceable unit</td>
</tr>
</tbody>
</table>

peripheral_5vprecharge

<table>
<thead>
<tr>
<th>Name</th>
<th>Node or Property</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>status</td>
<td>P</td>
<td>“A”</td>
<td>“OK”/“FAIL”</td>
<td>Field replaceable unit</td>
</tr>
<tr>
<td>fru</td>
<td>P</td>
<td>“A”</td>
<td>“no”</td>
<td>Field replaceable unit</td>
</tr>
</tbody>
</table>

system_5v

<table>
<thead>
<tr>
<th>Name</th>
<th>Node or Property</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>status</td>
<td>P</td>
<td>“A”</td>
<td>“OK”/“FAIL”</td>
<td>Field replaceable unit</td>
</tr>
<tr>
<td>fru</td>
<td>P</td>
<td>“A”</td>
<td>“no”</td>
<td>Field replaceable unit</td>
</tr>
</tbody>
</table>

* Refer to Table B-1.
Table B-1. Config Reader Data Hierarchy for the SPARCserver 1000/1000E and SPARCcenter 2000/2000E.

<table>
<thead>
<tr>
<th>Name</th>
<th>Node or Property</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>system_5v_ precharge</td>
<td>N</td>
<td>N</td>
<td></td>
<td></td>
</tr>
<tr>
<td>status</td>
<td>P</td>
<td>“A”</td>
<td>“OK”/“FAIL”</td>
<td></td>
</tr>
<tr>
<td>fru</td>
<td>P</td>
<td>“A”</td>
<td>“no”</td>
<td>Field replaceable unit</td>
</tr>
<tr>
<td>system_3v</td>
<td>N</td>
<td>N</td>
<td></td>
<td></td>
</tr>
<tr>
<td>status</td>
<td>P</td>
<td>“A”</td>
<td>“OK”/“FAIL”</td>
<td></td>
</tr>
<tr>
<td>fru</td>
<td>P</td>
<td>“A”</td>
<td>“no”</td>
<td>Field replaceable unit</td>
</tr>
<tr>
<td>system_3v_ precharge</td>
<td>N</td>
<td>N</td>
<td></td>
<td></td>
</tr>
<tr>
<td>status</td>
<td>P</td>
<td>“A”</td>
<td>“OK”/“FAIL”</td>
<td></td>
</tr>
<tr>
<td>fru</td>
<td>P</td>
<td>“A”</td>
<td>“no”</td>
<td>Field replaceable unit</td>
</tr>
</tbody>
</table>

* Refer to Table B-1. 

**SPARCserver 1000/1000E and SPARCcenter 2000/2000E**

The following table is the Config Reader data hierarchy for the SPARCstation 1000/1000E and the SPARCcenter 2000/2000E.

Table B-3. SPARCserver 1000/1000E and SPARCcenter 2000/2000E Config Reader Data Hierarchy

<table>
<thead>
<tr>
<th>Name</th>
<th>Node or Property</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>QLGC, isp(N)</td>
<td>N</td>
<td>N</td>
<td></td>
<td></td>
</tr>
<tr>
<td>device_type</td>
<td>P</td>
<td>“A”</td>
<td>“SCSI controller”</td>
<td></td>
</tr>
<tr>
<td>disk_count</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>fru</td>
<td>P</td>
<td>“A”</td>
<td>“yes”</td>
<td>Field replaceable unit</td>
</tr>
<tr>
<td>instance*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>model</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>tape_count</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Refer to Table B-1. 

**Config Reader**
<table>
<thead>
<tr>
<th>Name</th>
<th>Node or Property</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>board(N)</td>
<td>N</td>
<td></td>
<td>(N) = board number. This is a unique number ranging from 0 to the maximum number of boards per machine.</td>
<td></td>
</tr>
<tr>
<td>board-num</td>
<td>P</td>
<td>“I”</td>
<td>“yes”</td>
<td>same as N, above</td>
</tr>
<tr>
<td>fru</td>
<td>P</td>
<td>“A”</td>
<td>“yes”</td>
<td>Field replaceable unit</td>
</tr>
</tbody>
</table>
| state        | P                | “A”  | One of “Active,” “disabled,” or “failed.” | • “active”: Normal state for boards after the operating system has booted  
|              |                  |      |               | • “disabled”: Disabled by the PROM because it was listed in the ‘disabled-board-list’ property in the options node  
|              |                  |      |               | • “failed”: A board that is failed by POST and powered off in the testing phase of PROM operations. |            |
| type         | P                | “A”  | “cpu/memory/io” |            |
| cgsix(N)      | N                |      | (N) = unit number |            |
| device_type  | P                | “A”  | “display” |            |
| instance*    | P                | “I”  |            |            |
| model        | P                | “A”  |            |            |
| cpu-unit(N)   | N                |      | (N) = unit number |            |
| board#       | P                | “I”  |            | Board number on which this node resides |            |
| clock-frequency| P              | “A”  | “N MHz”   |            |
| cpu-type     | P                |      | “sparc”     |            |
| device_type  | P                | “cpu” |            |            |
| fru          | P                | “A”  | “yes”       | Field replaceable unit |            |
| module       | P                | “A”  |            |            |

* Refer to Table B-1.
Table B-3  SPARCserver 1000/1000E and SPARCcenter 2000/2000E Config Reader
Data Hierarchy  (Continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Node or Property</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>processor-id</td>
<td>P</td>
<td>&quot;I&quot;</td>
<td>2*board number (+1 if cpu-unit is &quot;B&quot;)</td>
<td></td>
</tr>
<tr>
<td>sparc-version</td>
<td>P</td>
<td>&quot;I&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>status</td>
<td>P</td>
<td>&quot;A&quot;</td>
<td>&quot;online&quot;/&quot;offline&quot;</td>
<td></td>
</tr>
<tr>
<td>unit</td>
<td>P</td>
<td>&quot;A&quot;</td>
<td>&quot;A&quot; or &quot;B&quot; (each board takes two CPUs)</td>
<td></td>
</tr>
<tr>
<td>dma(N)</td>
<td>N</td>
<td></td>
<td>(N) = unit number</td>
<td></td>
</tr>
<tr>
<td>instance*</td>
<td>P</td>
<td>&quot;I&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>model</td>
<td>P</td>
<td>&quot;A&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>esp(N)</td>
<td>N</td>
<td>&quot;A&quot;</td>
<td>(N) = unit number</td>
<td></td>
</tr>
<tr>
<td>chip</td>
<td>P</td>
<td>&quot;A&quot;</td>
<td>&quot;SCSI controller&quot;</td>
<td></td>
</tr>
<tr>
<td>device_type</td>
<td>P</td>
<td>&quot;A&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>disk_count</td>
<td>P</td>
<td>&quot;I&quot;</td>
<td></td>
<td>Number of disks attached to this node</td>
</tr>
<tr>
<td>instance*</td>
<td>P</td>
<td>&quot;I&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>tape_count</td>
<td>P</td>
<td>&quot;I&quot;</td>
<td></td>
<td>Number of tapes attached to this node</td>
</tr>
<tr>
<td>io-unit(N)</td>
<td>N</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>board#</td>
<td>P</td>
<td>&quot;I&quot;</td>
<td></td>
<td>Board number on which this node resides</td>
</tr>
<tr>
<td>device-id</td>
<td>P</td>
<td>&quot;I&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>instance*</td>
<td>P</td>
<td>&quot;I&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>mem-unit board#</td>
<td>N</td>
<td>&quot;I&quot;</td>
<td></td>
<td>Board number on which this node resides</td>
</tr>
<tr>
<td>device-id</td>
<td>P</td>
<td>&quot;I&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>device_type</td>
<td>P</td>
<td>&quot;A&quot;</td>
<td>&quot;memory&quot;</td>
<td></td>
</tr>
<tr>
<td>size</td>
<td>P</td>
<td>&quot;A&quot;</td>
<td>&quot;N MB&quot;</td>
<td></td>
</tr>
<tr>
<td>status</td>
<td>P</td>
<td>&quot;A&quot;</td>
<td>&quot;OK&quot;/&quot;FAIL&quot;</td>
<td></td>
</tr>
</tbody>
</table>

* Refer to Table B-1.
Table B-3  SPARCserver 1000/1000E and SPARCcenter 2000/2000E Config Reader Data Hierarchy (Continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Node or Property</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>le(N)</td>
<td>N</td>
<td></td>
<td>(N) = unit number</td>
<td></td>
</tr>
<tr>
<td>alias</td>
<td>P</td>
<td></td>
<td>&quot;le&quot;</td>
<td></td>
</tr>
<tr>
<td>device_type</td>
<td>P</td>
<td></td>
<td>&quot;network&quot;</td>
<td></td>
</tr>
<tr>
<td>ether</td>
<td>P</td>
<td></td>
<td>&quot;8:0:20:74:30:43&quot;</td>
<td></td>
</tr>
<tr>
<td>inet</td>
<td>P</td>
<td></td>
<td>&quot;129.146.235.47&quot;</td>
<td></td>
</tr>
<tr>
<td>instance*</td>
<td>P</td>
<td></td>
<td>&quot;I&quot;</td>
<td></td>
</tr>
<tr>
<td>name</td>
<td>P</td>
<td></td>
<td>&quot;le0&quot;</td>
<td></td>
</tr>
<tr>
<td>symbol</td>
<td>P</td>
<td></td>
<td>&quot;pump&quot;</td>
<td></td>
</tr>
<tr>
<td>lebuffer(N)</td>
<td>N</td>
<td></td>
<td>(N) = unit number</td>
<td></td>
</tr>
<tr>
<td>instance*</td>
<td>P</td>
<td></td>
<td>&quot;I&quot;</td>
<td></td>
</tr>
<tr>
<td>model</td>
<td>P</td>
<td></td>
<td>&quot;A&quot;</td>
<td></td>
</tr>
<tr>
<td>network_count</td>
<td>P</td>
<td></td>
<td>&quot;I&quot;</td>
<td></td>
</tr>
<tr>
<td>sbi(N)</td>
<td>N</td>
<td></td>
<td>(N) = unit number</td>
<td></td>
</tr>
<tr>
<td>device_type</td>
<td>P</td>
<td></td>
<td>&quot;SBus card&quot;</td>
<td></td>
</tr>
<tr>
<td>instance*</td>
<td>P</td>
<td></td>
<td>&quot;I&quot;</td>
<td></td>
</tr>
<tr>
<td>simm(N)</td>
<td>N</td>
<td></td>
<td>(N) = unit number</td>
<td></td>
</tr>
<tr>
<td>group#</td>
<td>P</td>
<td></td>
<td>&quot;I&quot;</td>
<td></td>
</tr>
<tr>
<td>memory-type</td>
<td>P</td>
<td></td>
<td>&quot;RAM&quot;</td>
<td></td>
</tr>
<tr>
<td>size</td>
<td>P</td>
<td></td>
<td>&quot;32MB&quot;</td>
<td></td>
</tr>
<tr>
<td>sd(N)</td>
<td>N</td>
<td></td>
<td>(N) = disk number</td>
<td></td>
</tr>
<tr>
<td>device_type</td>
<td>P</td>
<td></td>
<td>&quot;disk&quot;</td>
<td></td>
</tr>
<tr>
<td>fru</td>
<td>P</td>
<td></td>
<td>&quot;A&quot; &quot;yes&quot;</td>
<td>Field replaceable unit</td>
</tr>
<tr>
<td>instance*</td>
<td>P</td>
<td></td>
<td>&quot;I&quot;</td>
<td></td>
</tr>
<tr>
<td>mounted_partitions</td>
<td>P</td>
<td></td>
<td>&quot;I&quot;</td>
<td></td>
</tr>
<tr>
<td>name=&quot;clt3d0&quot;</td>
<td>P</td>
<td></td>
<td>&quot;A&quot; &quot;N mbytes&quot;</td>
<td>Partition name</td>
</tr>
</tbody>
</table>

* Refer to Table B-1.
Table B-3  SPARCserver 1000/1000E and SPARCcenter 2000/2000E Config Reader
Data Hierarchy (Continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Node or Property</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>directory_name</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>For example, / or /usr</td>
</tr>
<tr>
<td>avail_bytes</td>
<td>P</td>
<td>“A”</td>
<td>“N mbytes”</td>
<td></td>
</tr>
<tr>
<td>device_type</td>
<td>P</td>
<td>“partition”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>name</td>
<td>P</td>
<td>“clt3d0s0”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>percent_used</td>
<td>P</td>
<td>“A”</td>
<td>“N%”</td>
<td></td>
</tr>
<tr>
<td>total_bytes</td>
<td>P</td>
<td>“A”</td>
<td>“N mbytes”</td>
<td></td>
</tr>
<tr>
<td>used_bytes</td>
<td>P</td>
<td>“A”</td>
<td>“N mbytes”</td>
<td></td>
</tr>
<tr>
<td>slot (N)</td>
<td>N</td>
<td></td>
<td></td>
<td>Slot where boards are physically installed; (N) = unit number</td>
</tr>
<tr>
<td>slot-num</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>sd</td>
<td>N</td>
<td></td>
<td></td>
<td>This node only exists in cases where no disks are attached to the SCSI controller</td>
</tr>
<tr>
<td>device_type</td>
<td>P</td>
<td>“A”</td>
<td>“block”</td>
<td></td>
</tr>
<tr>
<td>fru</td>
<td>P</td>
<td>“A”</td>
<td>“yes”</td>
<td>Field replaceable unit</td>
</tr>
<tr>
<td>st</td>
<td>N</td>
<td></td>
<td></td>
<td>This node only exists in cases where no tapes are attached</td>
</tr>
<tr>
<td>device_type</td>
<td>P</td>
<td>“A”</td>
<td>“byte”</td>
<td></td>
</tr>
<tr>
<td>fru</td>
<td>P</td>
<td>“A”</td>
<td>“yes”</td>
<td>Field replaceable unit</td>
</tr>
<tr>
<td>system</td>
<td>N</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OS</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>Value as returned by <code>uname(2)</code> in the release field</td>
</tr>
<tr>
<td>OS_version</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>Value as returned by <code>uname(2)</code> in the release field</td>
</tr>
</tbody>
</table>

* Refer to Table B-1.
Ultra Enterprise 2 and 150 Systems

The following table is the Config Reader data hierarchy for the Ultra Enterprise 2 and 150 systems.

Table B-4  Ultra Enterprise 2 and 150 Config Reader Data Hierarchy

<table>
<thead>
<tr>
<th>Name</th>
<th>Node or Property</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SUNW,fas</td>
<td>N</td>
<td></td>
<td></td>
<td>Host Bus Adapter driver</td>
</tr>
<tr>
<td>tape_count</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td>Number of tapes attached to a slot</td>
</tr>
<tr>
<td>disk_count</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td>Number of disks attached to a slot</td>
</tr>
<tr>
<td>instance*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>device_type*</td>
<td>P</td>
<td>“A”</td>
<td>“scsi”</td>
<td></td>
</tr>
</tbody>
</table>

* Refer to Table B-1.
<table>
<thead>
<tr>
<th>Name</th>
<th>Node or Property</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SUNW, ffb(N)</td>
<td></td>
<td></td>
<td></td>
<td>UPA color frame buffer and graphics accelerator (N) = instance number</td>
</tr>
<tr>
<td>buffer</td>
<td>P</td>
<td>“A”</td>
<td>“Single”/“Double”</td>
<td></td>
</tr>
<tr>
<td>3DRAM</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>3-D RAM model and version number</td>
</tr>
<tr>
<td>DAC</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>Revision of DAC chip</td>
</tr>
<tr>
<td>FBC_version</td>
<td>P</td>
<td>“H”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>revision</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>Revision of FFB board</td>
</tr>
<tr>
<td>instance*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>upa-portid*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>width</td>
<td>P</td>
<td>“I”</td>
<td>Pixels</td>
<td></td>
</tr>
<tr>
<td>height</td>
<td>P</td>
<td>“I”</td>
<td>Pixels</td>
<td></td>
</tr>
<tr>
<td>device_type</td>
<td>P</td>
<td>“A”</td>
<td>“display”</td>
<td></td>
</tr>
<tr>
<td>model</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SUNW, hme</td>
<td>N</td>
<td></td>
<td></td>
<td>Fast Ethernet device driver</td>
</tr>
<tr>
<td>instance*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>device_type</td>
<td>P</td>
<td>“A”</td>
<td>“network”</td>
<td></td>
</tr>
<tr>
<td>SUNW, leo</td>
<td>N</td>
<td></td>
<td></td>
<td>Double-buffered SBus color frame buffer and graphics accelerator</td>
</tr>
<tr>
<td>instance*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>width</td>
<td>P</td>
<td>“I”</td>
<td>Pixels</td>
<td></td>
</tr>
<tr>
<td>height</td>
<td>P</td>
<td>“I”</td>
<td>Pixels</td>
<td></td>
</tr>
<tr>
<td>model</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>device_type</td>
<td>P</td>
<td>“A”</td>
<td>“display”</td>
<td></td>
</tr>
<tr>
<td>SUNW, pln(N)</td>
<td>N</td>
<td></td>
<td></td>
<td>SPARCstorage Array</td>
</tr>
<tr>
<td>disk_count</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td>Number of attached disks</td>
</tr>
<tr>
<td>device_type</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Refer to Table B-1.
Table B-4  Ultra Enterprise 2 and 150 Config Reader Data Hierarchy  (Continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Node or Property</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>instance*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SUNW, rtvc</td>
<td>N</td>
<td></td>
<td></td>
<td>Real-time video capture</td>
</tr>
<tr>
<td>instance*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>model</td>
<td>P</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SUNW, soc((N))*</td>
<td>N</td>
<td></td>
<td></td>
<td>Serial Optical Controller device driver; ((N) = \text{instance number})</td>
</tr>
<tr>
<td>device_type</td>
<td>P</td>
<td>“A”</td>
<td>See Description</td>
<td>Serial Optical Channel Processor Host Adapter</td>
</tr>
<tr>
<td>instance*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>model</td>
<td>P</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>soc-wwn</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td>World Wide Web device name</td>
</tr>
<tr>
<td>port-wwns</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>system-board</td>
<td>N</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>state=</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>“active:” Normal state for boards after the operating system has booted “unknown:” Unused</td>
</tr>
<tr>
<td>fru</td>
<td>P</td>
<td>“A”</td>
<td>“yes”</td>
<td>Field replaceable unit</td>
</tr>
<tr>
<td>board-num</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td>Always 1.</td>
</tr>
<tr>
<td>memory_size</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>(N) MB, where (N) is an integer (CPU/memory boards only)</td>
</tr>
<tr>
<td>cdrom</td>
<td>N</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>mounted_partitions</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>device_type</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>CD-ROM</td>
</tr>
<tr>
<td>name</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>For example, c0t6d0</td>
</tr>
<tr>
<td>instance*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cpu-unit((N))</td>
<td>N</td>
<td></td>
<td>((N) = \text{unit})</td>
<td></td>
</tr>
<tr>
<td>fru</td>
<td>P</td>
<td>“A”</td>
<td>“yes”</td>
<td>Field replaceable unit</td>
</tr>
</tbody>
</table>

* Refer to Table B-1.
<table>
<thead>
<tr>
<th>Name</th>
<th>Node or Property</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>clock-frequency</td>
<td>P</td>
<td>“A”</td>
<td>(N) MHz, where (N) is an integer</td>
<td></td>
</tr>
<tr>
<td>cpu-type</td>
<td>P</td>
<td>“A”</td>
<td>For example, sparc</td>
<td></td>
</tr>
<tr>
<td>status</td>
<td>P</td>
<td>“A”</td>
<td>“online”/“offline”</td>
<td></td>
</tr>
<tr>
<td>model</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>processor-id</td>
<td>P</td>
<td>“I”</td>
<td>0 or 1 (only 0 possible on the Ultra Enterprise 150)</td>
<td></td>
</tr>
<tr>
<td>unit</td>
<td>P</td>
<td>“A”</td>
<td>“A” or “B” (only on the Ultra Enterprise 2)</td>
<td></td>
</tr>
<tr>
<td>upa-mid*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>upa-portid*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>icache-size*</td>
<td>P</td>
<td>“A”</td>
<td>(N) KB or (N) MB, where (N) is a fixed point number</td>
<td></td>
</tr>
<tr>
<td>dcache-size</td>
<td>P</td>
<td>“A”</td>
<td>(N) KB or (N) MB, where (N) is a fixed point number</td>
<td></td>
</tr>
<tr>
<td>ecache-size</td>
<td>P</td>
<td>“A”</td>
<td>(N) KB or (N) MB, where (N) is a fixed point number</td>
<td></td>
</tr>
<tr>
<td>device_type</td>
<td>P</td>
<td>“A”</td>
<td>“cpu”</td>
<td></td>
</tr>
<tr>
<td>nf (N)</td>
<td>N</td>
<td></td>
<td></td>
<td>SBus FDDI Driver</td>
</tr>
<tr>
<td>ether</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>Ethernet address; for example, 8:0:20:75:af:f8</td>
</tr>
<tr>
<td>inet</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td>Internet address; for example, 129.146.65.45</td>
</tr>
<tr>
<td>symbol</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>Network name corresponding to the inet address above</td>
</tr>
<tr>
<td>name</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>Driver name; for example. nf0</td>
</tr>
<tr>
<td>instance*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>model</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>device_type</td>
<td>P</td>
<td>“A”</td>
<td>“network”</td>
<td></td>
</tr>
</tbody>
</table>

* Refer to Table B-1.
Table B-4  Ultra Enterprise 2 and 150 Config Reader Data Hierarchy  (Continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Node or Property</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sbus(N)</td>
<td>N</td>
<td></td>
<td></td>
<td>Peripheral bus; N=instance number</td>
</tr>
<tr>
<td>instance*</td>
<td>P</td>
<td>”I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>upa-portid*</td>
<td>P</td>
<td>”I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>upa-mid*</td>
<td>P</td>
<td>”I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>version#*</td>
<td>P</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>device_type*</td>
<td>P</td>
<td>”A”</td>
<td>“sbus”</td>
<td></td>
</tr>
<tr>
<td>model</td>
<td>P</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>network_count</td>
<td>P</td>
<td>”I”</td>
<td></td>
<td>Network devices attached to this SBus</td>
</tr>
<tr>
<td>sd(0)</td>
<td>N</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>fru</td>
<td>P</td>
<td>”A”</td>
<td>“yes”</td>
<td>Field replaceable unit</td>
</tr>
<tr>
<td>mounted_partitions</td>
<td>P</td>
<td>”I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>device_type</td>
<td>P</td>
<td>”A”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>name</td>
<td>P</td>
<td>”A”</td>
<td></td>
<td>“disk” for example, c0t0d0</td>
</tr>
<tr>
<td>instance</td>
<td>P</td>
<td>”I”</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The following data, which is a continuation of the properties that go with the sd(0) node (above), is the output of Config Reader if the disk has mounted partition.

<table>
<thead>
<tr>
<th>Name</th>
<th>Node or Property</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>P</td>
<td>”A”</td>
<td></td>
<td>For example, c0t0d0s0</td>
</tr>
<tr>
<td>percent_used</td>
<td>P</td>
<td>”I”</td>
<td></td>
<td>For example, 49%</td>
</tr>
<tr>
<td>total_bytes</td>
<td>P</td>
<td>”I”</td>
<td></td>
<td>n Mbytes or n Kbytes</td>
</tr>
<tr>
<td>avail_bytes</td>
<td>P</td>
<td>”I”</td>
<td></td>
<td>n Mbytes or n Kbytes</td>
</tr>
<tr>
<td>used_bytes</td>
<td>P</td>
<td>”I”</td>
<td></td>
<td>”n Mbytes or n Kbytes</td>
</tr>
<tr>
<td>device_type*</td>
<td>P</td>
<td>”A”</td>
<td></td>
<td>“partition”</td>
</tr>
<tr>
<td>export name</td>
<td>P</td>
<td>”A”</td>
<td></td>
<td>For example, c0t0d0s7</td>
</tr>
<tr>
<td>simm(N)</td>
<td>N</td>
<td></td>
<td></td>
<td>N is SIMM instance.</td>
</tr>
<tr>
<td>slot</td>
<td>P</td>
<td>”I”</td>
<td></td>
<td>CPU/memory slot where this SIMM resides</td>
</tr>
</tbody>
</table>

* Refer to Table B-1.
Table B-4  Ultra Enterprise 2 and 150 Config Reader Data Hierarchy  (Continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Node or Property</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>size</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>type</td>
<td>P</td>
<td>“A”</td>
<td>“dram”</td>
<td></td>
</tr>
<tr>
<td>fru</td>
<td>P</td>
<td>“A”</td>
<td>“yes”</td>
<td>Field replaceable unit</td>
</tr>
<tr>
<td>board-reference-number</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>Address of simm on board.</td>
</tr>
<tr>
<td>st (N)</td>
<td>N</td>
<td></td>
<td></td>
<td>SCSI tape, N is the instance number</td>
</tr>
<tr>
<td>fru</td>
<td>P</td>
<td>“A”</td>
<td>“yes”</td>
<td>Field replaceable unit</td>
</tr>
<tr>
<td>model</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>For example, Exabyte EXB-8500 8mm</td>
</tr>
<tr>
<td>name</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>For example, /dev/rmt/0n</td>
</tr>
<tr>
<td>status</td>
<td>P</td>
<td>“A”</td>
<td>“OK/FAIL”</td>
<td></td>
</tr>
<tr>
<td>device_type</td>
<td>P</td>
<td>“A”</td>
<td>“tape drive”</td>
<td></td>
</tr>
<tr>
<td>instance*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>system</td>
<td>N</td>
<td></td>
<td></td>
<td>Contains general properties of the system</td>
</tr>
<tr>
<td>total_processors</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td>Number of processors in the machine</td>
</tr>
<tr>
<td>total_memory</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>N MB, where N is an integer</td>
</tr>
<tr>
<td>total_disks</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>total_tape_devices</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>sample_number</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td>Since daemon started on server</td>
</tr>
<tr>
<td>timestamp</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>For example, Tue Mar 26 10:33:08 1996</td>
</tr>
<tr>
<td>hostname</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>Machine name</td>
</tr>
<tr>
<td>OS</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>Value as returned by <code>uname(2)</code> in release field</td>
</tr>
<tr>
<td>OS_version</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>Value as returned by <code>uname(2)</code> in release field</td>
</tr>
<tr>
<td>architecture</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>For example, sparc, mc68030, m32100, or 8386</td>
</tr>
<tr>
<td>machine</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>For example, sun4u</td>
</tr>
</tbody>
</table>

* Refer to Table B-1.
<table>
<thead>
<tr>
<th>Name</th>
<th>Node or Property</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>platform</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>Specific model of the hardware platform</td>
</tr>
<tr>
<td>serial_number</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>System_clock_frequency</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>sbus-board(N)</td>
<td>N</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>board-num</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>fru</td>
<td>P</td>
<td>“A”</td>
<td>“yes”</td>
<td>Field replaceable unit</td>
</tr>
<tr>
<td>model</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>state</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>“active:” Normal state for boards after the operating system has booted.</td>
</tr>
<tr>
<td>le</td>
<td>N</td>
<td>“I”</td>
<td></td>
<td>Ethernet device driver</td>
</tr>
<tr>
<td>instance*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>device_type</td>
<td>P</td>
<td>“A”</td>
<td>“network”</td>
<td></td>
</tr>
<tr>
<td>ether</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>Ethernet address; for example “8:0:20:75:af:f8”</td>
</tr>
<tr>
<td>inet</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td>Internet address; for example “129.146.65.45”</td>
</tr>
<tr>
<td>name</td>
<td>P</td>
<td>“A”</td>
<td></td>
<td>Driver name; for example, le0</td>
</tr>
<tr>
<td>device_type</td>
<td>P</td>
<td>“A”</td>
<td>“network”</td>
<td></td>
</tr>
<tr>
<td>SUNW,fdtwo</td>
<td>N</td>
<td>“I”</td>
<td></td>
<td>Floppy disk device</td>
</tr>
<tr>
<td>instance*</td>
<td>P</td>
<td>“I”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>device_type</td>
<td>P</td>
<td>“A”</td>
<td>“block”</td>
<td></td>
</tr>
<tr>
<td>fru</td>
<td>P</td>
<td>“A”</td>
<td>“yes”</td>
<td>Field replaceable unit</td>
</tr>
</tbody>
</table>

* Refer to Table B-1.
If any component of a hierarchy path contains a period (.) in it, you may not be able to use the findlist function to find it. For example, if you search for the mount point /export/a0.test reported by the Config Reader via the path:
system.slot.board.io-unit.sbi.dma.esp.sd./export/a0.test,
the node will not be found. Instead, use:
system.slot.board.io-unit.sbi.dma.esp.sd.* to find this node.
Installing SNMP Traps

This appendix describes how to install and set up SNMP traps. A SNMP trap is an asynchronous message directed at a specific monitor.

The Event Generator can send SNMP traps to applications that listen for SNMP traps, such as Solstice Site Manager and Solstice Domain Manager. Traps include information about events on the system that may be useful to someone running a Solstice Site Manager and Solstice Domain Manager console.

安装SNMP陷阱

注释 — 在开始此过程之前，请确保您知道 snmphost 机器的名称和 IP 地址。安装 SNMP 陷阱时，您需要输入此信息。

要安装 SNMP 版本 2.2.3 包，请参阅 SNMP 安装菜单。
▼ **To Install SNMP Traps**

1. Make sure the software that receives SNMP traps is installed and configured.

2. On the machine `snmphost`, copy the following three files in the
   `/opt/SUNWsymon/etc/snm` directory on the event host to the
   `/opt/SUNWconn/agents` directory as superuser (default SNMP directory.)
   - `symon.mib.oid`
   - `symon.mib.traps`
   - `symon.mib.schema`

3. Run the following command on the event host:

```bash
# /opt/SUNWsymon/sbin/sm_confsymon -e server_host -S "list_of_snmphost"
```

where:

- `"list_of_snmphost"` indicates a space-separated list of hosts to receive the
  SNMP traps.

4. Start the Event Generator daemon by entering:

```
# /opt/SUNWsymon/sbin/sm_control start
```

5. Run `snm -i` and select BasicStart.
   Wait for the SNMP Console to come up from the Main menu.

6. Select Edit->Create.
   a. Make sure your “Category” is Component.
   b. Select your “Type” to be WorkStation.
   c. Click the Create button.

A Create Form pop-up window is displayed.
7. Type the following:
   - Name: `snmp_hostname`
   - IP address: `snmp_hostname's IP address`
   - SNMP Rdcommunity: `public`
   - SNMP Wrcommunity: `public`

8. Select the SYMONMIB check button then click Apply.

9. Select the workstation icon you just created and from the main menu, select View—>Event/Trap Report.

10. Send test traps using this command on the event host machine:

    ```
    # /opt/SUNWsymon/sbin/trapsend -a "1.3.6.1.4.1.42 STRING (STATUS | FAIL)"
    ```

    If you receive the message above in double quotes in your Event/Trap Report, you are ready to receive SNMP traps from the server.
This appendix describes the default Solstice SyMON 1.3 rules. Use this appendix to determine the rules that are incorporated into Solstice SyMON 1.3. By identifying the default rules, you can determine whether or not you need to write a new rule.

Table D-1 describes the default rules supplied with Solstice SyMON 1.3. The columns in the table describe the following:

- Column 1 is the rule number.
- Column 2 is a description of the rule.
- Column 3 is the action taken when the condition is true.
- Column 4 is the severity.
- Column 5 is the priority.

<table>
<thead>
<tr>
<th>Rule Number</th>
<th>Description</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>General: syrules.tcl</td>
<td>Symond status</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>0</td>
<td>Symond status</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>1</td>
<td>Server status</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>3</td>
<td>Log Scanner status</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>4</td>
<td>Kernel Reader status</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>6</td>
<td>Delay initial Log Scanner and death status</td>
<td>none</td>
</tr>
</tbody>
</table>
Table D-1  Default Solstice SyMON 1.3 Rules (Continued)

<table>
<thead>
<tr>
<th>Rule Number</th>
<th>Description</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>Delay initial Kernel Reader death status</td>
<td>none</td>
</tr>
<tr>
<td>8</td>
<td>Warning if label contains “.”</td>
<td>none</td>
</tr>
<tr>
<td>9</td>
<td>Warning if label contains “*”</td>
<td>alarm, snmp</td>
</tr>
</tbody>
</table>

**General:** egrules.tcl

<table>
<thead>
<tr>
<th>Rule Number</th>
<th>Description</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>Trim event log if getting full</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>51</td>
<td>Warning when maximum number of events is near</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>52</td>
<td>Warning when ls_hist is corrupted</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>53</td>
<td>Warning on incorrect Tcl rule syntax</td>
<td>alarm, snmp</td>
</tr>
</tbody>
</table>

**General:** swrules.tcl

<table>
<thead>
<tr>
<th>Rule Number</th>
<th>Description</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>Disk busy</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>102</td>
<td>Swap space</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>103</td>
<td>CPU swapping and paging</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>104</td>
<td>CPU load</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>105</td>
<td>File system full</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>106</td>
<td>No swap space</td>
<td>alarm, snmp</td>
</tr>
</tbody>
</table>

**General:** hwrules.tcl

<table>
<thead>
<tr>
<th>Rule Number</th>
<th>Description</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>209</td>
<td>SIMM error</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>210</td>
<td>ssd hardware error</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>211</td>
<td>ssd fatal error</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>212</td>
<td>SIMM error</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>214</td>
<td>configd.*.status failing</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>216</td>
<td>CPU panic</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>217</td>
<td>Tape error rate high</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>219</td>
<td>ssd off-line</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>220</td>
<td>ssd okay (online)</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>222</td>
<td>Fatal SunVTS error</td>
<td>alarm, snmp</td>
</tr>
</tbody>
</table>
Table D-1  Default Solstice SyMON 1.3 Rules (Continued)

<table>
<thead>
<tr>
<th>Rule Number</th>
<th>Description</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>223</td>
<td>SunVTS error</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td><strong>General:</strong></td>
<td><strong>pfrules.tcl</strong></td>
<td></td>
</tr>
<tr>
<td>300</td>
<td>SIMM errors</td>
<td>add_pfa SIMM</td>
</tr>
<tr>
<td>301</td>
<td>Disk soft errors</td>
<td>add_pfa DISK</td>
</tr>
<tr>
<td>302</td>
<td>Disk soft errors from smart drives</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>303</td>
<td>Check SIMM (test period 1)</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>304</td>
<td>Check SIMM (test period 2)</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>305</td>
<td>Check SIMM (test period 3)</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>306</td>
<td>Check disk pfa (warning)</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>307</td>
<td>Check disk pfa (severe)</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>308</td>
<td>Trims pfa history</td>
<td>none</td>
</tr>
<tr>
<td><strong>General:</strong></td>
<td><strong>cprules.tcl</strong></td>
<td></td>
</tr>
<tr>
<td>400</td>
<td>CPU overload over x hours</td>
<td>alarm, snmp, add_cpa</td>
</tr>
<tr>
<td>401</td>
<td>Disk busy over x hours</td>
<td>alarm, snmp, add_cpa</td>
</tr>
<tr>
<td>402</td>
<td>Swap space low over x hours</td>
<td>alarm, snmp, add_cpa</td>
</tr>
<tr>
<td>403</td>
<td>Meta CPU events (check_cpa_cpu)</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>404</td>
<td>Meta disk events (check_cpa_disk)</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>405</td>
<td>Meta swap events (check_cpa_swap)</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>406</td>
<td>Trims cpa history</td>
<td></td>
</tr>
<tr>
<td>407</td>
<td>Initializes timestamp for rules 400 and 402</td>
<td></td>
</tr>
</tbody>
</table>

**Platform-Specific Rules:**  SPARCserver 1000(E), SPARCcenter 2000(E):- SS1000.tcl, SC2000.tcl

<table>
<thead>
<tr>
<th>Rule Number</th>
<th>Description</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1002</td>
<td>Config Reader status</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>1005</td>
<td>Delay initial Config Reader death status</td>
<td>none</td>
</tr>
<tr>
<td>1207</td>
<td>system.<em>.</em>.*.status</td>
<td>alarm, snmp</td>
</tr>
</tbody>
</table>
### Table D-1  Default Solstice SyMON 1.3 Rules (Continued)

<table>
<thead>
<tr>
<th>Rule Number</th>
<th>Description</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1208</td>
<td>system.<em>.</em>.<em>.</em>.<em>.</em>.*, status</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>1224</td>
<td>system.<em>.</em>.<em>.</em>.<em>.</em>.*, status</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>1225</td>
<td>Corrected ECC error</td>
<td>alarm, snmp</td>
</tr>
</tbody>
</table>

**Platform-Specific Rules: Ultra Enterprise 3000, 4000, 5000, 6000:**

UEnterprise.tcl

<table>
<thead>
<tr>
<th>Rule Number</th>
<th>Description</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1002</td>
<td>Config Reader status</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>1005</td>
<td>Delay initial <code>configd</code> death status</td>
<td>none</td>
</tr>
<tr>
<td>1201</td>
<td>Hot plug charge DC status</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>1202</td>
<td>Hot plug precharge DC status</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>1203</td>
<td>system.<em>.</em>.*, status</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>1204</td>
<td>Fan status</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>1205</td>
<td>CPU board temperature</td>
<td>alarm, snmp, mailto</td>
</tr>
<tr>
<td>1206</td>
<td>I/O and clock board temperature</td>
<td>alarm, snmp, mailto</td>
</tr>
<tr>
<td>1207</td>
<td>system.<em>.</em>.*, status</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>1208</td>
<td>system.<em>.</em>.*, status</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>1209</td>
<td>system.<em>.</em>.*, status</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>1213</td>
<td>Hot plug &quot;removed&quot;</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>1215</td>
<td>Hot plug &quot;hotplugged into&quot;</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>1218</td>
<td>system.<em>.</em>.*, status</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>1220</td>
<td>Hot plug &quot;installed&quot;</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>1221</td>
<td>Redundant power status</td>
<td>alarm, snmp</td>
</tr>
</tbody>
</table>

**Platform-Specific Rules: Ultra Enterprise 2 and 150:**

UEnterpriseI.tcl

<table>
<thead>
<tr>
<th>Rule Number</th>
<th>Description</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1002</td>
<td>Config Reader status</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>1005</td>
<td>Delay initial <code>configd</code> death status</td>
<td>none</td>
</tr>
</tbody>
</table>

---

*Solstice SyMON 1.3 User's Guide—April 1997*
Table D-1  Default Solstice SyMON 1.3 Rules (Continued)

<table>
<thead>
<tr>
<th>Rule Number</th>
<th>Description</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1207</td>
<td>system.<em>.</em>.*.status</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>1208</td>
<td>system.<em>.</em>.<em>.</em>.*.status</td>
<td>alarm, snmp</td>
</tr>
<tr>
<td>1224</td>
<td>system.<em>.</em>.<em>.</em>.<em>.</em>.<em>.</em>.status</td>
<td>alarm, snmp</td>
</tr>
</tbody>
</table>
action

Tells Solstice SyMON what to do when a condition is true, if the condition changes, or if the system shuts down. Use actions to notify users of a situation that may require attention. For example, an action might be to create an event, to send a record of the event to the Event Log; to generate an email message about the event; to use a modem to dial a beeper, or to execute a program. You can define new actions as needed.

agent

A daemon that collects data from the server.

alarm

A predefined procedure for event rules that makes an event active; opens a log entry in the Event Log for the event; optionally posts a message to the Event Viewer; and highlights the affected node in the appropriate console.

attributes

Elements of an event rule. Attributes include the rule number, condition, actions, level, priority, and severity.

complex rule

An event rule in which a single rule can generate multiple events and log entries by searching a range of parameters. The MULTI parameter in a rule designates it as a complex rule. Complex rules make the Event Manager evaluate the condition for multiple node variables. For example, complex rules can be used to make the Event Manager check the condition for each board on a system.
condition

A Tcl string that defines when a rule is active. This is the only mandatory part of a rule. A condition does not have a tag. Examples of conditions include a failed board or a DNLC (directory name lookup cache) long name ratio greater than 25 percent.

end_alarm

A predefined procedure for event rules that closes the log entry in the Event Log for the event, deletes the event from the Event Viewer, and removes any console.

event

An action that is used to notify other applications of a condition, typically hardware or operating system conditions that may require the attention of the system administrator.

Event Generator

Collects information from the Config Reader, Kernel Reader, and Log Scanner and evaluates the data against its rules. It also maintains data about itself and the state of the server agents. This enables rules to be written against the status of agents (including itself) as well as data from the server.

Event Log

A log in which the Event Generator records events.

Event Manager

A subsystem of Solstice SyMON that reports events based on a set of rules. The Event Manager collects data from server agents and evaluates them for conditions defined within its rules. When a condition is true, an event occurs and the Event Manager implements any specified action(s) in the rule. When the condition that generated the event no longer exists, the Event Manager may run a special action such as closing the event.

Event Viewer

Displays the Event Log information, which includes ID, LVL, OPEN, CLOSED, DURATION, MESSAGE LOCATION, PRI, SEVERITY, ACKED, ACKED BY, RULE NUMBER.

Kernel Data Catalog

Displays a hierarchical schematic view of the Solaris performance parameters that Solstice SyMON monitors.
Launcher

The main window of Solstice SyMON. Each icon on the console launches one of the seven consoles: Event Viewer, Log Viewer, Physical View, Logical View, Kernel Data Catalog, Process Viewer, and the On-Line Diagnostics screen. It also reports status of the server and the Solstice SyMON agents.

Log Viewer

Displays matching entries in a selected log file.

Logical View

Displays a hierarchical schematic view of the configuration and state.

MULTI

A special event rule attribute used to permit the rule to check a list of node variables for multiple events off a single rule. For example, the MULTI string can be used to make the Event Generator check a condition of a rule for each board in the system.

ON_OPEN

An event rule attribute that is interpreted when a condition for a rule becomes true.

ON_CLOSE

An event rule attribute that is interpreted when a rule is no longer true.

ON_CONTINUE

An event rule attribute that is interpreted when a rule continues to be true two or more times in a row.

ON_SHUTDOWN

An event rule attribute that is interpreted when the system shuts down.

Physical View

Displays graphical images of the server, which are updated dynamically as the server changes configuration or state.

PRIORITY

A rule attribute. A priority for the rule for the user to interpret that is used in conjunction with SEVERITY.

procedures file

Defines procedures used by rules. The file must exist but can be empty. The file is located in /etc/opt/SUNWsymon/event_gen.servername.tcl. Note that servername is the name of the server.
Process Viewer
Displays information on processes running on the server. Information includes the time the process was started and by whom; total CPU that the process has used; and its current status.

rule
A set of conditions and actions associated with that condition. Rules are always in the RULES Tcl variable, which is located in the file /etc/opt/SUNWsymon/rules.tcl.

rules functions
A rules function is a predefined procedure such as ON_OPEN or ON_CLOSE; it is used within an event rule, such as alarm and end_alarm.

Rules variable
A list of event rules specified in the file /etc/opt/SUNWsymon/rules.tcl. This variable is case sensitive.

SEVERITY
An event rule attribute that indicates the severity of the rule for the user to interpret. Used in conjunction with PRIORITY.

simple rule
An event rule that has a one-to-one correspondence between the rule and an event. Because a simple rule does not check a wildcard list of variables, it can only generate a single event.

strip string
The strip string is any subpath that is on the full path. Enclosing an item in the strip string deletes that item from the expanded path. If the strip string is null, you must use double quotes. If the strip string is not null, enclosing the strip string in double quotes is not required, but permissible.

System Meter
A GUI window within the Kernel Data Catalog that displays graphs of monitored performance parameters.

Tcl
A scripting language used to define rules.
Index

Symbols
?
, 126

A
acknowledging an event, 72
activating new or modified events, 99, 109
activating rules, 108
alarm function, 84
alarms and events, monitoring, 69
ascending order
  Event Viewer, View menu, 71
  Process Viewer, View menu, 68
attributes, 81
  graph style window, 57
  LEVEL, 77
  PRIORITY, 77
  see also rules attributes, 82
  SEVERITY, 77

B
books, Tcl language, 75
Bourne shell, setting up, 27

C
C shell, setting up, 27
capacity planning, 70
  rules, 78
capacity planning rules, 79
categories of event rules, 77
cautions, 70
Change Search Criteria, 64
characters, special, 80
-<cm>, 124
collapsing Logical View, 45
colorMap, 124
column resizing, 69
command line options, 123
commands
  customizing, 107
  Tcl, 84
COMMENTS or C attribute, 83
complex rules, examples, 115
complex searches
  performing, 65
Config Reader
data, deleting from hierarchy, 130
determining the path, 100
hierarchy, table of, 143
overview, 5
rules, writing, 99  
variable name, 81  
writing rules, 98
ConfigReader_status, 81
configuration
  Event Generator, 28, 29
host, 28
console
  launching, 36
  On-line Diagnostics, 37
consoles
  Event Viewer, 37, 69
  Kernel Data Catalog, 37
  Log Viewer, 37, 62
  Logical View, 37, 42
  On-line Diagnostics, 37, 47
  overview of, 8
  Physical View, 37
  Process Viewer, 37, 66
Solstice SyMON, 9
cprules.tcl file, 79
creating rules, 98
crnodes function, 85
customizing commands and
  procedures, 107

D

daemon running
  variable name, 81
daemon, symond, 6
data structuring, 97
date, 81
date, displaying, 64
debugging tips
  verify_rules, 109
default setting
  restoring a graph, 61
deleting
  an event, 72
  from hierarchy, Config Reader
data, 130
  graph from a System Meter, 59
  information, 127
Solstice SyMON, 31
variable from a graph, 59
descending sort order
  Event Viewer, View menu, 71
  Process Viewer, View menu, 68
diagnosing hardware problems
  with Sun Validation and Test Suite
  (SunVTS), 47
diagnostics, overview, 11
displaying
date and time, 64
  System Meter graphs, 60
dragthreshold, 124
dynlink function, 86

E
Edit menu, description, 10
egrules.tcl file, 79
end_alarm function, 86
error and warning messages
description, 10
error messages
general description, 9
event
  acknowledging, 72
deleting, 72
description, 76
Event Generator, 3
  configuring, 29
  getting functions, 106
  packages, installing, 23
  root node, variable name, 81
  rules, 79
  starting and stopping, 108
  tasks performed, 104
  writing rules, 98, 106
Event ID, Event Viewer, 70
Event Manager, 3
  overview, 6, 14
**Index**

<table>
<thead>
<tr>
<th>Event Rules</th>
<th>Attributes</th>
<th>81</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capacity Planning</td>
<td>78</td>
<td></td>
</tr>
<tr>
<td>Creating or Modifying</td>
<td>98</td>
<td></td>
</tr>
<tr>
<td>Hardware</td>
<td>78</td>
<td></td>
</tr>
<tr>
<td>Modifying</td>
<td>75</td>
<td></td>
</tr>
<tr>
<td>Non-Hardware</td>
<td>78</td>
<td></td>
</tr>
<tr>
<td>Platform-Specific</td>
<td>79</td>
<td></td>
</tr>
<tr>
<td>Predictive Failure Analysis</td>
<td>78</td>
<td></td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>131</td>
<td></td>
</tr>
<tr>
<td>Types</td>
<td>77</td>
<td></td>
</tr>
<tr>
<td>Writing</td>
<td>75</td>
<td></td>
</tr>
<tr>
<td>Config Reader, 98, 99</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Event Generator, 98, 106</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Kernel Reader, 98, 102</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Log Scanner, 98</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Event Viewer, 13**
- Description | 9 |
- Display, Customizing | 72 |
- Event ID | 70 |
- Overview | 14 |
- Using | 69 |
- View Menu
  - Ascending Sort Order | 71 |
  - Descending Sort Order | 71 |

**Event Gen.servername.tcl, 78, 107**

**Event Gen.tcl, 107**

**Events, 13**

**Events and Alarms**
- Monitoring, 69

**Examples**
- Complex Rules | 115 |
- Rule 0, 110 |
- Rule 100, 118 |
- Rule 102, 113 |
- Rule 106, 120 |
- Rule 201, 115 |
- Rules, 110 |
- Simple Rules, 110

**Exiting the GUI** | 30 |

**Expanding the Logical View, 45**

**F**
- fd, 124
- Features of Solstice SyMON, 1 |
- fi, 125 |
- Field Types
  - GetField, 90 |
  - PutField, 94 |
- File Menu
  - Description, 10 |
  - Physical View, 42 |
- FindList Function, 87 |
- Node Returned by Variable Name, 81 |
- FindStatus Function, 89 |
- FindValue Function, 89 |
- FlashDuration, 124 |
- FlashInterval, 125 |
- Functions
  - Rules, 84 |
  - Tcl, 84

**G**
- GetParameter Function, 91 |
- GetField
  - Field Types, 90 |
  - Function, 90 |
- GetTime Function, 92 |
- Graph
  - Changing Within a System Meter, 58 |
  - Deleting from a System Meter, 59 |
  - Scaling, 60 |
- Graph Style, 56 |
- Graph Style Window
  - Attributes, 57 |
  - Graph Type, 58 |
  - Legend Gravity, 58 |
  - Legend Orientation, 58 |
  - Scaling, 57 |
  - Use Defaults Field, 57 |
  - X-Axis Scaling, 57 |
  - Y-Axis Maximum, 58 |
  - Y-Axis Minimum, 58 |
Y-axis scaling, 57
graphs
  changing the title of System Meter or graph, 58
deleting a variable, 59
displaying in same window, 54
modifying a selected graph, 57
restoring to default setting, 61
selecting, 55
undoing a change, 59
zooming, 60
GUI
  overview of, 8
subsystem package, installing, 24

GUI subsystem package
installing, 24
H
h, 126
hardware event rules, 78
hardware monitoring rules, 79
hardware status
  monitoring, 11, 37
heartbeatInterval, 126
help, 126
Help menu, description, 10
hi, 126
hierarchies, 97
hierarchy
  being evaluated, variable name, 81
  Config Reader, table of, 143
  Kernel Reader, table of, 137
host
  configuring, 28
hwrules.tcl file, 79
I
i, 126
i, 127
icons
  launching, 36
  Solstice SyMON, 9
information messages, 10
information, deleting, 127
installDir, 126
installing
  Event Generator packages, 23
  man pages, 25
  server packages, 22
  SNMP traps, 169
  Solstice SyMON, 19
  user GUI subsystem package, 24
  instruments, Kernel Data Catalog, 53
interval, 127
interval, polling, 127
K
Kernel Data Catalog
  description, 9
  instruments, 53
  monitoring software performance, 12
  using, 52
Kernel Reader
  determining the path, 103
  hierarchy, table of, 137
  overview, 5
  variable name, 81
  writing rules, 98, 102
KernelReader_status, 81
keywords, searching for, 65
Korn shell, setting up, 27
L
Launcher window, 35
  overview, 8
  launching a console, 36
Layout option, 56
legend gravity, 58
legend orientation, 58
LEVEL attribute, 77
level of events, Event Viewer, 70
load search criteria, 66
log file entries
  defining search criteria, 64
  searching, 63
  searching for, 65
Log File Viewer menu
  File menu, 66
Log File Viewer window
  Change Search Criteria, 64
  View menu, 63
Log Scanner
  overview, 6
  tasks performed, 104
  variable name, 81
  writing rules, 98, 104
Log Viewer
  description, 9
  monitoring software performance, 12
  overview, 13
  using, 62
LOG_RULES guidelines, 106
Logical View
  collapsing, 45
  description, 9
  expanding, 45
  monitoring system components, 42
  overview, 11
  Show Information window, 46
  using, 42
LogScanner_status, 81

M
mailto function, 94
man pages, installing, 25
message string definition rules, 79
meters, system, 12
minWait, 127
modified events, activating, 109
modifying
  rules, 98
  selecting graph, 57
monitored system variable name, 81
monitoring
  alarms and events, 69
  hardware status, 37
  rules, 79
  software performance, 12
  system components, 11, 37
    Logical View, 11, 42
  system software performance, 52
  moving a System Meter, 60
MULTI attribute, 82
mw, 127
my_root, 81

N
n, 128
new events, activating, 109
node, 81
non-hardware event rules, 78

O
ON_ACKNOWLEDGE attribute, 82
ON_CLOSE attribute, 82
ON_CONTINU attribute, 82
ON_OPEN attribute, 82
ON_SHUTDOWN attribute, 82
On-line Diagnostics
  description, 9
  overview, 11
options
  command line, 123
  Solstice SyMON, 123

P
packages
  Event Generator, installing, 23
  server, installing, 22
  user GUI subsystem
    installing, 24
PARAMETER attribute, 82
path
determining, Config Reader, 100
Kernel Reader, determining, 103
searching for rules files, 107
performance
software, monitoring, 12
system software
monitoring, 52
pfrules.tcl file, 79
Physical View
description, 9
displaying a more detailed view, 38
displaying specific component information, 40
File menu, 42
overview, 11
Show Information window, 40
using, 37
platform-specific rules, 79
polling interval, 127
predictive failure analysis event rules, 78
PRIORITY attribute, 77
procedures, customizing, 107
Process Viewer
description, 9
description of entries, 67
display, customizing, 68, 72
monitoring software performance, 12
overview, 13
resizing columns, 69
using, 66
View menu
ascending sort order, 68
descending sort order, 68
processes, monitoring, 66
product features, 1
pruneTime, 128
pruning information, 127
psource command, 78
pt, 128
put_parameter function, 95
putfield function, 94

R
RATE attribute, 83
recalling a System Meter, 61
removing Solstice SyMON, 21, 31
reserved variable names, 81
resizing a column, 69
resources, reallocating, 66
rn, 128
root node Event Generator
variable name, 81
rpcNum, 128
RULE attribute, 82
rules
action, description, 76
activating, 108
attributes
  COMMENTS or C, 83
  ON_ACKNOWLEDGE, 82
capacity planning, 78
checking syntax, 108
complex rule examples, 115
condition, description, 76
creating or modifying, 98
descending sort order, 68
elements, 115
functions
  alarm, 84
dynlink, 86
end_alarm, 86
findlist, 87
findstatus, 89
findvalue, 89
get_parameter, 91
getfield, 90
gettime, 92
mailto, 94
put_parameter, 95, 96
putfield, 94
snmp, 96
syslog, 97
hardware, 78
in-depth description, 76
modifying, 75
non-hardware, 78
platform-specific, 79
predictive failure analysis, 78
Rule 0, example, 110
Rule 100, example, 118
Rule 102, example, 113
Rule 106, example, 120
Rule 201, example, 115
troubleshooting, 131
types, 77
writing, 75
Config Reader, 98, 99
Event Generator, 98, 106
Kernel Reader, 98, 102
Log Scanner, 98, 104
rules attributes
MULTI, 82
ON_CLOSE, 82
ON_CONTINUE, 82
ON_OPEN, 82
ON_SHUTDOWN, 82
PARAMETER, 82
PRIORITY, 82
RATE, 83
RULE, 82
SEVERITY, 82
rules files
capacity planning rules, 79
description of, 78
Event Generator, 79
hardware monitoring, 79
message string definition rules, 79
monitoring rules, 79
path used to search for, 107
predictive failure rules, 79
SC2000.tcl, 80
SPARCcenter 2000/2000E, 80
SPARCserver 1000/1000E, 80
SS1000.tcl, 80
system monitoring rules, 79
UEnterprise.tcl, 80
UEnterpriseI.tcl, 80
Ultra Enterprise 150, 80
Ultra Enterprise 2, 80
Ultra Enterprise X000 servers, 80
rules.tcl, 78, 79, 107
rultext.tcl file, 79
S
save search criteria, 66
save search results, 66
saving, current Solstice SyMON session, 129
scaling, 57
a graph, 60
search
criteria, defining for log file entries, 64
results window, using, 63
sorting, 64
stopping, 64
searches
complex, performing, 65
starting, 64
searching
for log file entries, 63
for log file entries containing a specific expression or keyword, 65
system log file, 62
server
configuring, 28
packages, installing, 22
subsystem, 2, 4
server_status, 81
servers supported, 1
session, 129
session, saving, current, 129
SEVERITY attribute, 77
Show Information window
Logical View, 46
Physical View, 40
shutting down Solstice SyMON, 31
SIGHUP signal, 108
snmp function, 96
SNMP traps, 7
installing, 170
installing and setting up, 33
software
- components, description, 2
- installation, steps, 19
- performance, monitoring, 12
- removing, 31
- starting, 29

Solstice SyMON
- features, 1
- installation, 19
- options, 123
- removing, 21
- shutting down, 31
- upgrading, 21

sort option
- Event Viewer, View menu, 71
- Process Viewer, View menu, 68

sorting the results of a search, 64
- special characters, 80
- $SS1000.tcl rules file, 80
- $SS2000.tcl rules files, 80

Start Search button, 64
- starting, Solstice SYMON, 29
- stopping a search, 64
- structuring data, 97

Sun Validation and Test Suite
(SunVTS), 47
- diagnosing hardware problems, 47
- overview, 11

supported servers, 1
- $swrules.tcl, 79
- $symond_daemon, 6
- $symond_status, 81
- syntax, checking, 108
- $syrules.tcl file, 79
- syslog
- man page, 104
- searching, 62
- syslog function, 85, 97

system
- meters, 12
- monitoring rules, 79
- target, to monitor, 129

System Meter, 12
- customizing, 55
- displaying graphs, 60
- moving, 60
- recalling, 61
- redisplaying, 61
- saving, 61
- View menu, Layout option, 55
- window, controlling appearance of, 56
- windows, building, 54

system software performance
- monitoring, 52

T
- t, 129
- target, 129
- target system to monitor, 129
- Tcl
- books, 75
- commands, 84
- rules, functions, 75
- scripting language, 75
- tempPruneTime, 129
- time
- displaying, 64
- event opened, 70
- Title menu, 57
- title, changing of system meter or graph, 58
- tpt, 129
- trees, 97
- troubleshooting rules, 131
- types of event rules, 77

U
- UEnterprise.tcl rules file, 80
- UEnterpriseI.tcl rules file, 80
- undoing a change in a graph, 59
- upgrading Solstice SyMON from 1.0, 21
- Use Defaults field, 57
V
Validation and Test Suite (SunVTS), 47
value, 81
variable name
  Config Reader, 81
date, 81
hierarchy being evaluated, 81
Kernel Reader, 81
Log Scanner agent, 81
monitored system, 81
node returned by findlist function, 81
root node for Event Generator, 81
variable names
  reserved, 81
variable, deleting from a graph, 59
verify_rules, 108
debugging tips, 109
  -I, 108
  -p, 108
  -R, 108
view
  Logical, 11
  Physical, 11
View menu
description, 10
Log File Viewer window, 63
VTS
diagnosing hardware problems, 47
overview, 11
vtsui, 130

W
wait, minimum, between polls or updates, 127
warning and error messages
description, 10
writing rules
  Config Reader, 98, 99
  Event Generator, 98, 106
  Kernel Reader, 98, 102
  Log Scanner, 98

Y
Y-axis maximum, 58
Y-axis minimum, 58
Y-axis scaling, 57

Z
zooming a graph, 60